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Introduction

Windows 10 is here.

Alas, Windows 8 and 8.1, we hardly knew ye.

And Windows 9—we just skipped you entirely and jumped ahead to Windows 10.

For people buying this book for the first time, welcome. For people who have bought
previous editions and are returning again (or again and again and again)—thank you for
coming back.

Group Policy and Active Directory go hand in hand. If you have Active Directory, you
get Group Policy.

If you’re very new to Group Policy, here’s the inside scoop. Group Policy has one goal: to
make your administrative life easier. Instead of running around from machine to machine,
tweaking a setting here or installing some software there, you’ll have ultimate control from
on high.

Like Zeus himself, controlling the many aspects of the mortal world below, you will have
the ability, via Group Policy, to dictate specific settings pertaining to how you want your
users and computers to operate. You’ll be able to shape your network’s destiny. You’ll have
the power. But you need to know how to tap into this power and what can be powered.

In this introduction and throughout the first several chapters, I’ll describe just what
Group Policy is all about and give you an idea of its tremendous power. Then, as your skills
grow, chapter by chapter, we’ll build on what you’ve already learned and help you do more
with Group Policy, troubleshoot it, and implement some of its most powerful features.

For those of you who are already somewhat Group Policy savvy, there is some good and
some bad news (which is the same news): From a Group Policy perspective, Windows 10 is
not radically different from its Windows 7 or Windows 8 siblings.

Ironically, Group Policy’s innards did get the most recent update between Windows 8
and Windows 8.1, and those carry forward to Windows 10. I’ll explain these when the time
comes, so you can understand the behavior changes. Take a look at Table 1.1 for how the
Windows Group Policy engine evolved when the internal version number changed.

TABLE 1.1 How Windows and Group Policy evolved

Internal Windows

Product Name Version Number Changes to Group Policy Engine
Windows XP 5.0 Big changes from Windows 2000

Vista 6.0 Big changes from XP

Windows 7 6.1 Not so big changes from Windows Vista

Windows 8 6.2 Not so big changes from Windows 7
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TABLE 1.1 How Windows and Group Policy evolved (continued)

Internal Windows

Product Name Version Number Changes to Group Policy Engine
Windows 8.1 and 6.3 Medium changes from Windows 8
Windows 8.1 with

Update

Windows 10 6.4 when itwasin  No changes from Windows 8.1

beta. But now at
release Microsoft
smartly jumped it
up to 10.

Again, Table I.1 shows changes from a “Group Policy guts” perspective and is not neces-
sarily reflective of what you can do (the actions you can perform) with Group Policy.

Knowing what’s changed within the Group Policy guts is a dual-edged sword. On the
one hand, you could say to yourself, “Awesome! If ’'m already an expert at Windows 7 and
Group Policy, there’s not a huge hill to climb!” And that would be true. On the other hand,
it’s also true that because Windows 8 through 10 didn’t shake things up too much, with
regard to Group Policy “guts,” there’s not a lot of whiz-bang newness to uncover and show
off. That being said, the updates in Windows 8.1 (which carry forward to Windows 10)
will be covered in Chapter 3.

In a way, I really like the dual-edged sword. I like that there are a variety of new goodies
and things you can do with Group Policy for Windows 10, some interesting updates, but
not a radical head-spinning change. I like the fact that what is already working in practice
doesn’t change that much. I like knowing that the time already invested in getting smarter
in Group Policy isn’t for nothing, and you and I won’t have to relearn everything we ever
knew all over again.

So, even though the “guts” haven’t changed all the much, there’s always new “stuff” you
can accomplish with Group Policy as each operating system comes out.

As you likely already know, Group Policy is, at its heart, an “on-prem” system for man-
agement. Isn’t this antithetical to Microsoft’s new battle cry of “Mobile first, cloud first?”

If you want to read Microsoft's own perspective on this, see:

A‘dnz
http://news.microsoft.com/2014/03/27/satya-nadella-mobile-
first-cloud-first-press-briefing/

Shouldn’t Group Policy get a huge overhaul in its underlying technology to align with
“Mobile first, cloud first?”


http://news.microsoft.com/2014/03/27/satya-nadella-mobile-first-cloud-first-press-briefing/
http://news.microsoft.com/2014/03/27/satya-nadella-mobile-first-cloud-first-press-briefing/
http://news.microsoft.com/2014/03/27/satya-nadella-mobile-first-cloud-first-press-briefing/
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Perhaps it doesn’t need it. Because Group Policy is, by its very nature, extensible, we
can extend Group Policy to the cloud when needed if paired with (at least two) “add-
ons.” Microsoft DirectAccess (beyond the scope of this book, but briefly touched upon in
Chapter 3) enables Windows machines to act as if they are always connected on-premise,
even though they might be over the Internet at a coffee shop. That being said, DirectAccess
only works with the more pricey Enterprise version of the Windows client.

PolicyPak Cloud (demonstrated in Chapter 3 and “name dropped” throughout the book)
can take existing Group Policy directives and get them to the cloud for use on traveling and
even non-domain-joined machines. PolicyPak Cloud works with any version of Windows
and isn’t limited to the more pricey Enterprise version.

If you’ve done some work already with Group Policy, you might notice that it could be
described as various components under one roof; it roughly breaks down as follows:

Group Policy Administrative Templates

Group Policy Security Settings

Group Policy Preferences

Everything else, including third-party extensions

With all that power, and extendibility, Group Policy continues to stay not just rel-
evant but, indeed, central to any Active Directory administrator’s tool belt of required
knowledge.

And because Group Policy is extensible, it can keep working in a “Mobile first, cloud
first” world.

Group Policy Defined

If we take a step back and try to analyze the term Group Policy, it’s easy to become con-
fused. When I first heard the term, I didn’t know what to make of it.

I asked myself, “Are we applying ‘policy’ to ‘groups’? Is this some sort of old-school
NT 4 System Policy applied to Active Directory groups?”

Turns out, “Group Policy” as a name isn’t, well, excellent. At cocktail parties, when I
tell the person next to me that I teach, write about, and make software to extend Group
Policy, they don’t get what “Group Policy” means.

If I said something like “I teach databases,” he would cheerfully go back to his scotch
and soda and leave me alone. But because I say, “I teach Group Policy to smart people
looking to get smarter and build software that hooks into Group Policy,” he (unfortunately)
wants to know more. He’ll say something like “What does that mean? I’ve never heard of
Group Policy before.” And while I love talking about Group Policy with you, my friendly
IT geeks, at a cocktail party full of stuffed shirts, I just want to get another canapé.

So, the name “Group Policy” can be kind of confusing, but it’s also intriguing. Microsoft’s
perspective is that the name “Group Policy” is derived from the fact that you are “grouping
together policy settings.” I don’t really love the name “Group Policy”—Dbut it’s the name we
have, so that’s what it’s called. As Juliet said in Romeo and Juliet (11, ii, 43—44), “What’s in a
name? That which we call a rose by any other name would smell as sweet.”
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For me, if I was consulted, I might have named it Windows Policy or Microsoft Policy.
But, alas. Group Policy is the name it has.

Group Policy is, in essence, rules that are applied and enforced at multiple levels of
Active Directory. Policy settings you dictate must be adhered to by your users and comput-
ers. This provides great power and efficiency when manipulating client systems.

Instead of running around from machine to machine, you’re in charge (not your users).

When going through the examples in this book, you will play the various parts of the end
user, the OU administrator, the domain administrator, and the enterprise administrator. Your
mission is to create and define Group Policy using Active Directory and witness it being auto-
matically enforced. What you say goes! With Group Policy, you can set policies that dictate
that users quit messing with their machines. You can dictate what software will be deployed.
You can determine how much disk space users can use. You can do pretty much whatever you
want—it is up to you. With Group Policy, you hold all the power. That’s the good news.

And this magical power only works on Windows 2000 and later machines. For the
sake of completeness, this includes all versions of Windows 2000 and later: workstation
and server. Of course, this includes all the modern Windows systems you would use, like
Windows 10 and Windows Server 2016.

I’ll likely say this again in multiple places, but I want to get one “big ol’ misconception”
out of the way right here, right in the introduction. The Group Policy infrastructure does
not care what mode your domain is in. If you have only one type of Domain Controller or a
mixture of Domain Controllers, 100 percent of everything we cover in this book is valid.

Said another way, even if your domain level is the oldest-of-the-old Windows 2000
mixed mode, you’re still pretty much 100 percent covered here. Group Policy is all about
the client (the target) operating system and not the Domain Controllers or domain modes.

e It is true that wireless settings and BitLocker key storage require schema
P updates to play nicely with Group Policy. But even then, Group Policy will
still work running with the oldest-of-the-old servers.

If the range of control scares you, don’t be afraid! It just means more power to hold over
your environment. You’ll quickly learn how to wisely use this newfound power to reign
over your subjects, er, users.

Group Policy vs. Group Policy Objects vs. Group Policy Preferences

Before we go headlong into Group Policy theory, let’s get some terminology and vocabulary
out of the way:
Group Policy is the concept that, from on high, you can do all this “stuff” to your
client machines.
A policy setting is just one individual setting that you can use to perform some
specific action.
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Group Policy Objects (GPOs) are the “nuts and bolts” contained within Active Direc-
tory Domain Controllers, and each can contain anywhere from one to a zillion individual
policy settings.

The Group Policy Preferences is a newer add-on to the existing set of the “original”
Group Policy settings and abilities many have come to know and love. Group Policy
Preferences (sometimes shortened to GPPrefs) don’t act quite the same as their original
cousins. We’ll cover the Group Policy Preferences in detail in Chapter 5.

Preference item is a way to describe one “Group Policy Preferences directive.” It’s like a
“policy setting,” but for the Group Policy Preferences.

It’s my goal that after you work through this book, you’ll be able to jump up on your desk
one day and use all the vocabulary at once. Like this: “Hey! Group Policy isn’t applying to
our client machines! Perhaps a policy setting is misconfigured. Or, maybe one of our Group
Policy Objects has gone belly up! Heck, maybe one of the preference items is misconfigured.
I’d better read about what’s going on in Chapter 7, “Troubleshooting Group Policy.””

This terminology can be a little confusing—considering that each term includes the word
policy. In this text, however, I’ve tried especially hard to use the correct nomenclature for
what I’'m describing. If you get confused, just come back here to refresh your brain about the
definitions.

Note that there is never a time to use the phrase “Group Policies.” Those

dﬂz two words together shouldn’t exist. If you're talking about “multiple GPOs”
or “multiple policy settings” or “policy settings vs. preference items,”
these are the preferred phrases to use, and never “Group Policies.”

Where Group Policy Applies

Group Policy can be applied to many machines at once using Active Directory, or it can be
applied when you walk up to a specific machine. For the most part, in this book I’ll focus
on using Group Policy within an Active Directory environment, where it affects the most
machines.

A percentage of the settings explored and discussed in this book are available to mem-
ber or stand-alone Windows machines—which can either participate (that is, be “joined”
to Active Directory) or not participate (that is, it’s “non-domain-joined”) in an Active
Directory environment.

However, the Folder Redirection settings (discussed in Chapter 10) and the Software
Distribution settings (discussed in Chapter 11) are not available to stand-alone machines
(that is, computers that are not participating in an Active Directory domain). In some cases,
I will pay particular attention to non—Active Directory environments. However, most of the
book deals with the more common case; that is, we’ll explore the implications of deploying
Group Policy in an Active Directory environment.
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The “Too Many Operating Systems” Problem

If we line up all the operating systems that you (a savvy IT person) might have in your
corporate world, we would likely find one or more of the following (presented here in
date-release order):

Windows 2000 (Workstation and Server), RTM through SP4
Windows Server 2003, RTM through SP2

Windows XP, RTM through SP3

Windows Vista, RTM through SP2

Windows Server 2008, RTM (known as SP1, actually) through SP2
Windows 7 RTM, through SP1

Windows Server 2008 R2, through SP1

Windows Server 2012, RTM

Windows Server 2012 R2

Windows 8 client, RTM

Windows 8.1 client, RTM

Windows 8.1 Update 1

Windows 10, RTM

Windows Server 2016, RTM

For the love of Pete (whoever Pete is), that’s a lot of potential operating systems. Okay,
okay—perhaps you don’t have all of them. You likely don’t have any more Windows 2000 (or
maybe you do, tucked in a back room somewhere, quietly processing something or other).

The point, however, is that Group Policy can apply to all of these systems. Under most
circumstances, “old stuff” will work correctly on newer machines. That is, generally,
something that could affect, say, an XP machine will also (generally) continue to affect a
Windows 10 machine.

With that in mind, here’s an example of what I’'m not going to do. ’'m not going to show
you an example of something in the book, then say something like, “and this example is
valid for Windows XP, Windows Vista, Windows Server 2008, Windows Server 2008 R2,
Windows 7, Windows 8, Windows 8.1, Windows 8.1 Update 1, Windows Server 2012,
Windows Server 2012 R2, Windows 10, and Windows Server 2016.”

My head (and yours) will just explode if I do that and you need to read it each time.

So, here’s what I am going to do. You’ll read my discussion about something, then I’ll
say something like, “and this example is valid for Windows XP and later.” That would
mean that the thing ’'m about to show you (for example, a policy setting) should work
A-OK for XP and later machines (all the way to Windows 10 and also usually for servers,
like Windows Server 2016, too). Similarly, if I say, “and this is valid for Windows Vista and
later,” that means you’ll be golden if the target machine is Windows Vista and later (all the
way through Windows 10 and Windows Server 2016).



Introduction XXXi

Of course, there are a handful of exceptions: things that only work on one particular
operating system in a possibly peculiar way. For instance, there are a handful of Windows
Vista—only settings that aren’t valid for Windows 7 and Windows 8. There are Windows 10—
specific settings that won’t work on older machines. Again, I'll strive for clarity regarding the
exceptions—but the good news is, those are few and far between.

If you get lost, here’s a quick cheat sheet to help you remember “which machines act alike”:

Windows 2000 Workstation and Windows Server
Windows Server 2003 and Windows XP
Windows Server 2008 and Windows Vista
Windows 7 and Windows Server 2008 R2
Windows 8 and Windows Server 2012

Windows 8.1 and Windows Server 2012 R2
Windows 10 and Windows Server 2016

Just to be even more specific, Windows 7, Windows 8, Windows 8.1, Windows Server
2008 R2, Windows Server 2012, Windows Server 2012 R2, Windows 10, and Windows
Server 2016 are ludicrously close brothers. They look alike, throw the same temper tantrums,
and enjoy the same kinds of movies. But they’re not identical. They are, in fact, different, but
in most cases, they’re super-duper similar and will react the same way when poked.

For this edition of the book, we decided to make a conscious choice about how to
present Group Policy. Most of the walk-throughs, examples, and screen shots in the
book will be of Windows 10 and Windows Server 2016.

Since I wrote the last edition of this book, two friends have passed away. Those friends,
of course, are Windows XP and Windows Server 2003. It’s impossible to know how much
XP is still out there, but my unscientific guess would be that 30 percent of the PCs in the
business world are still using XP as I write these words. That’s not a lot, but it’s certainly
not a little either.

As far as 'm concerned though, XP and Windows Server 2003 are dead ends. I mean,
they really are: Microsoft has stopped supporting them except in extreme circumstances
and special handling cases.

But I do want to be super-clear about something: I am also specifically going to note
and talk about the differences between the various operating systems. For instance, I’ll
definitely be expressing some concepts as originally found in Windows 2000, and also
Windows XP and Windows Vista—things that were originally in these operating systems’
behaviors but are absent or changed now.

When explaining Group Policy, I like to explain how Group Policy evolved from
Windows 2000 through Windows XP and Vista and now on to Windows 10. I like to talk
about the “old-school” stuff sometimes, because I find it helps explain why Windows does
some things today that seem, well, odd or confusing. If I explain the older operating systems,
for example, Windows 2000 and Windows XP, it’s actually easier to understand modern
Windows. But as far as actual examples go in this book, sayonara XP (and Windows Server
2003). When it’s necessary to get a deeper perspective on details of Windows XP, I might
refer you to previous editions of this book.
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And now, a quick word about Windows Vista.

Yes, friends. Vista happened.

We also cannot deny the existence of Windows Vista and that it actually came and went
without anyone caring at all.

That being said, even though Microsoft “didn’t quite get the taste right” with regard to
Windows Vista, the individual ingredients continue to be the base of our Windows soup
going forward. So, that means Windows 7, 8, and 10 are honestly very minor upgrades
from Vista.

And pretty much everything that was once valid for Vista is also valid for Windows 7,
Windows 8, and Windows 10. Therefore, you’ll see me write a lot about, “and this works
for Windows Vista and later,” or in some places, like table listings, you’ll see “Valid for
Vista+”—meaning that whatever I'm referencing will work on Vista (if you have it), but it
will also work on Windows 7, almost always Windows 8, and onward to Windows 10.

A Little about Me, This Book, PolicyPak, and Beyond

Group Policy is a big concept with some big power. This book is intended to help you get a
handle on this new power to gain control over your environment and to make your day-to-
day administration easier. It’s filled with practical, hands-on examples of Group Policy usage
and troubleshooting. It is my hope that you enjoy this book and learn from my experiences so
you can successfully deploy Group Policy and manage your desktops to better control your
network. ’'m honored to have you aboard for the ride, and I hope you get as much out of
Group Policy as I do.

I’ve had and continue to have a long history with Group Policy.

I’ve been writing about and speaking about Group Policy in my hands-on workshops for
over 10 years.

I’ve been one of about a dozen Group Policy MVPs, as anointed by Microsoft for 12 years.

And, I’ve also founded a company called PolicyPak Software, which extends Group
Policy to do more amazing things than what is possible with what is in the box alone. For
instance, here are some of the things you can do with the products from PolicyPak:

Manage just about any third-party application using Group Policy (like Java, Flash,
Firefox, Lync [now Skype for Business|, OpenOffice, and hundreds more).

Craft exactly when and how Group Policy Admin Template template settings will be
applied to users or computers.

Keep Group Policy Preferences items working—even when the computer goes offline.

Learn when a machine is in compliance and out of compliance with what you need it
to be.

Deploy almost all Group Policy directives over the Internet and on to machines that
might never otherwise be able to get Group Policy.

So, ’'m going to try to walk a fine line here. With your permission, I am going to, from
time to time, describe when something from PolicyPak could enhance a situation or solve a
problem that cannot be solved out of the box. I’ll show you real examples of how to solve
real problems.



Introduction XXXiii

And I’'m doing it not to sell you something, but if that happens, that’s okay, too. The
point, really, is to demonstrate a problem or situation that might not have any other way
out of it. So basically, if I didn’t explain that the “PolicyPak possibility” to fix a particular
problem existed, you wouldn’t know about it and you’d still always be stuck in a rut.

Meanwhile, as you read this book, it’s natural to have questions about Group Policy
or managing your desktops. To form a community around Group Policy, I have a popular
community forum that can be found at www.GPanswers.com.

I encourage you to visit the website and post your questions to the community forum or
peruse the other resources that will be constantly renewed and available for download. For
instance, in addition to the forum at www.GPanswers.com, you’ll find these resources:

Full downloadable PowerShell scripts from the PowerShell chapter
Tips and tricks
A third-party Group Policy Solutions Guide, and lots, lots more!

If you want to meet me in person, book me for onsite training, or attend my live public
Group Policy courses; my website at www.GPanswers.com has a calendar with upcoming
events. I’d love to hear how this book met your needs or helped you out.

Thanks again for being a part of the journey.


http://www.GPanswers.com
http://www.GPanswers.com
http://www.GPanswers.com
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In this chapter, you’ll get your feet wet with the concept that is Group Policy. You’ll start to
understand conceptually what Group Policy is and how it’s created, applied, and modified,
and you’ll go through some practical examples to get at the basics.

The best news is that the essentials of Group Policy are the same in all versions
of Windows 2000 on. So as I stated in the introduction, if you’ve got Windows XP,
Windows 7, Windows 8, Windows 10—whatever—you’re golden.

Learn the basics here, and you’re set up on a great path.

That’s because Group Policy isn’t a server-driven technology. As you’ll learn in depth
a little later, the magic of Group Policy happens (mostly) on the client (target) machine.
And when we say “client,” we mean anything that can “receive” Group Policy directives:
Windows 8, Windows XP, or even the server operating systems such as Windows Server
2016 or Windows Server 2008 R2; they’re all “clients” too.

So, if your Active Directory Domain Controllers are a mixture of Windows Server 2008,
Windows Server 2012, and/or Windows Server 2016, nothing much changes. And it doesn’t
matter if your domain is in Mixed, Native, or another mode—the Group Policy engine
works exactly the same in all of them.

When the domain mode is Windows 2003 or later schema, you'll get some-
thing neat called WMl filters (described in Chapter 4, “Advanced Group
Policy Processing”). Also note that in a Windows 2008 Functional mode
domain level or later, the replication of the file-based part of a Group Policy
Object (GPO) can be enhanced to use distributed file system (DFS) replica-
tion instead of system volume (SYSVOL) replication.

é/ There are occasional odds and ends you get with upgraded domain types.
P

Regardless of what your server architecture is, I encourage you to work through the
examples in this chapter.
So, let’s get started and talk about the essentials.
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Getting Ready to Use This Book

This book is full of examples. And to help you work through them, I’'m going to suggest a
sample test lab for you to create. It’s pretty simple really, but in its simplicity we’ll be able
to work through dozens of real-world examples to see how things work.

Here are the computers you need to set up and what I suggest you name them (if you
want to work through the examples with me in the book):

DCO1.corp.com This is your Active Directory Domain Controller. It can be any type of
Domain Controller (DC). For this book, I’ll assume you’ve loaded Windows Server 2016
and later on this computer and that you’ll create a test domain called Corp.com.

In real life you would have multiple Domain Controllers in the domain. But here in the test
lab, it’ll be okay if you just have one.

I’ll refer to this machine as DCO1 in the book. We’ll also use DCO1 as a file server and soft-
ware distribution server and for a lot of other roles we really shouldn’t. That’s so you can
work through lots of examples without bringing up lots of servers. Bringing up a modern
DC requires the use of Server Manager. Check out the sidebar “Bringing Up a Windows
Server as a Domain Controller” if you need a little guidance.

Win10.corp.com This is some user’s Windows 10 machine and it’s joined to the domain
Corp.com. Il refer to this machine as WIN10 in the book. Sometimes it’ll be a Sales com-
puter, other times a Marketing computer, and other times a Nursing computer. To use this
machine as such, just move the computer account around in Active Directory when the time
comes. You’ll see what I mean.

Winl0management.corp.com This machine belongs to you—the I'T pro who runs

the show. You could manage Active Directory from anywhere on your network, but

you’re going to do it from here. This is the machine you’ll use to run the tools you

need to manage both Active Directory and Group Policy. I’ll refer to this machine as
WINTOMANAGEMENT. As the name implies, you’ll run Windows 10 from this machine.
Note that you aren’t “forced” or “required” to use a Windows 10 machine as your manage-
ment machine—but you’ll be able to “manage it all” if you do.

You can see a suggested test lab setup in Figure 1.1.

Note that from time to time I might refer to some machine that isn’t here in the sug-
gested test lab, just to illustrate a point. However, this is the minimum configuration you’ll
need to get the most out the book.

To save space in the book, we're going to assume you're using a Win-
Ad’TE dows 10 machine as your management machine. You can also use a Win-
dows 8 or 7 management machine as well and be able to work through
pretty much everything in the book, barring a few new things that got born
in Windows 8.1 and are still present on a Windows 10 management machine.
If you're forced by some draconian corporate edict to use a Windows Vista
or Windows XP (or earlier) machine as a management machine, you’ll have
to refer to previous editions of the book to get the skinny about using them.
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FIGURE 1.1 Here'sthe configuration you'll need for the test lab in this book. Note
that the Domain Controller can be 2000 or above, but Windows Server 2016 is preferred
to allow you to work through all the examples in this book.

Your machine—the
Administrators who
control Group Policy.

Some user’s
machine. Could be
Sales, Marketing, etc.

WINTO \
Some user’s

machine. Could be
Sales, Marketing, etc.

Active Directory Domain
Controllers of any kind

WIN10
win10computer.corp.com

corp.com

For working through this book, you can build your test lab with real machines or
with virtual hardware. Personally, I use VMware Workstation (a pay tool) for my testing.
However, Microsoft’s Hyper-V is a perfectly decent choice as well. Indeed, Hyper-V is now
available built into Windows 8 and later. So, you could bring up a whole test lab to learn
Windows 10—on your Windows 10 box! What a mindblower! Here’s an (older) overview
of Windows 8’s Hyper-V if you care to use it: http://tinyurl.com/3r99nr9. Note there
are also other alternatives, such as Parallels Desktop and VMware Fusion (both of which
run on a Mac) and Oracle VM VirtualBox.

In short, by using virtual machines, if you don’t have a bunch of extra physical servers
and desktops around, you can follow along with all the examples anyway.

I suggest you build your test lab from scratch. Get the original media or download each
operating system and spin up a new test lab.

Here is where to find trial downloads for Windows 7, Windows 8.1, Windows 10, and
Windows Server 2016:

www.microsoft.com/en-us/evalcenter/evaluate-windows-8-1-enterprise

Microsoft usually also makes prebuilt virtual hard disk (VHD) images for use with
Virtual PC and now, more recently, Hyper-V. It’s your choice of course, but I prefer to
fresh-build my lab instead of using the preconfigured VHD files.

And that’s what I’ll be doing for my examples in this book. If the URLs I’ve specified
change, ’'m sure a little Googling, er, Bing-ing will Bing it, er, bring it right up.


http://tinyurl.com/3r99nr9
http://www.microsoft.com/en-us/evalcenter/evaluate-windows-8-1-enterprise
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ING that you try the examples in a test lab environment first before making

ﬁ" Because Group Policy can be so all-encompassing, | highly recommend
changes for real in your production environment.

Bringing Up a Windows Server as a Domain Controller

The DCPROMO. EXE you knew and loved is dead as of Windows Server 2012.

Before continuing, ensure that your server is already named DCO1. If it isn’t, rename it
and reboot before continuing. Additionally, ensure that DC0O1 has a static IP address and
is configured to use itself as the DNS server.

Now, you'll need to use the Server Manager’s “Add Roles and Features Wizard” to add
the roles required to make your server a DC. It's not hard. Here’s a sketch of the steps.

First, fire up Server Manager, which is the leftmost icon when you're on the server. Next,
click Dashboard and select “Add roles and features,” as seen here.

Server Manager

« Das h boa rd - {é) | rA Manage  Tools  View Help

Dashboard WELCOME TO SERVER MANAGER

i Local Server
ii All Servers . .
- o Configure this local server
g File and Storage Services b - _
QUICK START -
) M ~ c r fa Fate
2 Add roles and features
3~ Add other servers to manage
WHAT'S NEW — ) |
4 Create a server group
Hide
LEARM MORE
ROLES AND SERVER GROUPS
Roles: 1 | Servergroups:1 | Servers total: 1

=a File and Storage
g Do ond storg
Services
— -

= ol
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Then you'll be at the “Add Roles and Features Wizard,” as seen here.

DESTINATION SERVER

This wizard helps you install roles, role services, or features, You determine which roles, role sanvices, or
faatures to install based on the computing needs of your organization, such a5 sharing decuments, ar
Installation Type hasting a website.

Server Selection
To remave roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such ac static [P addresses, are configured
* The most current security updates from Windows Update are inctalled

I you ify that any of the pracading prerequisites have b leted, close the wizard,
complete the steps, and then run the wizard again.

To continue, dlick Nexl

[ Skip this page by defautt

< Previous | [ Hexts Install Cancel

Click Next to visit the Installation Type screen and select “Role-based or feature-based
installation.” Then click Next.

At Server Selection, click “Select a server from the server pool” and select your only
machine: DCO1.

At Server Roles, select Active Directory Domain Services, as seen here, and say yes when
prompted to load the additional items, which must come along for the ride.

Select server roles

Before You Begin Select one or more roles to install on the selected server.

Installation Type Roles

server selection . ~
ctory Certificate Services Ll

Feal [Rapiectouy Federation Services
AD DS ive Directory Lightweight Directory Services
Confirmation [ Active Directory Rights Management Services

[ Application Server

["] DHCP Server

L] DNS Server

[ Fax Server

(E] File And Storage Services (Installed)
[ Hyper-v

[ Network Policy and Access Services.

-

[ Print and Document Services
[ Remote Access
[ Remote Desktop Services
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At the Features screen, click Next.
At the AD DS screen, click Next.

At the Confirmation screen, select “Restart the destination server automatically if
required” and then click Install.

Next, Active Directory components will be installed on DC0O1 along with the GPMC. When
done, you'll be able to select “Promote this server to a domain controller,” as seen here.

[ Add Roles and Features Wizard =& -

DESTINATION SERVER

Installation progress s

View installation progress

@ Festure installation

Configuration required. Installation succeeded on DCO1.

Active Directory Domain Services
Additional steps are required ta make this machine a damain controller.

Promote this server to a domain controller

Graup Policy Management

Remote Server Administration Tools
Role Administration Tools
AD DS and AD LDS Tools
AD DS Tools
AD DS Snap-Ins and Command-Line Tools

Active Directory Administrative Center

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Netifications in the command bar, and then Task Details.

Export configuration settings

Cancel

At this point it should be pretty familiar. At the Deployment Configuration page, select
“Add a new forest” and type Corp.com as the root domain name. Click Next.

At the Domain Controller Options page, leave the defaults as is. Provide a Directory Ser-
vices Restore Mode (DSRM) password. | recommend p@sswOrd. (My suggested pass-
word in all my books is p@sswOrd. That’s a lowercase p, the at sign, an s, ans,aw, a
zero, then r, and d.) Click Next to continue.

At the DNS Options page, you might get a warning; click Next.
At the Additional Options page, leave the defaults and click Next.
At the Paths page, leave the defaults as is and click Next.

At the Review Options page, click Next.
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At the Prerequisites Check page, make sure there are no showstoppers. Finally, click
Install on that same page.

The computer should restart automatically and reboot.

Congrats! You have your first Domain Controller!

Getting Started with Group Policy

Group Policy is a big, big place. And you need a road map. Let’s try to get a firm under-
standing of what we’re about to be looking at for the next several hundred pages.

Group Policy Entities and Policy Settings

Every Group Policy Object contains two halves: a User half and a Computer half. These
two halves are properly called nodes, though sometimes they’re just referred to as either
the User half and the Computer half or the User branch and the Computer branch.

A sample Group Policy Object with both the Computer Configuration and User
Configuration nodes can be seen in Figure 1.2 (in the upcoming section, “Local Group
Policy Editor”). Don’t worry; I’ll show you how to get there in just a second.

Just to make things a little more complicated, if you're deploying settings

dnz using Active Directory (the most usual case) as opposed to walking up and
creating a “local GPO"” as we do later in Figure 1.2, the interface is a wee
bit different and shows the Group Policy Preferences node. Hang tight for
more on that.

The first level under both the User and the Computer nodes contains Software Settings,
Windows Settings, and Administrative Templates. If we dive down into the Administrative
Templates of the Computer node, underneath we discover additional levels of Windows
Components, System, Network, and Printers. Likewise, if we dive down into the
Administrative Templates of the User node, we see some of the same folders plus some addi-
tional ones, such as Shared Folders, Desktop, Start Menu, and Taskbar.

In both the User and Computer halves, you’ll see that policy settings are hierarchical,
like a directory structure. Similar policy settings are grouped together for easy location.
That’s the idea anyway—though, admittedly, sometimes locating the specific policy or con-
figuration you want can prove to be a challenge.

When manipulating policy settings, you can choose to set either computer policy set-
tings or user policy settings (or both!). You’ll see examples of this shortly. (See the section
“Searching and Commenting Group Policy Objects and Policy Settings” in Chapter 2,
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“Managing Group Policy with the GPMC and via Powershell,” for tricks on how to mini-
mize the effort of finding the policy setting you want.)

Most policy settings are not found in both nodes. However, there are a few

A&TE that overlap. In that case, if the computer policy setting is different from
the user policy setting, the computer policy setting generally overrides the
user policy setting. But, to be sure, check the Explain text associated with
the policy setting.

Wait... | Don’t Get It. What Do the User and Computer Nodes Do?

One of the key issues that new Group Policy administrators ask themselves is, “What the
heck is the difference between the Computer and User nodes?”

Imagine that you had a combination store: Dog Treats (for dogs) and Candy Treats (for
kids). That's right; it's a strange little store with seemingly two types of incompatible
foods under the same roof. You wouldn’t feed the kids dog treats (they'd spit them out
and ignore the treat), and you wouldn’t feed the kids’ candy to a dog (because the dogs
would spit out the sour candy and ignore the treat).

That's the same thing that happens here. Sure, it looks tempting. There are lots of treats
on both sides of the store, but only one type of customer will accept each type of treat.

So, in practical terms, the Computer node (the first part of the policy) contains policy
settings that are relevant only for computers. That is, if there’s a GPO that contains
Computer-side settings and it “hits” a computer, these settings will take effect. These
Computer-side settings could be items like startup scripts, shutdown scripts, and how the
local firewall should be configured. Think of this as every setting relevant to the computer
itself—no matter who is logged on at that moment.

The User node (the second part of the policy) contains policy settings that are relevant
only for users. Again, if there’s a GPO that contains User-side settings and it “hits” a user,
these settings will take effect for that user. These User-side items make sense only on a
per-user basis, like logon scripts, logoff scripts, availability of the Control Panel, and lots
more. Think of this as every setting relevant to the currently logged-on user—and these
settings will follow the user to every machine they pop on to.

Feeding users dog treats, er, Computer-side settings doesn’t work. Same thing with feed-
ing computers User-side settings. When a GPO hits user objects with Computer policy
settings or computer objects with User policy settings, it simply will not do anything.
You'll just sit there and scratch your head and wonder why it doesn’t work. But it's not
that it's not working; this is how it’s designed.
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Computer settings are for computer objects, and User settings are for user objects. If this
is bad news for you, there are two ways to get out of the problem. One way is an in-the-
box advanced technique called loopback processing that can help you out. Look for more
information on loopback processing in Chapter 4. The other way is via a third-party tool
called PolicyPak, which (among other things) can permit computers to embrace User-side
settings. More on this in Chapter 6, “Managing Applications and Settings Using Group
Policy.

Active Directory and Local Group Policy

Group Policy is a twofold idea. First, without an Active Directory, there’s one and only one
Group Policy available.

Officially, this policy directly on the workstation is called a local policy, but it still
resides under the umbrella of the concept of Group Policy. Later, once Active Directory is
available, the nonlocal (or, as they’re sometimes called, domain-based or Active Directory—
based) Group Policy Objects come into play, as you’ll see later. Let’s get started and explore
both options.

Then, here’s the weird thing: after I’ve fully described Active Directory’s Group
Policy, we’re going to take a second visit back to Local Group Policy. That’s because with
Windows Vista and later, there’s a special superpower I want to show you, but I only want
to explain it after we’ve explored the first two concepts. So, in summary, here’s the short-
term road map:

Local Group Policy for Windows XP and later
Active Directory Group Policy for all operating systems
Multiple Local Group Policy (MLGPO) for Windows Vista and later

Trust me; it’s easier to learn it this way, even though we’re taking two passes at one
concept.

While you're plunking around inside the Group Policy editor (also known as

A ITE the Group Policy Management Editor, or Group Policy Object Editor), you'll
see lots of policy settings that are geared toward a particular operating
system. Some are only for specific operating systems, and others are more
general. If you happen to apply a policy setting to a system that isn’t listed,
the policy setting is simply ignored. For instance, policy settings described
as working “Only for Windows 8” machines will not typically work on Win-
dows XP machines. All policy settings have a “Supported on” field that
should be consulted to know which operating systems can embrace which
policy setting. Many of them will say something like “At least Windows
XP" to let you know they’re valid for, say, XP and on.
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Understanding Local Group Policy

Before we officially dive into what is specifically contained inside this magic of Group
Policy or how Group Policy is applied when Active Directory is involved, you might be curi-
ous to see exactly what your interaction with Local Group Policy might look like.

Local Group Policy is best used when Active Directory isn’t available, say either in a
Novell NetWare environment or when you have a gaggle of machines that simply aren’t
connected to a domain.

Local Group Policy Editor

The most expeditious way to edit the Local Group Policy on a machine is to click Start >
Run and type in GPEDIT.MSC. This pops up the Local Computer Policy Editor.

You are now exploring the Local Group Policy of this workstation. Local Group Policy
is unique to each specific machine. To see how a Local Group Policy applies, drill down
through the User Configuration > Administrative Templates > System > Ctrl+Alt+Del
options and select Remove Lock Computer, as shown in Figure 1.2. As seen in the figure,
the default for all policy settings is Not Configured. To make this policy setting perform its
magic, choose the Enabled radio button and click OK.

When you do, within a few seconds you should see that if you press Ctrl+Alt+Del, the
Lock Computer option is unavailable.

To revert the change, simply reselect Remove Lock Computer and select Not
Configured. This reverts the change.

You can think of Local Group Policy as a way to perform decentralized
dnz administration. A bit later, when we explore Group Policy with Active
Directory, we'll saunter into centralized administration.

This Local Group Policy affects everyone who logs onto this machine—including nor-
mal users and administrators. Be careful when making settings here; you can temporarily
lock yourself out of some useful functions.

If you’re thinking to yourself, “Yep, I’'ve done that,” then stay tuned. After the next sec-
tion is complete, we’ll return to Local Group Policy and discuss the idea of Multiple Local
Group Policy Objects, which can help ensure that you escape from this very jam.

Before we leave Local Group Policy (for now), remember something that I stated in
the introduction. That is, many of the settings we’ll explore in this book are available to
workstations or servers that aren’t joined to an Active Directory domain. Just poke around
here in Local Group Policy to get a feel for what you can and cannot do without Active
Directory. However, many functions, like Folder Redirection settings (discussed in Chapter
10, “Implementing a Managed Desktop, Part 1: Redirected Folders, Offline Files, and the
Synchronization Manager”), the Software Distribution settings (discussed in Chapter 11,
“The Managed Desktop, Part 2: Software Deployment via Group Policy”), and others
require Active Directory present to embrace these Group Policy directives.
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You can point to other computers’ local policies by using the syn-
tax gpedit.msc /gpcomputer:"targetmachine" or gpedit.msc /

gpcomputer:"targetmachine.domain.com"; the machine name must be in
quotes.

FIGURE 1.2 You can edit the Local Group Policy using the Local Group Policy Editor
(GPEDIT.MSC).

i@ Console - [Console Root\Local Computer Policy\User Configuration\Ad.. = O
[& File Action View Favorites Window Help

- | &%
e pE = Bml v
| Console Root Setting State Comment
<5 LD[EC‘ Cumputechufhcy /i Remove Change Password  Not configured Mo
> & Computer Configuration |i| Remove Lock Computer  Not configured Mo
a 4 User Configuration —
. . |iZ) Rernove Task Manager Mot configured Mo
» || Software Settings R Logoff Not conf g N
» 5 Windows Settings |i=] Remove Logo ot configure: o

a [ Administrative Templates
| Control Panel
| Desktop
> | Metwork
| Shared Folders
| Start Menu and Taskbar
| System
| Ctrl+Alt+Del Options
|| Driver Installation

a Remove Lock Computer = =

5] Remove Lock Computer Next Setting

(@) Mot Configured ~ “Omment:

Enabled
[u‘{}bisabled

[

Supported on: | At |east Windows 2000

Opticns: Help:

This policy setting prevents users from locking the system,

While locked, the desktop is hidden and the system cannot be
used. Only the user whe locked the system or the system
administrator can unlock it.

s

If you enable this policy setting, users cannot lock the computer
from the keyboard using Ctrl+Alt+Del,

If you disable or do not configure this policy setting, users will be
able to lock the computer from the keyboard using Ctrl+ Alt+Del.

Tip:To lock a computer without configuring a setting, press Ctrl
+Alt+Delete, and then click Lock this computer.

oK Cancel App
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Active Directory-Based Group Policy

To use Group Policy in the most meaningful way, you’ll need an Active Directory environ-
ment. An Active Directory environment needn’t be anything particularly fancy; indeed, it
could consist of a single Domain Controller and perhaps just one Windows 10 workstation
joined to the domain.

But Active Directory can also grow extensively from that original solitary server. You
can think of an Active Directory network as having four constituent and distinct levels that
relate to Group Policy:

The local computer
The site
The domain
The organizational unit (OU)
The rules of Active Directory state the following:

Every server and workstation must be a member of one (and only one) domain and be
located in one (and only one) site.

Every user must be a member of one (and only one) domain and may also be located
within one OU (and only one OU).

One of the most baffling questions people have when they start to dig into Group
Policy is, “If a user can only be a member of one OU, how do I apply multiple Group
Policy Object directives to one user?” I know it seems almost impossible based on the con-
straints listed, but I promise I’ll explain exactly how to do that in Chapter 2 in the section
“Filtering the Scope of Group Policy Objects with Security.”

Full Windows vs. Windows RT and What It Means for
Group Policy

Windows has two big flavors: full Windows and Windows RT.

Windows RT is the tablet edition that runs on ARM-based devices. Microsoft is not per-
mitting Windows RT machines to join Active Directory. Therefore, there is no way to get
Active Directory—based Group Policy on Windows RT. However, Windows RT will support
Local Group Policy.

In this book we’re not going to be spending much time on Windows RT, because most
of what we’ll do, we’ll do within the domain—and Windows RT machines are left out of
the fun.

Windows RT has some non—Group Policy management capability so that administrators
can control basic security settings. For more information about this feature, visit

http://tinyurl.com/6ufn565

Sadly, Windows RT has been out a few years (with the birth of Windows 8) and there
still isn’t any way to manage these devices using Group Policy. If there ever comes a time
that Windows RT machines can join the domain and get Active Directory Group Policy, I'll
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write about it at www.GPanswers.com. But don’t hold your breath, as all indications suggest
Windows RT will likely be depreciated and Microsoft will only be updating Windows RT
to keep the lights on.

Group Policy and Active Directory

As you saw, when Group Policy is created at the local level, everyone who uses that
machine is affected by those wishes. But once you step up and use Active Directory, you
can have nearly limitless Group Policy Objects (GPOs)—with the ability to selectively
decide which users and which computers will get which wishes (try saying that five times
quickly). The GPO is the vessel that stores these wishes for delivery.

Actually, you can have only 999 GPOs applied and affecting a user or a
A ITE computer before the system “gives up” and won't apply any more.

You’ll create GPOs using the Group Policy Management Console, or GPMC for short.
The GPMC can be added to a Windows Server 2016 computer or Domain Controller (see
the section “Using a Windows Server 2016 Machine as Your Management Station”). The
GPMC can also be added to a Windows 7, Windows 8, Windows 8.1, or Windows 10
machine via an extra download and install called RSAT. RSAT stands for Remote Server
Administration Tools, and after installing it, you’ll find tools like Active Directory Users
and Computers as well as the GPMC, which we’ll use right around the bend.

When we create a GPO that can be used in Active Directory, two things happen: we
create some brand-new entries within Active Directory, and we automatically create some
brand-new files within our Domain Controllers. Collectively, these items make one GPO.

You can think of Active Directory as having three major levels:

Site
Domain

ou

Additionally, since OUs can be nested within each other, Active Directory has a nearly
limitless capacity for where we can tuck stuff away.

In fact, it’s best to think of this design as a three-tier hierarchy: site, domain, and each
nested OU. When wishes, er, policy settings, are set at a higher level in Active Directory,
they automatically flow down throughout the remaining levels.

So, to be precise:

If a GPO is set at the site level, the policy settings contained within affect those
accounts within the geography of the site. Sure, their user account could be in one
domain and their computer account could be in another domain. And of course, it’s
likely that those accounts are in an OU. But the account is affected only by the policy
settings here because the account is in a specific site. And logically, when a computer
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starts up in a new site, the User object will also get its site-based Group Policy from the
same place. This is based on the IP subnet the user is a part of and is configured using
Active Directory Sites and Services.

If a GPO is set at the domain level, it affects those users and computers within the
domain and all OUs and all other OUs beneath it.

If a GPO is set at the OU level, it affects those users or computers within the OU and
all other OUs beneath it (usually just called child or sub-OUs).

By default, when a policy is set at one level, the levels below inberit the settings from the
levels above it. You can have “cumulative” wishes that keep piling on.

You might wonder what happens if two policy settings conflict. Perhaps one policy is set
at the domain level and another policy is set at the OU level, which reverses the edict in the
domain. The result is simple: policy settings further down the food chain take precedence.
For instance, if a policy setting conflicts at the domain and OU levels, the OU level “wins.”
Likewise, domain-level settings override any policy settings that conflict with previously set
site-specific policy settings. This might seem counterintuitive at first, so bear with me for a
minute.

Take a look at the following illustration to get a view of the order of precedence.

Local (least amount
of precedence)

GPO linked to Site

GPO linked to Domain

G Windows client

User account  (any version)

GPO linked to OU
(most amount of precedence)

The golden rule with Group Policy is truly, “Last writer wins.” Another way
P to say itis, “If any GPOs conflict, the settings contained in the last-written

GPO win.”
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However, don’t forget about any Local Group Policy that might have been set on a spe-
cific workstation. Regardless, once that local policy is determined, only then do policy set-
tings within Active Directory (the site, domain, and OU) apply. So, sometimes people refer
to the four levels of Group Policy: local workstation, site, domain, and OU. Nonetheless,
GPOs set within Active Directory always trump the Local Group Policy should there be
any conflict.

If this behavior is undesirable for lower Active Directory levels, all the settings from
higher Active Directory levels can be blocked with the “Block Inheritance” attribute on a
given OU. Additionally, if a higher-level administrator wants to guarantee that a setting
is inherited down the food chain, they can apply the “Enforced” attribute via the GPMC
interface. (Panic not! Chapter 2 explores both “Block Inheritance” and “Enforced” attri-
butes in detail.)

Note that you cannot “Block Inheritance” between Local GPOs and Active Directory
GPOs. But it is true that anything you set within Active Directory to inverse a Local GPO
setting is always honored. Said another way, Active Directory edicts trump local edicts.
You can, however, literally “turn off” Local Group Policy Objects from processing. In
Windows Vista and later, there is a policy setting found in Computer Configuration >
Policies > Administrative Templates > System > Group Policy entitled Turn off Local
Group Policy Object processing, which, when set to Enabled, will prevent Local Group
Policy Objects from affecting the machine.

y Don’t sweat it if your head is spinning a little now from the Group Policy

A TE application theory. I'll go through specific hands-on examples to illustrate
each of these behaviors so that you understand exactly how this works.

Linking Group Policy Objects

Another technical concept that needs a bit of description here is the “linking” of GPOs.
When a GPO “appears” to be “created” at the site, domain, or OU level via the GUI (which
we’ll do in a moment), what’s really happening is quite different. It’s created in one set
“place,” then merely “linked” there. (Yes, I know there are a lot of “quotes” in the last sen-
tence, but sometimes that’s how I “write.”)

Anyway, when you tell the system, “I want to affect an OU with this new GPO,” the sys-
tem automatically creates the GPO in the fixed location and then associates that GPO with
the level at which you want to affect. That association is called linking.

Linking is an important concept for several reasons. First, it’s generally a good idea to
understand what’s going on under the hood. However, more practically, the Group Policy
Management Console (GPMC), as we’ll explore in just a bit, displays GPOs from their
linked perspective.

Let’s extend the metaphor a little more.
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You can think of all the GPOs you create in Active Directory as children in a big swim-
ming pool. Each child has a tether attached around their waist, and an adult guardian is
holding the other end of the rope. Indeed, there could be multiple tethers around a child’s
waist, with multiple adults tethered to one child. A sad state indeed would be a child who
has no tether but is just swimming around in the pool unsecured. The swimming pool in
this analogy is a specific Active Directory container named Policies (which we’ll examine
closely in Chapter 7, “Troubleshooting Group Policy”). All GPOs are born and “live” in
that specific domain. Indeed, they’re replicated to all Domain Controllers. The adult guard-
ian in this analogy represents a level in Active Directory—any site, domain, or OU.

In our swimming pool example, multiple adults can be tethered to a specific child. With
Active Directory, multiple levels can be linked to a specific GPO. Thus, any level in Active
Directory can leverage multiple GPOs, which are standing by in the domain ready to be
used.

Remember, though, unless a GPO is specifically linked to a site, a domain, or an OU, it
does not take effect. It’s just floating around in the swimming pool of the domain waiting
for someone to make use of it.

I’ll keep reiterating and refining the concept of linking throughout the first four chapters.
And, as necessary, I'll discuss why you might want to “unlink” a policy.

This concept of linking to GPOs created in Active Directory can be a bit confusing. It
will become clearer later as we explore the processes of creating new GPOs and linking to
existing ones. Stay tuned. That discussion is right around the corner.

Multiple Local GPOs (Vista and Later)

Okay, as promised, we need to take a second swipe at Local GPOs.

Starting with Vista and continuing on through Windows 10, there’s a secret superpower
that takes Local Group Policy to the next level.

The last time I discussed Local GPOs, I stated this:

This Local Group Policy affects everyone who logs onto this
machine—including normal users and administrators. Be careful
when making settings here; you can temporarily lock yourself out of
some useful functions.

True—for pre-Vista machines, like Windows XP. On Vista and later, however, the
superpower feature is that you can decide who gets which settings at a local level. This fea-
ture is called Multiple Local GPOs (MLGPOs).

MLGPOs are most often handy when you want your users to get one gaggle of settings
(that is, desktop restrictions) but you want to ensure that your access is unfettered for day-
to-day administration.

Now, in these examples we’re going to use Windows 10, but this same feature is avail-
able on Vista and later (including Windows Server 2008 and later). It’s just not all that
likely you’ll end up using it on a Windows Server.
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Understanding Multiple Local GPOs

The best way to understand MLGPOs is by thinking of the end product. That is, when
we’re done, we want our users to embrace some settings, and we (administrators) want to
potentially embrace some settings or avoid some settings. We can even get granular and
dictate specific settings to just one user.

By typing GPEDIT.MSC at a command prompt, you’re running the utility to affect all
users—mere mortals and administrators.

But with Vista and later, there are actually three “layers” that can be leveraged to ensure
that some settings affect regular users and other settings affect you (the administrator).

Let’s be sure to understand all three layers before we get too gung ho and try it out.
When MLGPOs are processed, Windows Vista and later checks to see if the layer is being
used and if that layer is supposed to apply to that user:

Layer 1 (Lowest Priority) The Local Computer Policy. You create this by running
GPEDIT.MSC.

The settings you make on the Computer Configuration side are guaranteed to
affect all users on this computer (including administrators).

The settings you make on the User Configuration side may be trumped by Layer 2
or Layer 3.

Layer 2 (Next Highest Priority) Is the user a mere mortal or a local administrator? (One
account cannot be both.) This layer cannot contain Computer Configuration settings.

Layer 3 (Most Specific) Is this a specific user who is being dictated a specific policy? This
layer cannot contain Computer Configuration settings.

You can see this graphically laid out in Figure 1.3.
If no conflicts exist among the levels, the effect is additive. For instance, let’s imagine the
following:

Layer 1 (Everyone): The wish is to restrict “Lock this PC” from the Ctrl+Alt+Del area
in Windows 10. We’ll use the Remove Lock Computer policy setting that we already
saw in Figure 1.2.

Then, at Layer 2 (Users, but not Administrators): We say “All local users” will have
Task Manager gone from the Ctl+Alt+Del screen in Windows 10.

Then, at Layer 3 (a specific user): We say Fred, a local user, will be denied access to the
Control Panel.

The result for Fred will be the sum total of all edicts at all layers.

But what if there’s a conflict between the levels? In that case, the layer that’s “closest to
the user” wins (also known as “Last writer wins”). So, if at the Local Computer Policy the
wish is to Remove Lock Computer from the Ctrl+Alt+Del area but that area is expressly
granted to Sally, a local user on that machine, Sally will still be able to use the Lock com-
mand. That’s because we’re saying that she is expressly granted the right at Layer 3, which
“wins” over Layers 1 and 2.

«
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FIGURE 1.3 Ablockdiagram of how MLGPOs are applied to a system
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Trying Out Multiple Local GPOs on Windows 10

Just typing GPEDIT.MSC at the Start screen doesn’t give you the magical “layering” super-
power. Indeed, just typing GPEDIT.MSC performs the exact same function as it did in
Windows XP. That is, every edit you make while you run the Local Computer Policy affects
all users logged onto the machine.

To tell Vista and later you want to edit one of the layers (as just described), you need to
load the Group Policy Object Editor by hand. We’ll do this on WIN10.
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On WINT10, to load the Group Policy Object Editor by hand, follow these steps:

1. From the Start screen, start typing MMC (which will bring up the Search box). A
“naked” MMC appears. Note that you may have to approve a User Access Control
(UAC) dialog message (UAC is discussed in detail in Chapter 8, “Implementing Secu-
rity with Group Policy”).

2. From the File menu, choose Add/Remove Snap-in to open the Add/Remove Snap-in
dialog box.

3. Locate and select the Group Policy Object Editor Snap-in and click Add (don’t choose
the Group Policy Management Snap-in, if present—that’s the GPMC that we’ll use a
bit later).

4. At the Select Group Policy Object screen, note that the default Local Computer Policy
is selected. Click Browse.

5. The “Browse for a Group Policy Object” dialog box appears. Select the Users tab and
select the layer you want. That is, you can pick Non-Administrators or Administrators,
or click a specific user, or choose the Administrator account, as seen in Figure 1.4.

FIGURE 1.4 Edit specific layers of Windows MLGPOs by first adding the Group
Policy Object Editor into a “naked” MMC. Then browse for the Windows Local Group
Policy by firing up GPEDIT.MSC.
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In the Group Policy Object Exists column in the Users tab, you can also tell
P whether or not a local GPO layer is being used.

6. At the “Select Group Policy Object” dialog box, click Finish.
7. At the “Add or Remove Snap-ins” dialog box, click OK.

You should now be able to edit that layer of the local GPO. For instance, Figure 1.5 shows
that Ive chosen to edit the Non-Administrators portion of the GPO (which is on level 2).

FIGURE 1.5 Below the words Console Root, you can see which layer of the local
GPO you're specifically editing.
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To edit additional or other layers of the local GPO, repeat the previous steps.

Here’s an important point that bears repeating: Layers 2 and 3 of the MLGPO cannot
contain overriding computer settings from Layer 1. That’s why in Figure 1.5 you simply
don’t see them—they’re not there. If you want to introduce a Computer-side setting that
affects everyone on the machine, just fire up GPEDIT.MSC and you’ll be off and running.
That’s Layer 1, and it affects everyone.

Final Thoughts on Local GPOs

You can think of Local Group Policy as a way to perform desktop management in a decen-
tralized way. That is, you’re still running around, more or less, from machine to machine
where you want to set the Local Group Policy.

The other strategy is a centralized approach. Centralized Group Policy administration
works only in conjunction with Active Directory and is the main focus of this book.

aging Multiple Local Group Policy” from Microsoft. At last check, the URL
was http://tinyurl.com/oqgl8at. The steps should work for all versions
of Windows starting with Vista.

é/ For more information, check out the article “Step-by-Step Guide to Man-
P
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In case you’re curious, Local Group Policy is stored in the %windir%\system32\group-
policy directory (usually C:\windows\system32\grouppolicy). The structure found here
mirrors what you’ll see later in Chapter 7 when we inspect the ins and outs of how Group
Policy applies from Active Directory. Windows Vista and later store Level 2 (Admin/Non-
Admin Local Policies) and specific Local User Policies (Level 3) inside %windir%\system32\
grouppolicyusers.

You will notice one folder per user policy you have created, each named with the
Security ID (SID) of the relevant user object.

An Example of Group Policy Application

At this point, it’s best not to jump directly into adding, deleting, or modifying our own
GPOs. Right now, it’s better to understand how Group Policy works “on paper.” This
is especially true if you’re new to the concept of Group Policy, but perhaps also if Group
Policy has been deployed by other administrators in your Active Directory.

By walking through a fictitious organization that has deployed GPOs at multiple levels,
you’ll be able to better understand how and why policy settings are applied by the deploy-
ment of GPOs.

Let’s start by taking a look at Figure 1.6, the organization for our fictitious example
company, Example.com.

This picture could easily tell a thousand words. For the sake of brevity, I've kept it down
to around 200. There are two domains: Example.com and Widgets.example.com. Let’s talk
about Example.com:

The domain Example.com has two Domain Controllers. One DC, named EXAM-
PLEDCI, is physically located in the California site. Example.com’s other Domain
Controller, EXAMPLEDC2, is physically located in the Phoenix site.

As for PCs, they need to physically reside somewhere. SallysPC is in the California site;
BrettsPC and AdamsPC are in the Delaware site. JoesPC is in the Phoenix site. FredsPC
is in the California site, and MarksPC is in the New York site.

User accounts may or may not be in OUs. Dave’s and Jane’s account are in the Human
Resources OU.

Computer accounts may or may not be in OUs. FredsPC is in the Human Resources
OU. AdamsPC is specifically placed within the High Security OU. And that High
Security OU is actually within the Human Resources OU (also known as a sub-OU.).
JoesPC, SallysPC, BrettsPC, and MarksPC are hanging out in a container and aren’t in
any OUs.

Using Active Directory Sites and Services, you can put in place a schedule to regulate
communication between EXAMPLEDCT1 located in California and EXAMPLEDC2
located in Phoenix. That way, the administrator controls the chatter between the two
Example.com Domain Controllers, and it is not at the whim of the operating system.
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FIGURE 1.6 This fictitious Example.com is relatively simple. Your environment may
be more complex.

California Site

FredsPC Dave |
High
Security OU [ )

( Phoenix Site

BrettsPC

EXAMPLEDC2 Delaware Site

Example.com

Implicit two-way trust

MarksPC ] widgets.example.com

Another domain, called Widgets.example.com, has an implicit transitive two-way
trust to Example.com. There is only one Domain Controller in the Widgets.example.
com domain, named WIDDC1, and it physically resides at the Phoenix site. Last, there is
MarksPC, a member of the Widgets.example.com domain, and it physically resides in the
New York site and isn’t in any OU.

Understanding where your users and machines are is half the battle. The other half is
understanding which policy settings are expected to appear when they start logging onto
Active Directory.
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Examining the Resultant Set of Policy

As stated earlier, the effect of Group Policy is cumulative as GPOs are successively applied—
starting at the local computer, then the site, the domain, and each nested OU. The end
result of what affects a specific user or computer—after all Group Policy at all levels has
been applied—is called the Resultant Set of Policy (RSoP). This is sometimes referred to as
the RSoP calculation.

Throughout your lifetime working with Group Policy, you will be asked to troubleshoot
the RSoP of client machines.

and troubleshoot the RSoP of a particular configuration. Getting a good,
early understanding of how to perform manual RSoP calculations on paper
is important because it's a useful troubleshooting skill. In Chapters 3 and 7,
we’ll also explore additional RSoP skills—with tools and additional manual
troubleshooting.

é/ Many of our dealings with Group Policy will consist of trying to understand
P

Before we jump in to try to discover what the RSoP might be for any specific machine,
it’s often helpful to break out each of the strata—local computer, site, domain, and OU—
and examine, at each level, what happens to the entities contained in them. I’ll then bring it
all together to see how a specific computer or user reacts to the accumulation of GPOs. For
these examples, assume that no local policy is set on any of the computers; the goal is to get
a better feeling of how Group Policy flows, not necessarily what the specific end state will be.

At the Site Level

Based on what we know from Figure 1.6, the GPOs in effect at the site level are shown here:

Site Computers Affected

California SallysPC, EXAMPLEDCI1, and FredsPC
Phoenix EXAMPLEDC2, JoesPC, and WIDDC1
New York MarksPC

Delaware AdamsPC and BrettsPC

If we look at the graphic again, it looks like Dave, for instance, resides in California and
Jane, for instance, resides in Delaware. But I don’t like to think about it like that. I prefer to
say that their accounts reside in OUs.

But users are affected by site GPOs only when they log onto computers that are at a spe-
cific site.
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In Figure 1.6, we have Dave’s and Jane’s accounts in the Human Resources OU. And that’s
great. But they’re only affected by California site-level GPOs if they travel to California. It
doesn’t matter where they usually reside; again, they’re only affected by the site-level GPOs
when they’re physically present in that site. So if they travel to California, they will get the
GPOs related to California first; then other GPOs (described later) will apply.

So, don’t think that user accounts reside at the site level. Rather, they reside in the OU
level but are using computers in the site and, hence, get the properties assigned to all users
at that site.

e Sites are defined using the Active Directory Sites and Services tool. IP

P subnets that constitute a site are assigned using this tool. That way, if a
new computer turns on in Delaware, Active Directory knows what site the
computer is in.

At the Domain Level

Here’s what we have working at the domain level:

Domain Computers/Users Affected

Example.com Computers SallysPC, FredsPC, AdamsPC, BrettsPC, JoesPC,
EXAMPLEDC1, and EXAMPLEDC2

Example.com Users Dave and Jane

Widgets.example.com Computers ~ WIDDC1 and MarksPC

At the OU Level

At the organizational unit level, we have the following:

Organizational Unit ~ Computers/Users Affected

Human Resources FredsPC is in the Human Resources OUj therefore, it is

OU Computers affected when the Human Resources OU gets GPOs applied.
Additionally, the High Security OU is contained inside the
Human Resources OU. Therefore, AdamsPC, which is in
the High Security OU, is also affected whenever the Human
Resources OU is affected.

Human Resources The accounts of Dave and Jane are affected when the Human
OU Users Resources OU has GPOs applied.
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Bringing It All Together

Now that you’ve broken out all the levels and seen what is being applied to them, you can
start to calculate what the devil is happening on any specific user and computer combi-
nation. Looking at Figure 1.6 and analyzing what’s happening at each level makes add-
ing things together between the local, site, domain, and organizational unit GPOs a lot

easier.

Here are some examples of RSoP for specific users and computers in our fictitious

environment:

FredsPC

MarksPC

AdamsPC

Dave using AdamsPC

x

FredsPC inherits the settings of the GPOs from the Califor-
nia site, then the Example.com domain, and last, the Human
Resources OU.

MarksPC first accepts the GPOs from the New York site and
then the Widgets.example.com domain. MarksPC is not in
any OU; therefore, no organizational unit GPOs apply to his
computer.

AdamsPC is subject to the GPOs at the Delaware site, the
Example.com domain, the Human Resources OU, and the
High Security OU.

AdamsPC is subject to the computer policies in the GPOs
for the Delaware site, the Example.com domain, the Human
Resources OU, and finally the High Security OU. When
Dave travels from California to Delaware to use Adam’s
workstation, his user GPOs are dictated from the Delaware
site, the Example.com domain, and the Human Resources
OU (where Dave’s account is actually contained).

At no time are any domain GPOs from the Example.com parent domain
JTE automatically inherited by the Widget.example.com child domain. Inheri-

tance for GPOs only flows downward to OUs within a single domain—not
between any two domains—parent to child or otherwise, unless you explic-
itly link one of those parent GPOs to a child Domain Container.
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If you want one GPO to affect the users in more than one domain, you have four choices:
Precisely re-create the GPOs in each domain with their own GPO.

Copy the GPO from one domain to another domain (using the GPMC, as explained in
Chapter 2 in the section “Basic Interdomain Copy and Import”).

Use a third-party tool that can perform some magic and automatically perform the
copying between domains for you.

Do a generally recognized no-no called cross-domain policy linking. (L1l describe this
no-no in detail in Chapter 7 in the section “Group Policy Objects from a Domain Per-
spective.”)

Also, don’t assume that linking a GPO at a site level necessarily guarantees the results
to just one domain. In this example, as in real life, there is not necessarily a 1:1 correlation
between sites and domains. Indeed, without getting too geeky here, sites technically belong
to the forest and not any particular domain.

At this point, we’ll put our example Example.com behind us. That was an on-paper
exercise to allow you to get a feel for what’s possible in Group Policy-land. From this point
forward, you’ll be doing most items in your test lab and following along.

Group Policy, Active Directory, and
the GPMC

The Group Policy Management Console (GPMC) was created to help administrators work
in a “one-stop-shop” place for all Group Policy management functions. Since 2003, it was
freely downloadable as an add-on to either Windows XP or Windows Server 2003 systems.

Today, the GPMC is built into the server operating systems (Server 2008 R2, Windows
Server 2016, etc.). And it’s also available for download as part of the RSAT tools for your
own machine (say, Windows 7 or 10).

Even though I’ve said it before, it bears repeating: it doesn’t matter if your Active
Directory or domains or Domain Controllers are Windows 2000, Windows 2003,
Windows 2008, Windows 2008 R2, Windows 2012, Windows 2012 R2, Windows
Server 2016, or whatever. The Group Policy infrastructure doesn’t care what domain type
or Domain Controllers you have.

The GPMC’s name says it all. It’s the Group Policy Management Console. Indeed, this
will be the MMC snap-in that you use to manage the underlying Group Policy mechanism.
The GPMC just helps us tap into those features already built into Active Directory. I’ll
highlight the mechanism of how Group Policy works throughout the next three chapters.

One major design goal of the GPMC is to get a Group Policy—centric view of the lay of the
land. The GPMC also provides a programmatic way to manage your GPOs. In fact, the GPMC
scripting interface allows just about any GPO operation. You can do the same “stuff” with
the GPMC that you do with the mouse programmatically with VBScript and PowerShell.
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We’ll explore scripting Group Policy operations normally performed with the GPMC,
but instead using PowerShell in Appendix A, a downloadable bonus chapter, “Scripting
Group Policy Operations with Windows PowerShell.”

y The VBScript GPMC scripts, which were previously part of the download-
A&TE able GPMC package, are not included in the newest GPMC. You have to
specifically download them from the GPMC scripting center at http://
tinyurl.com/23xfz3 or search for “Group Policy Management Console
Sample Scripts” in your favorite search engine.

There are lots of ways you could manage your Group Policy universe. Some people walk
up to their Domain Controllers, log onto the console, and manage their Group Policy infra-
structure there. Others use a management workstation and manage their Group Policy
infrastructure from their own Windows 10 workstation (suggested).

I’ll talk more about the use and best practices of a Windows 10 management worksta-
tion in Chapter 6.

Implementing the GPMC on Your Management Station

As I mentioned, the GPMC isn’t built into Windows 10. But it is built into Windows Server
2016. Remember earlier I stated that you could manage your Active Directory from any-
where. And this is true. You could walk up to a Domain Controller, you could install the
GPMC on a Windows Server 2016 server, or you could use Terminal Services to remotely
connect to a Domain Controller.

But in this book, you won’t be. Your ideal management station is a Windows 10
machine (where we’ll manually introduce the GPMC) or a Windows Server 2016 machine
(which is ready to go, no pesky downloads needed).

Windows 7 and Windows Server 2008 R2 are perfectly fine choices as well, but there is
a small downside with those GPMCs. That is, they aren’t the “latest, greatest” and do lack
some of the newest features, which we’ll explore in the next chapter. One good example of
this is that the Windows 7 version of GPMC will not have the Group Policy Preferences item
type for Internet Explorer 10. The idea is that Microsoft will only put new or updated func-
tionality in the latest, greatest GPMC, and today, that GPMC is Windows 10’s (and Windows
Server 2016’s). (They share the same guts.) That being said, if you only had a Windows 7
GPMC to use, it wouldn’t be the end of the world, and you’ll likely be pretty happy.

If you must use something else (Windows XP, Windows Server 2003, or Windows
Vista), you’ll see me pepper in some advice for those. But you’ll really want to use the rec-
ommended set to get the most out of this book

Using a Windows 10 or Windows Server 2016 Management Station

For this book, and for real life, I recommend that you use what’s known as a Windows 10
management station. And, to make use of it to implement Group Policy in your domain,
you’ll need to introduce the downloadable GPMC on it.
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Note that you could also use a Windows Server 2016 machine as your management sta-
tion. Honestly, the Windows 10 GPMC that you’ll download and the built-in GPMC for
Windows Server 2016 are equals. There’s no difference. But it’s simply not likely you’re
going to install Windows Server 2016 on your laptop or desktop.

So, just to be clear, the following two ways to create and manage GPOs are equal:

Windows 10 and the downloadable GPMC (contained within the RSAT tools)
Windows Server 2016 with its built-in GPMC

I’ll usually just refer to a Windows 10 management station, and when I say that, [ mean
what I have in that first bullet point. Just remember that you can use a Windows Server
2016 machine as your management station, too.

Now, to be super-crazy, ridiculously clear: you could also use any of the other GPMCs
out there, and things will basically “work.” T delve into this in serious detail in Chapter 6,
but here’s the CliffNotes, er, JeremyNotes version of “What GPMC should I use?”:

Always strive to use Windows 10 (or Windows Server 2016) as your management sta-
tion and you’ll always be able to control all operating systems’ settings from all operat-
ing systems. If by the time you read this book, something after Windows 11 is out—use
that GPMC. Always use the latest GPMC.

The next best choice would be Windows 8.1 (with Update 1) and RSAT or Server
2012 R2.

After that, the next best choice would be Windows 7 or Windows Server 2008 R2,
which has “almost” all the same stuff as Windows 8’s GPMC (but not quite).

Everything else would be suboptimal to use.

But if you have even one Windows 10 client machine (say in Sales or Marketing),
in order to manage all its settings you’re going to need to manage the machine using a
“modern” GPMC. So I’'m suggesting you just bite the bullet and get yourself a copy of
Windows 10 and do your management from there.

Again, more details later, but here’s the warning. If you create a GPO using a “newer
GPMC” (say, using a Windows 10 or Windows Server 2016 GPMC) but then edit it using
an older operating system (say, a Windows 7 or XP GPMC), you might not be able to
“see” all the configurable options. And what’s worse, some settings might be set (but you
wouldn’t be able to see them!). Only the newest GPMC can see the “stuff” that the newest
GPMC puts into the GPO.

P management station? Well, you’ve got another option. Perhaps you can
create a Windows 10 or Windows Server 2016 machine to act as your man-
agement station, say in the server room. Or, use VMware Workstation or
another virtualization tool to make an “almost real” management machine.
Or, do create a real machine but set up Terminal Services or Remote Desk-
top to utilize the GPMC remotely.

g/ What if you're not “allowed” to load Windows 10, 8.1, or 7 on your own
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Again, in our examples we’ll call our machine WINTOMANAGEMENT, but you can
use either a Windows 10 or Windows Server 2016 for your best management station
experience.

Using a Windows Server 2016 Machine as Your Management Station

The latest GPMC is available in Windows Server 2016. However, it’s not magically
installed in most cases. The only time it is just “magically there” is when you make your
Windows Server 2008, Windows Server 2008 R2, or Windows Server 2016 machine a
Domain Controller. In that case, the GPMC is automatically installed for you. You don’t
need to do the following procedure.

And, if you're following along in the labs, you've likely already made your server a
Domain Controller. But for practice, if you want to learn how to install it for when your
server is not acting as a Domain Controller, there are two ways to install the GPMC: using
Server Manager and also by the command line.

To install the GPMC using Server Manager:

1. From the Start screen, select Server Manager.
2. Click Dashboard, then select “Add roles and features.”

3. In the “Add Roles and Features” wizard, you’ll eventually get to the Features screen.
Be sure Group Policy Management is selected.

4. Click Install.

Close Server Manager once you’re done.
You can also install the GPMC using the command line:

1. Open a PowerShell prompt as an Administrator.
2. In PowerShell, type Add-WindowsFeature GPMC.

3. Close the command prompt when the installation has been completed.

Using Windows 10 as Your Management Machine

The first step on your Windows 10 management-station-to-be is to install Windows 10.

RSAT comes as a Microsoft Update Standalone Package and installs like a hotfix, and
you may or may not need to reboot after installation. At last check, you can download the
Windows 10 RSAT from www.microsoft.com/en-us/download/details.aspx?id=45520.

All the tools installed automatically when you install the Update Package. You can see
the tools already installed in Figure 1.7.

Once you’re done, close the Windows Features window and, if prompted, reboot your
Windows 10 machine. The next time you boot, you’ll have Active Directory Users and
Computers, the GPMC, and other tools available for use in the rest of the book.

If you cannot use a Windows 10 management machine and can only use a Windows 8.1
or 7 management machine, then the steps are the same for Windows 7, except the RSAT down-
load is different. The RSAT for Windows 8.1 RSAT can be found at http://tinyurl.com/
win8lrsat and the Windows 7 SP1 can be found at http://tinyurl.com/win7rsat-spl.
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FIGURE 1.7 The RSAT tools installed in Windows Features in the Control Panel >
Programs > “Turn Windows features on or off”
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Creating a One-Stop-Shop MMC

As you’ll see, the GPMC is a fairly comprehensive Group Policy management tool. But the
problem is that right now the GPMC and the Active Directory Users and Computers snap-
ins are, well, separate tools that each do a specific job. They’re not integrated to allow you
to work on the idea of Users and Computers and Group Policy at the same time.

Often, you’ll want to change a Group Policy linked to an OU and then move comput-
ers to that OU. Unfortunately, you can’t do so from the GPMC; you must return to Active
Directory Users and Computers to finish the task. This can get frustrating quickly. But
that’s the deal.

As a result, my preference is to create a custom MMC that shows both the Active
Directory Users and Computers and GPMC in a one-stop-shop view. You can see what I
mean in Figure 1.8.

You might be wondering at this point, “So, Jeremy, what are the steps I need in order to
create this unified MMC console you’ve so neatly described and shown in Figure 1.8?”

Just click Start and type MMC at the Search prompt. Then add in both the Active Directory
Users and Computers and Group Policy Management snap-ins, as shown in Figure 1.9.

edit one Group Policy Object at a time), the Group Policy Object Editor (for
Local Group Policy), or the Group Policy Starter GPO Editor (which we use
in Chapter 2).

é/ You won't need the Group Policy Management Editor (which allows you to
P
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FIGURE 1.8 Usethe MMC to create a unified console.
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FIGURE 1.9 Add Active Directory Users and Computers and Group Policy
Management to your custom view.
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Once you have added both snap-ins to your console, you’ll have a near-unified view of
most of what you need at your fingertips. Both Active Directory Users and Computers and
the GPMC can create and delete OUs. Both tools also allow administrators to delegate
permissions to others to manage Group Policy, but that’s where the two tools’ functionality
overlap ends.

The GPMC won’t show you the actual users and computer objects inside the OU, so delet-
ing an OU from within the GPMC is dicey at best because you can’t be sure of what’s inside!
You can choose to add other snaps-ins, too, of course, including Active Directory Sites

and Services or anything else you think is useful. The illustrations in the rest of this book will
show both snap-ins loaded in this configuration. I suggest you save your “one-stop shop” to the
Desktop and give it catchy name so you can quickly find it later when you need to.

Group Policy 101 and Active Directory

Let’s start with some basics to ensure that things are running smoothly. For most of the
examples in this book, you’ll be able to get by with just the one Domain Controller and one or
two workstations that participate in the domain, for verifying that your changes took place.

For the examples in this book, I'll refer to our sample Domain Controller, DCO1,
dnz which is part of my example Corp.com domain. For these examples, you can
choose to rename the Default-First-Site-Name site or not—your choice.

Again, I encourage you to try these examples in your test lab and not to try them directly
on your production network. This will help you avoid a CLM (career-limiting move).

For our examples, we’ll assume you’re using WINIOMANAGEMENT as your manage-
ment station, which is a Windows 10 with RSAT machine.

Active Directory Users and Computers vs. GPMC

The main job of Active Directory Users and Computers is to give you an Active Directory
object—centric view of your domain. Active Directory Users and Computers lets you deal
with users, computers, groups, contacts, some of the Flexible Single Master Operations
(FSMO) roles, and delegation of control over user accounts as well as change the domain
mode and define advanced security and auditing inside Active Directory. You can also cre-
ate OUs and move users and computers around inside those OUs. Other administrators can
then drill down inside Active Directory Users and Computers into an OU and see the com-
puters, groups, contacts, and so on that you’ve moved to those OUs.

But the GPMC has one main job: to provide you with a Group Policy—centric view of all
you control. All the OUs that you see in Active Directory Users and Computers are visible
in the GPMC. Think about it—it’s the same Active Directory behind the scenes “storing”
those details about the OU and its contents.
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However, the GPMC just doesn’t have a way to “view” the users, computers, contacts,
and such. When you drill down into an OU inside the GPMC, you’ll see but one thing: the
GPOs that affect the objects inside the OU.

In Figure 1.8, you were able to see the Active Directory Users and Computers view as
well as the GPMC view—rolled into one MMC that we created earlier. Even though it’s not
super-obvious from the screen shot, the Active Directory Users and Computers view of an
OU and the GPMC view of the same OU are radically different. For instance, in Figure 1.8
I’ve added (for the sake of this discussion) an OU called Temporary Office Help and some
other OUs, too, for fun.

When focused at a site, a domain, or an OU within the GPMC, you see only the GPOs
that affect that level in Active Directory. You don’t see the same “stuff” that Active Directory
Users and Computers sees, such as users, computers, groups, or contacts.

The basic overlap in the two tools is the ability to create and delete OUs. If you add
or delete an OU in either tool, you need to refresh the other tool by pressing F5 to see the
update. For instance, in Figure 1.8 you could see that my Active Directory has several OUs,
including the one I added named Temporary Office Help.

sh Deleting an OU from inside the GPMC is generally a bad idea. Because you
ING cannot see the Active Directory objects inside the OU (such as users and
computers), you don’'t know how many objects you're about to delete. So
be careful!

If T delete the Temporary Office Help OU in Active Directory Users and Computers, the
change is not reflected in the GPMC window until it’s refreshed. And vice versa.
So, let’s summarize with three key points:

Understanding that the two tools are “separate” and work on the same underlying
database is key.

Understanding that what you do in one tool (e.g., delete an OU) affects the other tool
(because it’s affecting the same underlying database) is also key.

The final key is realizing that you will need to occasionally “refresh” the view of
each tool. This is because other administrators might be “doing stuff” to the GPOs
and/or Active Directory user accounts. You won’t see their changes until you refresh
your view.

Adjusting the View within the GPMC

The GPMC lets you view as much or as little of your Active Directory as you like. By
default, you view only your own forest and domain. You can optionally add in the ability
to see the sites in your forest as well as the ability to see other domains in your forest or
domains in other forests, although these views might not be the best for seeing what you
have control over.
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Here’s how to view the various other items you may need to within the GPMC:

Viewing Sites in the GPMC When you create GPOs, you won’t often create GPOs that
affect sites. The designers of the GPMC seem to agree; it’s a bit of a chore to apply GPOs

to sites. To do so, you need to link an existing GPO to a site. You’ll see how to do this a bit
later in this chapter.

However, you first need to expose the site objects in Active Directory. To do so, right-click
the Sites object in GPMC, choose Show Sites from the context menu (see Figure 1.10), and
then click the check box next to each site you want to expose.

FIGURE 1.10 You need to expose the Active Directory sites before you can link
GPOs to them.
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In our first example, we’ll use the site level of Active Directory to deploy our first Group
Policy Object. At this point, go ahead and enable the Default-First-Site-Name so that you
can have it ready for use in our own experiments.

Viewing Other Domains in the GPMC To see other domains in your forest, drill down
to the Forest folder in Group Policy Management, right-click Domains, choose Show
Domains, and select the other available domains in your forest. Each domain will now
appear at the same hierarchical level in the GPMC.

Viewing Other Forests in the GPMC To see other forests, right-click the root (Group
Policy Management) and choose Add Forest from the context menu. You’ll need to type
the name of the Active Directory forest you want to add. If you want to add or subtract
domains within that new forest, follow the instructions in the preceding paragraph.

Now that we’ve adjusted our view to see the domains and forests we want, let’s examine
how to manipulate our GPOs and GPO links.
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defaults will not display these domains as a safety mechanism. To turn off
the safety mechanism, choose View > Options to open the Options dialog
box. In the General tab, clear Enable Trust Detection and click OK.

é/ You can add forests with which you do not have a trust. However, GPMC
P

The GPMC-centric View

As I stated earlier, one of the fundamental concepts of Group Policy is that the GPOs them-
selves live in the “swimming pool” inside the domain. Then, when you want to utilize a
GPO from that swimming pool against a level in Active Directory, you simply link a GPO
to that level.

Figure 1.11 shows what our swimming pool will eventually look like when we’re done
with the examples in this chapter.

FIGURE 1.11 Imagine your about-to-be-leveraged GPOs as just hanging out in the
swimming pool of the domain.
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Our swimming pool will be full of GPOs, with various levels in Active Directory “linked”
to those GPOs. To that end, you can drill down, right now, to see the representation of the
swimming pool. It’s there, waiting for you. Click Group Policy Management > Forest >
Domains > Corp.com > Group Policy Objects to see all the GPOs that will exist in the
domain by the time we’re done (see Figure 1.12).

FIGURE 1.12 The Group Policy Objects folder highlighted here is the
representation of the swimming pool of the domain that contains your actual GPOs.
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If you're just getting started, it's not likely you’ll have more than the

daTE “Default Domain Controllers Policy” GPO and “Default Domain Policy”
GPO. That’s okay. You'll start getting more GPOs soon enough. Oh, and for
now, please don’t modify the default GPOs. They're a bit special and are
covered in great detail in Chapter 8.

All GPOs in the domain are represented in the Group Policy Objects folder. As you can
see, when the Temporary Office Help OU is shown within the GPMC, a relationship exists
between the OU and the “Hide Desktop Settings Option” GPO. That relationship is the
tether to the GPO in the swimming pool—the GPO is linked back to “Hide Desktop Settings
Option.” You can see this linked relationship because the “Hide Desktop Settings Option”
icon inside Temporary Office Help has a little arrow icon, signifying the link back to the
actual GPO in the domain. The same is true for the “Default Domain Policy,” which is linked
at the domain level, but the actual GPO is placed below the Group Policy Objects folder.
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Our Own Group Policy Examples

Now that you’ve got a grip on honing your view within the GPMC, let’s take it for a quick
spin around the block with some examples!

For this series of examples, we’re going after the users who keep fiddling with their dis-
play doo-dads in Windows 10.

If you want to see these examples in action using Windows 10, start out on WIN10 by
looking at the “Change the visuals and sounds on your computer” page, which is located
by right-clicking the Desktop and choosing Personalize. In the left column, you’ll see items
including “Change desktop icons” and “Change mouse pointers.” In the bottom section,
you’ll see several entries, including Desktop Background, Window Color, Sounds, and
Screen Saver, as shown in Figure 1.13.

FIGURE 1.13 The Windows 10 Personalization page—unconfigured by Group Policy
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For our first use of Group Policy, we’re going to produce four “edicts” (for dramatic effect,
you should stand on your desk and loudly proclaim these edicts with a thick British accent):

At the site level, there will be no ability to change screen savers.

At the domain level, there will be no ability to change Windows’ sounds.



38 Chapter 1 = Group Policy Essentials

At the Human Resources Users OU level, there will be no way to change the mouse
pointers. And, while we’re at it, let’s bring back the ability to change screen savers!

At the Human Resources Computers OU, we’ll make it so whenever anyone uses a
Human Resources computer, calc.exe automatically launches after login.

Following along with these concrete examples will reinforce the concepts presented ear-
lier. Additionally, they are used throughout the remainder of this chapter and the book.

Understanding GPMC's Link Warning

As you work through the examples, you'll do a lot of clicking around. When you click a
GPO link the first time, you'll get this message:

Group Policy Management Console

You have selected a link to a Group Policy Object (GPO). Bxcept for
changes to link properties, changes you make here are global to the GPO,
and will impact all other locations where this GPO ig linked.

[ Do not show this message again

This message is trying to convey an important sentiment—that is, multiple levels in
Active Directory may be linked back and use the exact same GPO. The idea is that mul-
tiple levels of Active Directory could use the exact same Group Policy Object contained
inside the Group Policy Objects container—but just be linked back to it.

What if you modify the policy settings by right-clicking a policy link and choosing Edit
from the context menu? All instances in Active Directory that link to that GPO embrace
the new settings. If this is a fear, you might want to create another GPO and then link it to
the level in Active Directory you want. More properties are affected by this warning, and
we'll explore them in Chapter 4, “Advanced Group Policy Processing.”

If you've squelched this message by selecting “Do not show this message again,” you
can get it back. In the GPMC in the menus, choose View > Options and select the General
tab, then select “Show confirmation dialog box to distinguish between GPOs and GPO
links” and click OK.

More about Linking and the Group Policy
Objects Container

The GPMC is a fairly flexible tool. Indeed, it permits the administrator to perform many
tasks in different ways. One thing you’ll do quite a lot in your travels with the GPMC is
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create your own Group Policy Objects. Again, GPOs live in a container within Active
Directory and are represented within the Group Policy Objects container (the swimming
pool) inside the domain (seen in Figure 1.11, earlier in this chapter). Any levels of Active
Directory—site, domain, or OU—simply link back to the GPOs hanging out in the Group
Policy Objects container.
To apply Group Policy to a level in Active Directory using the GPMC, you have two

options:

Create the GPOs in the Group Policy Objects container first. Then, while focused at

the level you want to command in Active Directory (site, domain, or OU), manually

add a link to the GPO that is in the Group Policy Objects container.

While focused at the level you want to command in Active Directory (domain or OU),
create the GPOs in the Group Policy Objects container and automatically create the
link. This link is created at the level you’re currently focused at back to the GPO in the
Group Policy Objects container.

Which is the correct way to go? Both are perfectly acceptable because both are doing the
same thing.

In both cases the GPO itself does not “live” at the level in Active Directory at which
you’re focused. Rather, the GPO itself “lives” in the Group Policy Objects container. The
link back to the GPO inside the Group Policy Objects container is what makes the relation-
ship between the GPO inside the Group Policy Objects container swimming pool and the
level in Active Directory you want to command.

To get the hang of this, let’s work through some examples. First, let’s create our first
GPO in the Group Policy Objects folder. Follow these steps:

1. Launch the GPMC. Click Start, and then in the search box, type GPMC.MSC.

2. Traverse down by clicking Group Policy Management > Forest > Domains > Corp.
com > Group Policy Objects.

3. Right-click the Group Policy Objects folder and choose New from the context menu, as
shown in Figure 1.14, to open the New GPO dialog box.

4. Let’s name our first edict, er, GPO, something descriptive, such as “Hide Screen Saver
Option.”

5. Once the name is entered, you’ll see the new GPO listed in the swimming pool. Right-
click the GPO and choose Edit, as shown in Figure 1.15, to open the Group Policy
Management Editor.

6. To hide the Screen Saver option, drill down by clicking User Configuration > Poli-
cies > Administrative Templates > Control Panel > Personalization. Double-click the
Prevent changing screen saver policy setting to open it. Select the Enabled setting, and
click OK.

7. Close the Group Policy Management Editor.
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FIGURE 1.14 You create your first GPO in the Group Policy Objects container by
right-clicking and choosing New.
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FIGURE 1.15 You can right-click the GPO in the Group Policy Objects container and
choose Edit from the context menu to open the Group Policy Management Editor.
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Note that in earlier iterations of the GPMC, this setting was named differ-
doTE ently and placed in another node. It used to be called Hide Screen Saver
Tab and was located in the Display node within Control Panel. As you can
see, as the operating system evolves, so do the names of the policy set-
tings, Group Policy Preference items (described in Chapter 5), and the
capabilities within the GPMC itself. This is why it’s pretty important to
always use the “latest, greatest” GPMC, as we are doing in this book.

Understanding Our Actions

Now that we have this “Hide Screen Saver Option” edict, er, GPO floating around in
the Group Policy Objects container—in the representation of the swimming pool of the
domain—what have we done? Not a whole lot, actually, other than create some bits inside
Active Directory and on the Domain Controllers. By creating new GPOs in the Group
Policy Objects folder, we haven’t inherently forced our desires on any level in Active
Directory—site, domain, or OU.

To make a level in Active Directory accept our will, we need to link this new Group
Policy Object to an existing level. Only then will our will be accepted and embraced. Let’s
do that now.

Applying a Group Policy Object to the Site Level

The least-often-used level of Group Policy application is at the site. This is because it’s got
the broadest stroke but the bluntest application. And more and more organizations use high-
speed links everywhere, so it’s not easy to separate computers into individual sites because
(in some organizations) Active Directory is set up to see the network as just one big site!

Additionally, since Active Directory states that only members of Enterprise
Administrators (EAs) can modify sites and site links, it’s equally true that only EAs (by
default) can add and manipulate GPOs at the site level.

A JITE the Domain Administrators (DAs) of the root domain can create and modify
sites and site links. When multiple domains exist, DAs in domains other
than the root domain cannot create sites or site links (or site-level GPOs).

)’r When a tree or a forest contains more than one domain, only the EAs and

However, site GPOs might come in handy on occasion. For instance, you might want
to set up site-level GPO definitions for network-specific settings, such as Internet Explorer
proxy settings or an IP security policy for sensitive locations. Setting up site-based settings
is useful if you have one building (set up explicitly as an Active Directory site) that has
a particular or unique network configuration. You might choose to modify the Internet
Explorer proxy settings if this building has a unique proxy server. Or, in the case of IP
security, perhaps this facility has particularly sensitive information, such as confidential
records or payroll information.
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Therefore, if you’re not an EA (or a DA of the root domain), it’s likely you’ll never get to
practice this exercise outside the test lab. In upcoming chapters I’ll show you how to del-
egate these rights to other administrators, like OU administrators.

For now, we’ll work with a basic example to get the feel of the Group Policy
Management Editor.

We already stood on our desks and loudly declared that there will be no Screen Saver
options at our one default site. The good news is that we’ve already done two-thirds of
what we need to do to make that site accept our will: we exposed the sites we want to man-
age, and we created the “Hide Screen Saver Option” GPO in the Group Policy Objects
container.

sh Implementing GPOs linked to sites can have a substantial impact on your
ING logon times and WAN (wide area network) traffic if not performed cor-
rectly. For more information, see Chapter 7 in the section “Group Policy
Objects from a Site Perspective.”

Now all we need do is to tether the GPO we created to the site with a GPO link.
To remove the Screen Saver option using the Group Policy Management Editor at the site
level, follow these steps:

1. Inside the GPMC snap-in, drill down by clicking the Group Policy Management folder,
the Forest folder, and the Sites folder.

2. Find the site to which you want to deliver the policy. If you have only one site, it is
likely called Default-First-Site-Name.

3. Right-click the site and choose “Link an Existing GPO,” as shown in Figure 1.16.
4. Now you can select the “Hide Screen Saver Option” GPO from the list of GPOs in the
Group Policy Objects container within the domain.

Once you have chosen the GPO, it will be linked to the site.

s Did you notice that there was no “Are You Sure You Really Want To Do
ING This?” warning or anything similar? The GPMC trusts that you set up the

GPO correctly. If you create GPOs with incorrect settings and/or link them
to the wrong level in Active Directory, you can make boo-boos on a grand
scale. Again, this is why you want to try any setting you want to deploy in a
test lab environment first.

Again, there is a good reason GPOs for sites must be pre-created. Since Sites does not
belong to a specific domain but rather the forest, you cannot assume which “domain swim-
ming pool” a particular GPO should be added to. By creating them this way, you know
which domain you created them in first and then to what site you want them linked.
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FIGURE 1.16 Once you have your first GPO designed, you can link it to your site.
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Verifying Your Changes at the Site Level

Now, log onto any workstation or server that falls within the boundaries of the site to
which you applied the sitewide GPO. If you didn’t change any of the defaults, you should be
able to log onto any computer in the domain (say, WIN10) as any user you have defined—
even the administrator of the domain.

Right-click the Desktop and select Personalize. Then click Lock Screen on the left, and
try the Screen Saver option toward the bottom of the page. When you try it, you’ll see what
happens, which you can also see in Figure 1.17.

Don’t panic if you do not see the changes reflected the first time you log

A ITE on. See Chapter 3, “Group Policy Processing Behavior Essentials,” in the
section “Background Refresh Policy Processing” to find out how to encour-
age changes to appear. To see the Screen Saver tab disappear right now,
log off and log back on. The policy should take effect.
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FIGURE 1.17 InWindows 10 the Screen Saver entry on the Personalization page is
disabled.
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This demonstration should prove how powerful Group Policy is, not only because every-
one at the site is affected, but more specifically because administrators are not immune
to Group Policy effects. Administrators are not immune because they are automatically
members of the Authenticated Users security group. (You can modify this behavior with the
techniques explored in Chapter 3.)

Applying Group Policy Objects to the Domain Level

At the domain level, we want to deliver an edict that says that the Sounds option in the
Windows Personalization page should be removed.

Active Directory domains allow only members of the Domain Administrators group the
ability to create and link Group Policy directly on the domain level. Therefore, if you’re
not a DA (or a member of the EA group), or you don’t get delegated the right, it’s likely
that you’ll never get to practice this exercise outside the test lab. (A bit later we’ll talk more
about how to give others besides Domain Admins rights to create and link GPOs.)

To apply the edict, follow these steps:

1. In the GPMC, drill down by clicking Group Policy Management > Forest > Corp.com.

2. Right-click the domain name to see the available options, as shown in Figure 1.18.
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FIGURE 1.18 Atthe domain level, you can create the GPO in the Group Policy
Objects container and then immediately link to the GPO from here.
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“Create a GPO in this domain, and Link it here” vs. “Link an Existing GPO"”

In the previous example, we forced the site level to embrace our “Hide Screen Saver Option”
edict. First, we created the GPO in the Group Policy Objects folder, and then in another step
we linked the GPO to the site level. However, at the domain level (and, as you're about to see,
the OU level), we can take care of both steps at once via the “Create a GPO in this domain,
and Link it here” command. (Note, in previous versions of the GPMC, this was confusingly
called “Create And Link A GPO Here.” Being a grammar snob, this was a personal wish of
mine to have clarified, and I'm happy to see Microsoft agreed and corrected it.)

This command tells the GPMC to create a new GPO in the Group Policy Objects folder and
then automatically link the new GPO back to this focused level of Active Directory. This

is a time-saving step so we don’t have to dive down into the Group Policy Objects folder
first and then create the link back to the Active Directory level.

So why is the “Create a GPO in this domain, and Link it here” option possible only at the
domain and OU level and not the site level? Because Group Policy Objects linked to sites
can often cause excessive bandwidth troubles when the old-school way of doing things
is used. With that in mind, the GPMC interface makes sure that when you work with GPOs
that affect sites, you're consciously choosing from which domain the GPO is being linked.
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Don’t panic when you see all the possible options. We’ll hit them all in due time; right
now we’re interested in the first two: “Create a GPO in this domain, and Link it here” and
“Link an Existing GPO.”

Since you’re focused at the domain level, you are prompted for the name of a new
Group Policy Object when you right-click and choose “Create a GPO in this domain, and
Link it here.” For this one, type a descriptive name, such as “Prohibit Changing Sounds.”
Your new “Prohibit Changing Sounds” GPO is created in the Group Policy Objects
container and, automatically, a link is created at the domain level from the GPO to the
domain.

P GPO. Simply drill down through Group Policy Management > Forest >
Domains > Corp.com and locate the Group Policy Objects node. Look for
the new “Prohibit Changing Sounds” GPO.

é/ Take a moment to look in the Group Policy “swimming pool” for your new

Right-click the link “Prohibit Changing Sounds” (or the GPO itself) and choose Edit to
open the Group Policy Management Editor. To make your wish come true and affect the
sounds applet Windows 10 Personalization page, drill down through User Configuration >
Policies > Administrative Templates > Control Panel > Personalization, and double-click
Prevent changing sounds. Change the setting from Not Configured to Enabled, and click
OK. Close the Group Policy Management Editor to return to the GPMC.

Note that the policy setting will only affect Windows 7 and later, so any Windows XP
machines (if you have any) will ignore the policy setting.

Verifying Your Changes at the Domain Level

Now, log on as any user in the domain. You can log onto any computer in the domain (say,
WINT10) as any user you have defined—even the administrator of the domain.

On WINT10, right-click the Desktop and click Personalize > Themes > Go to Advanced
sound settings.

You’ll see in Figure 1.19 the before and after. On the left, you’ll see that before the pol-
icy applies, there are four tabs in the Sound applet. After the policy applies, there are three
tabs in the Sounds applet.

The actual policy name was called Prevent changing sounds. Note that it didn’t prevent
access to the Sounds applet, but instead removed the most critical tab, the Sounds tab, in
the Sound applet.

Once again, administrators are not immune to Group Policy effects. You can change this
behavior, as you’ll see in Chapter 2.
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FIGURE 1.19 The Sounds applet goes from four tabs to three tabs because the user
is affected by the domain-level policy
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Applying Group Policy Objects to the OU Level

OUs are wonderful tools for delegating away unpleasant administrative duties, such as
password resets or modifying group memberships. But that’s only half their purpose. The
other half is to be able to apply Group Policy.

You’ll likely find yourself making most Group Policy additions and changes at the OU
level, because that’s where you have the most flexibility and the OU is the most refined
instrument to affect users. Once OU administrators become comfortable in their surround-
ings, they want to harness the power of Group Policy.
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Preparing to Delegate Control

To create a GPO at the OU level, you must first create the OU and a plan to delegate. For
the examples in this book, we’ll create three OUs that look like this:

Human Resources
Human Resources Users
Human Resources Computers

Having separate OUs for your users and computers is a good idea—for both delega-
tion of rights and GPO design. Microsoft considers this a best practice. In the Human
Resources Users OU in our Corp.com domain, we’ll create and leverage an Active
Directory security group to do our dirty work. We’ll name this group HR-OU-Admins and
put our first users inside the HR-OU-Admins security group. We’ll then delegate the appro-
priate rights necessary for them to use the power of GPOs.

To create the Human Resources Users OU using your WINIOMANAGEMENT
machine, follow these steps:

1. Earlier, you created a “unified console” where you housed both Active Directory
Users and Computer and the GPMC. Simply use Active Directory Users and Comput-
ers, right-click the domain name, and choose New > Organizational Unit, which will
allow you to enter a new OU name. Enter Human Resources as the name. (Note that
newer versions of Active Directory Users and Computers will ask you if you want to
“Protect container from accidental deletion.” It’s your choice. I typically deselect the

check box.)

2. Inside the Human Resources OU, create two more OUs—Human Resources Computers
and Human Resources Users, as shown in Figure 1.20.

FIGURE 1.20 When you complete all these steps, your Human Resources OU
should have a Human Resources Users OU and Human Resources Computers OU. In the
users’ side, put Frank Rizzo and the HR-OU-Admins.
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Alternatively, you can create the OU in the GPMC. Just right-click the
P domain and choose New Organizational Unit from the context menu.

To create the HR-OU-Admins group, follow these steps:

1. In Active Directory Users and Computers, right-click the new Human Resources Users

OU and choose New > Group.
2. Create the new group HR-OU-Admins as a new global security group.
To create the first user to go inside HR-OU-Admins, follow these steps:

1. In Active Directory Users and Computers, right-click the Human Resources Users OU
and choose New > User.

2. Name the user Frank Rizzo, with an account name of frizzo, and click Next.

3. Modern domains require a complex password for a user. Again, my suggested pass-
word is p@sswOrd. That’s a lowercase p, the at sign, an s, an s, a w, a zero, then 7,

and d.
4. Finish and close the wizard.

If you’re following along, Frank Rizzo’s login will be frizzo@corp.com.

Easily Manage New Users and Computers

The Computers folder and Users folder in Active Directory Users and Computers are not
OUs. They are generic containers. You'll notice that they are not present when you're
using the GPMC to view Active Directory. Because they are generic containers (and not
OUs), you cannot link Group Policy Objects to them. Of course, these objects will receive
GPOs if linked to the domain, because the containers are still inthe domain. They just
aren’t OUs in the domain.

These folders have two purposes:

If you ever did an upgrade from NT 4 domains to Active Directory, these User and
Computer accounts would wind up in these folders. (Administrators are then sup-
posed to move the accounts into OUs.)

The two folders are the default location where older tools drop new accounts when
creating new users and computers. Additionally, command-line tools, such as net
user and net group, will add accounts to these two folders. Similarly, the Computers
folder is the default location for any new client workstation or server that joins the
domain. The same goes when you create computer accounts using the net computer
command.
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So, these seem like decent “holding pens” for these kinds of objects. But ultimately, you
don’t want your users or computers to reside in these folders for very long—you want
them to end up in OUs. That’s where the action is because you can apply Group Policy to
OUs, not to these folders! Yeah, sure, these users and computers are affected by site- and
domain-level GPOs. But the action is at the OU level, and you want your computer and
user objects to be placed in OUs as fast as possible—not sitting around in these generic
Computers and Users folders.

To that end, domains that are at least at the “Windows 2003 functional level” have two
tools to redirect the default location of new users and computers to the OUs of your
choice. For example, suppose you want all new computers to go to a NewComputers

OU and all new users to go to a NewUsers OU. And you want to link several GPOs to

the NewUsers and NewComputers OUs to ensure that new accounts immediately have
some baseline level of security, restriction, or protection. Without a little magic, new user
accounts created using older tools won't automatically be placed there.

Starting with Windows 2003 Active Directory, Microsoft provided REDIRUSR and REDIRCMP
commands that take a distinguished name, like this:

REDIRCMP ou=newcomputers,dc=corp,dc=com and/or
REDIRUSR ou=newusers,dc=corp,dc=com

Now if you link GPOs to these OUs, your new accounts will get the Group Policy Objects
dictating settings to them at an OU level. This will come in handy when users and com-
puters aren’t specifically created in their final destination OUs.

To learn more about these tools, see the Microsoft Knowledge Base article 324949 at
http://support.microsoft.com/kb/324949.

To add Frank Rizzo to the HR-OU-Admins group, follow these steps:
1. Double-click the HR-OU-Admins group.
2. Click the Members tab.
3. Add Frank Rizzo.

When it’s all complete, your OU structure with your first user and group should look
like Figure 1.20, shown previously.

Delegating Control for Group Policy Management

You’ve created the Human Resources OU, which contains the Human Resources Users OU
and the Human Resources Computers OU and the HR-OU-Admins security group. Now,
put Frank inside the HR-OU-Admins group, and you’re ready to delegate control.



http://support.microsoft.com/kb/324949

Our Own Group Policy Examples 51

Performing Your First Delegation

You can delegate control to use Group Policy in two ways: using Active Directory Users
and Computers and using the GPMC.

For this first example, we'll kick it old school and do it the Active Directory
P Users and Computers way. Then, in Chapter 2, I'll demonstrate how to del-
egate control using the GPMC.

To delegate control for Group Policy management, follow these steps:

1. In Active Directory Users and Computers, right-click the top-level Human Resources
OU you created and choose Delegate Control from the context menu to start the “Del-
egation of Control Wizard.”

2. Click Next to get past the wizard introduction screen.

3. You’ll be asked to select users and/or groups. Click Add, add the HR-OU-Admins
group, and click Next to open the “Tasks to Delegate” screen, shown in Figure 1.21.

FIGURE 1.21 Selectthe “Manage Group Policy links” task.
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4. Click “Manage Group Policy links,” and then click Next.

5. At the wizard review screen, click Finish.

You might want to click some or all the other check boxes as well, but for

P this example, only “Manage Group Policy links” is required. Avoid select-
ing “Generate Resultant Set of Policy (Planning)” and “Generate Resultant
Set of Policy (Logging)” at this time. You'll see where these options come
into play in Chapter 2.
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The “Manage Group Policy links” delegation assigns the user or group

doTE Read and Write access over the gPLink and gPOptions properties for that
level. To see or modify these permissions by hand, open Active Directory
Users and Computers and choose View > Advanced Features. If later you
want to remove a delegated permission, it’s a little challenging. To locate
the permission that you set, right-click the delegated object (such as OU),
click the Properties tab, click the Security tab, choose Advanced, and dig
around until you come across the permission you want to remove. Finally,
delete the corresponding access control entry (ACE).

Adding a User to the Server Operators Group (Just for This Book)

Under normal conditions, nobody but Domain Administrators, Enterprise Administrators,
or Server Operators can walk up to Domain Controllers and log on. For testing purposes
only, though, we’re going to add our user, Frank, to the Server Operators group so he can
easily work on our DC01 Domain Controller when we want him to.

To add a user to the Server Operators group, follow these steps:

1. In Active Directory Users and Computers, double-click Frank Rizzo’s account under
the Human Resources Users OU.

2. Click the Member Of tab and click Add.
3. Select the Server Operators group and click OK.
4. Click OK to close the Properties dialog box for Frank Rizzo.
Normally, you wouldn’t give your delegated OU administrators Server Operators access.

You’re doing it solely for the sake of this example to allow Frank to log on locally to your
Domain Controllers.

Testing Your Delegation of Group Policy Management

At this point, on your WINIOMANAGEMENT machine, log off as Administrator and log
in as Frank Rizzo (frizzo@corp.com).
Now follow these steps to test your delegation:

1. Choose Start and type GPMC.MSC at the Start Search prompt to open the GPMC.

2. Drill down through Group Policy Management, Domains, Corp.com, and Group Pol-
icy Objects. If you right-click Group Policy Objects in an attempt to create a new GPO,
you’ll see the context menu shown in Figure 1.22.

As you can see, Frank is unable to create new GPOs in the swimming pool of the
domain. Since Frank has been delegated some control over the Human Resources OU
(which also contains the other OUs), let’s see what he can do. If you right-click the Human
Resources OU in the GPMC, you’ll see the context menu shown in Figure 1.23.
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FIGURE 1.22 Frankcannot create new GPOs in the Group Policy Objects container.
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FIGURE 1.23 Frank’s delegated rights allow him to link to existing GPOs but not to
create new GPOs.
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Because Frank is unable to create GPOs in the swimming pool of the domain (the
Group Policy Objects container), he is also unable by definition to “Create a GPO in this
domain, and Link it here.” Although Frank (and more specifically, the HR-OU-Admins)
has been delegated the ability to “Manage Group Policy links,” he cannot create new
GPOs. Frank (and the other potential HR-OU-Admins) has only the ability to link an
existing GPO.

Understanding Group Policy Object Linking Delegation

When we were logged on as the Domain Administrator, we could create GPOs in the
Group Policy Objects container, and we could “Create a GPO in this domain, and Link it
here” at the domain or OU levels. But Frank cannot.

Here’s the idea about delegating the ability to link to GPOs: someone with a lot of brains
in the organization does all the work in creating a well-thought-out and well-tested GPO.
Maybe this GPO distributes software, maybe it sets up a secure workstation policy, or per-
haps it runs a startup script. You get the idea.

Then, others in the organization, like Frank, are delegated just the ability to link to
that GPO and use it at their level. This solves the problem of delegating perhaps too much
control. Certainly some administrators are ready to create their own users and groups, but
other administrators may not be quite ready to jump into the cold waters of Group Policy
Object creation. Thus, you can design the GPOs for other administrators; they can just link
to the ones you (or others) create.

When “Link an Existing GPO” is selected (as seen in Figure 1.23), any GPO which lives
in the Group Policy Objects “swimming pool” can be selected.

In this example, the HR-OU-Admins members, such as Frank, can leverage any cur-
rently created GPO to affect the users and computers in their OU—even if they didn’t cre-
ate it themselves. In this example, Frank has linked to an existing GPO called “Word 2003
Settings.” Turns out that some other administrator in the domain created this GPO, but
Frank wants to use it. So, because Frank has “Manage Group Policy links” rights on the
Human Resources OU (and OUs underneath it), he is allowed to link to it.

But, as you can see in Figure 1.24, he cannot edit the GPOs. Under the hood, Active
Directory doesn’t permit Frank to edit GPOs he didn’t create (and therefore doesn’t own).

In Chapter 2, I'll show you how to grant specific rights to allow more than
P just the original creator (and now owner) of the object to edit specific
GPOs.

Giving the ability to just link to existing GPOs is a good idea in theory, but often OU
administrators are simply given full authority to create their own GPOs (as you’ll see later).
For this example, don’t worry about linking to any GPOs. Simply cancel out of the Select
GPO screen, close the GPMC, and log off from the server as Frank Rizzo.



FIGURE 1.24 The GPMC will not allow you to edit an existing GPO if you do not
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own it (or do not have explicit permission to edit it).
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Granting OU Admins Access to Create New Group
Policy Objects

By using the “Delegation of Control Wizard” to delegate the “Manage Group Policy links”
attribute, you performed half of what is needed to grant the appropriate authority to Frank
(and any additional future HR-OU-Admins) to create GPOs in the Group Policy Objects
container and link them to the Human Resources OU, the Human Resources Users OU,

or the Human Resources Computers OU (though we really don’t want to link many GPOs
directly to the Human Resources OU).

You can grant the HR-OU-Admins the ability to create GPOs in the Group Policy
Objects container in two ways. For now, I’ll show you the old-school way; in Chapter 2, T’ll
show you the GPMC way.

One of Active Directory’s built-in security groups, Group Policy Creator Owners, holds
the key to the other half of our puzzle. You’ll need to add those users or groups that you
want to have the ability to create GPOs to a built-in group, cleverly named Group Policy
Creator Owners. To do so, follow these steps:

1. Log off and log back on as Domain Administrator.
2. Fire up Active Directory Users and Computers.

3. By default, the Group Policy Creator Owners group is located in the Users folder in the
domain. Double-click the Group Policy Creator Owners group and add the HR-OU-
Admins group and/or Frank Rizzo.
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é/ In Chapter 2, you'll see an alternate way to allow users to create GPOs.
P

Creating and Linking Group Policy Objects at the OU Level

At

the site level, we hid the Screen Saver option. At the domain level, we chose to get rid of

the Sounds option in the Windows 10 Personalization page.

1.

At the OU level, we have two jobs to do:
Prevent users from changing the mouse pointers (a Windows 7 and later policy setting)
Restore the Screen Saver option that was taken away at the site level

To create a GPO at the OU level, follow these steps:

Since you’re on WINTOMANAGEMENT, log off as Administrator and log back on as
Frank Rizzo (frizzo@corp.com).

2. Choose Start and type GPMC.MSC in the Start Search prompt.

3. Drill down until you reach the Human Resources Users OU, right-click it, and choose

“Create a GPO in this domain, and Link it here” from the context menu to open the
New GPO dialog box.

In the New GPO dialog box, type the name of your new GPO, say “Hide Mouse Point-
ers Option / Restore Screen Saver Option.” This will create a GPO in the Group Policy
Objects container and link it to the Human Resources Users OU.

Right-click the Group Policy link and choose Edit from the context menu to open the
Group Policy Management Editor.

To hide the mouse pointers option in the Group Policy editor, drill down through User
Configuration > Policies > Administrative Templates > Control Panel > Personaliza-
tion and double-click the Prevent changing mouse pointers policy setting. Change the
setting from Not Configured to Enabled, and click OK.

To restore the Screen Saver setting for Windows 10, double-click the Prevent Changing
Screen Saver policy setting. Change the setting from Not Configured to Disabled, and
click OK.

Close the Group Policy Management Editor to return to the GPMC.

Enable setting set at a higher level. See the sidebar “The Three Possible

é/ By disabling the Hide Screen Saver Tab policy setting, you're reversing the
P

Settings: Not Configured, Enabled, and Disabled” later in this chapter.

Verifying Your Changes at the OU Level

On your test WIN10 machine, log back on as Frank. Because Frank’s account is in the OU,
Frank is destined to get the site, domain, and now the new OU GPOs with the policy settings.
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On WINT10, right-click the Desktop and choose Personalize from the context menu to

open the Display Properties dialog box.

You can now (as Frank) click Themes, and when you then try to click on “Go to mouse
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pointer settings” you will see what’s in Figure 1.25.

You should also now (as Frank) be able to click within Personalization upon the Lock
Screen menu, and when you try to click on “Screen saver settings” you will be able to

open it.

In Figure 1.25, you can see the before (left) and after (right) when the policy is applied.

57

Look closely, and note that the “Pointers” option in the Mouse Properties applet is removed
and that the Screen Saver option is no longer grayed out and is now available.

FIGURE 1.25 On the top, we have Frank’s Personalization page where Frank
can now get to his Screen Saver settings. On the bottom (left) you can see Frank’s
Mouse Properties before the policy applies. On the bottom (right) you can see
Frank’s Mouse Properties after the policy applies (and note the missing “Pointers” tabs).
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This test proves, once again, that even OU administrators are not automatically immune
from policy settings. Chapter 2 explains how to change this behavior.

Group Policy Strategy: Should | Create More or Fewer GPOs?

At times, you’ll want to lock down additional functions for a collection of users or com-
puters. For example, you might want to specify that no users in the Human Resources
Users OU can use the Control Panel.

At the Human Resources Users OU level, you've already set up a GPO that contained a
policy setting to hide the mouse pointers option in the Windows 10 Personalization page.
You can create a new GPO that affects the Human Resources Users OU, give it a descrip-
tive name—say, No One Can Use Control Panel—and then drill down through User Con-
figuration> Policies > Administrative Templates > Control Panel and enable the policy
setting Prohibit Access to Control Panel.

Or you could simply modify your existing GPO, named Hide Mouse Pointers Option/
Restore Screen Saver Option, so that it contains additional policy settings. You can then
rename your GPO to something that makes sense and encompasses the qualities of all
the policy changes—say “Our Human Resources Users’ Desktop Settings.”

Here's the quandary: the former method (one policy setting per GPO) is certainly more
descriptive and definitely easier to debug should things go awry. If you have only one pol-
icy set inside the GPO, you have a better handle on what each one is affecting. If some-
thing goes wrong, you can dive right into the GPO, track down the policy setting, and
make the necessary changes, or you can disable the ornery GPO (as discussed in Chapter 2
in the section “Stopping Group Policy Objects from Applying”).

The second method (multiple policy settings per GPO) is a teeny-weeny bit faster for your
computers and users at boot or logon time because each additional GPO takes some
miniscule fraction of additional processing time. But if you stuff too many settings in an
individual GPO, the time to debug should things go wrong goes up exponentially. Group
Policy has so many nooks and crannies that it can be difficult to debug.

So, in a nutshell, if you have multiple GPOs at a particular level, you can do the following:
Name each of them more descriptively.
Debug them easily if things go wrong.
Disable individually misbehaving GPOs.
Associate a specific GPO more easily to a WMI filter (explored in Chapter 6).

More easily delegate permissions to any specific GPO (explored in Chapter 2).
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If you have fewer GPOs at a particular level, the following is the case:

Logging on is slightly faster for the user (but only slightly).
Debugging is somewhat more difficult if things go wrong.

You can disable individually misbehaving GPOs or links to misbehaving GPOs. (But if
they contain many settings, you might be disabling more than you desire.)

So, how do you form a GPO strategy? There is no right or wrong answer; you need to
decide what's best for you. Several options, however, can help you decide.

One middle-of-the-road strategy is to start with multiple GPOs and one lone policy set-
ting in each. Once you are comfortable that they are individually working as expected,
you can create another new GPO that contains the sum of the settings from, in this exam-
ple, Prevent Changing Mouse Pointers and Prohibit Access to Control Panel, and then
delete (or disable) the old individual GPO.

Another middle-of-the-road strategy is to have a single GPO that contains only the policy
settings required to perform a complete “wish.” This way, if the wish goes sour, you can
easily address it or disable it (or whack it) as needed.

Here's yet another strategy. Some Microsoft documentation recommends that you create
GPOs so that they affect only the User half or the Computer half. You can then disable the
unused portion of the GPO (either the Computer half or the User half). This allows you to
group together policy settings affecting one node for ease of naming and debugging and
allows for flexible troubleshooting. However, be careful here because after you disable
half the GPO, there’s no iconic notification (though there is a column labeled GPO Status
that does show this). Troubleshooting can become harder if not performed perfectly and
consistently. In all, I'm not a huge fan of disabling half the GPO.

Creating a New Group Policy Object Affecting
Computers in an OU

For the sake of learning and working through the rest of the examples in this section, you’ll
create another GPO and link it to the Human Resources Computers OU. This GPO will
autolaunch a very important application for anyone who uses these machines: calc.exe.

)’ The setting we're about to play with also exists under the User node, but
A&TE we'll experiment with the Computer node policy.

First, you’ll need to create the new GPO and modify the settings. You’ll then need to
move some client machines into the Human Resources Computers OU in order to see your
changes take effect.
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To autolaunch calc.exe for anyone logging into a computer in the Human Resources

Computers OU, follow these steps:

1.

If you’re not already logged in as Frank Rizzo, the Human Resources OU administra-
tor, do so now on WIN1IOMANAGEMENT.

Choose Start and type GPMC.MSC in the Start Search prompt.

Drill down until you reach the Human Resources Computers OU, right-click it, and
choose “Create a GPO in this domain, and Link it here” from the context menu.

Name the GPO something descriptive, such as “Auto-Launch calc.exe.”

Right-click the GPO, and choose Edit to open the Group Policy Management Editor.

. We want to affect our client computers (not users), so we need to use the Computers

node. To autolaunch calc.exe, drill down through Computer Configuration > Policies
> Administrative Templates > System > Logon, and double-click Run these programs
at user logon. Change the setting from Not Configured to Enabled.

Click the Show button, and the Show Contents dialog box appears. You’ll see that this
policy setting has a little “table editor” associated with it. In the first “row,” simply
enter the full path to calc.exe as c:\windows\system32\calc.exe and click OK, as
shown in Figure 1.26. Click OK to close the Show Contents dialog box, and click OK
again to close the Run these programs at user logon policy setting.

FIGURE 1.26 When this policy setting is enabled and calc.exe is specified, all
computers in this OU will launch calc.exe when a user logs in.
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8. Close the Group Policy Management Editor to return the GPMC.

enable a policy to disable a setting. Since Windows 2003, most policy set-
tings have been renamed to “Prohibit <whatever>" to reflect the change
from confusion to clarity.

é/ Be aware of occasional strange Microsoft verbiage when you need to
P

Moving Computers into the Human Resources
Computers OU

Since you just created a policy that will affect computers, you’ll need to place a workstation
or two inside the Human Resources Computers OU to see the results of your labor. You’ll
need to be logged on as Administrator on DC01 or WIN1TOMANAGEMENT to do this.

e Quite often computers and users are relegated to separate OUs. That
P way, certain GPOs can be applied to certain computers but not others. For
instance, isolating laptops, desktops, and servers is a common practice.

In this example, we’re going to use the Find command in Active Directory Users and
Computers to find your workstation named WIN10 and move it into the Human Resources
Computers OU.

To find and move computers into a specific OU, follow these steps:

1. In Active Directory Users and Computers, right-click the domain, and choose Find
from the context menu to open the “Find Users, Contacts, and Groups” dialog box.

2. From the Find drop-down menu, select Computers. In the Name field, type WIN10
to find the computer account of the same name. Once you’ve found it, right-click the
account and choose Move from the context menu, as shown in Figure 1.27. Move the
account to the Human Resources Computers OU.

3. Now that you’ve moved WINT10 (or other example machines) into the new OU, be sure
to reboot those client computers.

7 After you move the computer accounts into the Human Resources Com-
ING puters OU, it's very important to reboot your client machines. As you'll see

in Chapter 3, the computer does not recognize the change right away when
computer accounts are moved between OUs.

As you can see in this example (and in the real world), a best practice is to separate
users and computers into their own OUs and then link GPOs to those OUs. Indeed,
underneath a parent OU structure, such as the Human Resources OU, you might have
more OUs (that is, Human Resources Laptops OU, Human Resources Servers OU, and
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so on). This will give you the most flexibility in design between delegating control where
it’s needed and the balance of GPO design within OUs. Just remember that for GPOs to
affect either a user or computer, that user or computer must be within the scope of the
GPO—site, domain, or OU.

FIGURE 1.27 Use the Find command to find computers in the domain, then right-
click the entry and select Move to move them.
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Verifying Your Cumulative Changes

At this point, you’ve set up three levels of Group Policy that accomplish multiple actions:
= At the site level, the “Hide Screen Saver Option” GPO is in force for users.
= At the domain level, the “Prohibit Changing Sounds” GPO is in force for users.

= In the Human Resources Users OU, the “Hide Mouse Pointers Option/Restore Screen
Saver Option” GPO is in force for users.

= In the Human Resources Computers OU, the “Auto-Launch calc.exe” GPO is in force
for computers.
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At this point, take a minute to flip back to Figure 1.11 (the swimming pool illustration)
to see where we’re going here. To see the accumulation of your policy settings inside your
GPOs, you'll need to log on as a user who is affected by the Human Resources Users OU
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and at a computer that is affected by the Human Resources Computers OU. Therefore, log

on as Frank Rizzo at WINT10.

If you’re using Windows 10, right-click the Desktop and choose Personalize. Note that
the removal of “Change mouse pointers” is still in force (and the Screen Saver entry is
restored). And, when you logged in as Frank Rizzo, did the computer GPO autolaunch
Windows Calculator?

e These tests prove that even OU administrators are not automatically

P immune from GPOs and the policy settings within. Under the hood, they
are in the Authenticated Users security group. See Chapter 2 for informa-
tion on how to modify this behavior.

The Three Possible Settings: Not Configured, Enabled, and Disabled

As you saw in Figure 1.2 earlier in this chapter, nearly all administrative template policy
settings can be set as Not Configured, Enabled, or Disabled. These three settings have
very different consequences, so it's important to understand how each works.

Not Configured The best way to think about Not Configured is to imagine that it really
says, “Don’t do anything” or even “Pass through.” Why is this? Because if a policy setting
is set to Not Configured, then it honors any previously set setting (or the operating sys-
tem default).

Enabled When a specific policy setting is enabled, the policy will take effect. In the case
of the Prohibit Changing Sounds policy setting, the effect is obvious. However, lots of
policy settings, once enabled, have myriad possibilities inside the specific policy set-
ting! (For a gander at one such policy setting, use the Group Policy Management Editor
and drill down to User Configuration Policies Administrative Templates Windows
Components Internet Explorer Toolbars and select the policy setting named Configure
Toolbar Buttons.) So, as you can see, Enabled really means “Turn this policy setting on.”
Either it will then do what it says or there will be more options inside the policy setting
that can be configured.

Disabled This setting leads a dual life:

Disabled usually means that if the same policy setting is enabled at a higher level,
reverse its operation. For example, we chose to enable the Prevent Changing
Screen Saver policy setting at the site level. If at a lower level (say, the domain or
OU level), we chose to disable this policy setting, the Screen Saver option will pop
back at the level at which we disabled this policy. You can think of Disabled (usu-
ally) as “reverse a policy setting coming from a higher level.”
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Disabled sometimes has a special and, typically, rare use. That is, something
might already be hard-coded into the Registry to be “turned on” or work one

way, and the only way to turn it off is to select Disabled. One such policy setting

is the Shutdown Event Tracker. You disable the policy setting, which turns it off,
because in servers, it's already hard-coded on. In workstations, it's already hard-
coded off. Likewise, if you want to kill the firewall for Windows XP (and later), you
need to set Windows Firewall: Protect All Network Connections to Disabled. (You
can find that policy setting at Computer Configuration > Policies > Administrative
Templates > Network > Network Connections > Windows Firewall > Domain
Profile (and also Standard Profile). Again, you set it to Disabled because the fire-
wall’s defaults are hard-coded to on, and by disabling the policy setting, you're
“reverting” the behavior back.

So, think of Not Configured as having neither Allow nor Deny set. Enabled will turn it on,
and it will possibly have more functions. Disabled has multiple uses, and be sure to first
read the help text for each policy setting. Most times it’s simply directly spelled out what
Enabled and Disabled does for that particular setting. Last, test, test, test to make sure
that once you’'ve manipulated a policy setting, it's doing precisely what you had in mind.

Final Thoughts

The concepts here are valid regardless of what your domain is running. It doesn’t matter
if you have a pure or mixed Active Directory domain with various and sundry Domain
Controller types. The point is that to make the best use of Group Policy, you’ll need an
Active Directory.

You’ll also need a Windows 10 or Windows Server 2016 management station to do your
Group Policy work. Again, we talk more about why you need a Windows 10 management
station in Chapters 3 and 6 and elsewhere.

Remember, the GPMC is built into Windows Server 2016, but it’s not installed unless
the machine is also a Domain Controller. The GPMC isn’t built into Windows 10 and is
only available through the downloadable RSAT tools.

Even though most of the examples of a target computer are Windows 10 in this book,
you can usually substitute a Windows 7 or 8 machine as your target and see similar (if not
often identical) results.

The more you use and implement GPOs in your environment, the better you’ll become
at their basic use while at the same time avoiding pitfalls when it comes to using them. The
following tips are scattered throughout the chapter but are repeated and emphasized here
for quick reference, to help you along your Group Policy journey:
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GPOs don’t “live” at the site, domain, or OU level. GPOs “live” in Active Directory and
are represented in the swimming pool of the domain called the Group Policy Objects con-
tainer. To use a GPO, you need to link a GPO to a level in Active Directory that you want
to affect: a site, a domain, or an OU.

GPOs apply locally and also to Active Directory sites, domains, and OUs. There is a local
GPO that can be used with or without Active Directory. Everyone on that computer must
embrace that local GPO. Then, Active Directory Group Policy Objects apply: site, domain,
and then OU. Active Directory GPOs “trump” any local policy settings if set within the
Local Group Policy. Active Directory is a hierarchy, and Group Policy takes advantage of
that hierarchy.

Avoid using the site level to implement GPOs. Users can roam from site to site by jumping
on different computers (or plugging their laptop into another site). When they do, they can
be confused by the settings changing around them. Use GPOs linked to the site only to set
up special sitewide security settings, such as IPsec or the Internet Explorer Proxy. Use the
domain or OU levels when creating GPOs whenever possible.

Implement common settings high in the hierarchy when possible. The higher up in the
hierarchy GPOs are implemented, the more users they affect. You want common settings
to be created and set one time. It’s not optimal to create many GPOs performing the same
functions at other lower levels, which will just clutter your view of Active Directory with
the multiple copies of the same policy setting.

Implement unique settings low in the hierarchy. If a specific collection of users is unique,
try to round them up into an OU and then apply Group Policy to them. This is much better
than applying the settings high in the hierarchy and using Group Policy filtering later.

Use more GPOs at any level to make things easier. When creating a new wish, isolate it
by creating a new GPO. This will enable easy revocation by unlinking it should something
go awry.

Strike a balance between having too many and too few GPOs. There is a middle ground
between having one policy setting within a single GPO and having a bajillion policy set-
tings contained within a single GPO. At the end of your design, the goal is to have mean-
ingfully named GPOs that reflect the “wishes” you want to accomplish. If you should
choose to end those wishes, you can easily disable or delete a specific GPO.

As you go on your Group Policy journey... Don’t go at it alone. There are some nice third-
party independent resources to help you on your way. I run www.GPanswers.com, which has
oodles of resources, downloads, a community forum, downloadable eChapters, video tuto-
rials, links to third-party software, and my in-person and online versions of my hands-on
training seminars. Think of it as your secret Group Policy resource.

My pal (and technical editor for this edition of the book) Alan Burchill runs www. group-
policy.biz and has a wonderful set of step-by-step articles and tips and tricks and such.


http://www.GPanswers.com
http://www.group-policy.biz
http://www.group-policy.biz
http://www.group-policy.biz
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My pal (and technical editor for a previous edition) Darren Mar-Elia runs “GPO
Guy,” which is part of his software company, SDM Software. Check it out at
http://sdmsoftware.com/gpoguy/.

My pal (and technical editor for a previous edition) Jakob Heidelberg has a lot of great
articles (mostly on Group Policy topics) at www.heidelbergit.dk/.


http://sdmsoftware.com/gpoguy/
http://www.heidelbergit.dk/

Managing Group Policy with
the GPMC and via PowerShell

In Chapter 1, “Group Policy Essentials,” you got to know how and when Group Policy
works. We used Active Directory Users and Computers to create and manage users and
computers, but we used the Group Policy Management Console (GPMC) to manage Group
Policy. We got a little workout with the GPMC when creating new GPOs and linking them
to various levels in Active Directory.

And, for just a moment, we went back to the old-school way to delegate control to Frank
and the HR-OU-Admins group to link existing GPOs to their Human Resources OU
structure.

In this chapter, ’ll cover the remainder of the daily tasks you can perform using the
GPMC. As a reminder, the GPMC is for all implementations of Active Directory. That
is, you can use the GPMC to manage your Active Directory—whatever the Domain
Controllers are that constitute it.

You just need the GPMC loaded up on some machine. Now, in the previous chapter, I
put a pretty fine point on it: you want this machine to be one of the latest machines pos-
sible, either a Windows 10 or a Windows Server 2016 machine. There are some older edi-
tions, but I don’t recommend you use them.

For this edition of the book, I’ve decided to also show the PowerShell equivalent of the
GPMC process. In other words, for almost all the things you can do in the GPMC, you
could, if you wanted, use PowerShell.

But first, let’s answer the question, Why would you want to do the items within the
GPMC using PowerShell? Said another way, if the clickety-clicks are straightforward and
easy, why would you want to make it harder on yourself and typety-type your way through
the same process?

The answer to that would be if you need to do anything that’s repeatable process. For
instance, in this chapter, you’re going to learn how to do things like this:

Create a Group Policy Object and give it a name.
Link a Group Policy Object to an OU.
Order Group Policy Objects at a level, say, the OU level.
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Yep, I'm definitely going to show you how to clickety-click your way to success here.
But I’'m also going to show you the typety-type way using PowerShell. So if you needed to
do the same thing over and over again, you could recycle the typety-types and make it a
repeatable script.

If you wanted to fully ignore all the PowerShell text, and focus just on the GPMC
clickety-clicks, you could do that.

Also, that being said, I’'m not going to be going deep into PowerShell, syntax rules, or
actually making scripts. There are zillions of PowerShell tutorials and books that talk about
how to do that. And, one of the appendices, entitled “Scripting Group Policy Operations
with Windows PowerShell,” has a mini-section right at the top entitled “Preparing for
Your PowerShell Experience.” There you’ll learn what I think are the three most important
pieces of getting started with PowerShell:

Getting PowerShell up and running
Downloading the latest help from Microsoft

Setting up to run actual scripts (which shouldn’t be needed for the one-liners in this
chapter)

So, here’s my recommendation for using this chapter:
1. Read this chapter, and do the clickety-clicks.

2. If you’re already reasonably PowerShell savvy, then just go for the PowerShell examples
in this chapter if you want to try them out.

3. If you’re warming up to PowerShell, jump to the appendix entitled “Scripting Group
Policy Operations with Windows PowerShell” and read the section “Preparing for
Your PowerShell Experience,” get set up, then come back to this chapter as a reference
for most of what can be done with Group Policy and PowerShell.

Again, you should have already created your management station with the GPMC in the
previous chapter. Remember, if you don’t use a Windows 10 machine (or Windows Server
2016) as your management station, you won’t have access to all the latest awesome powers
in the Group Policy arsenal. In this chapter, you’re going to be working again with your
WINTOMANAGEMENT machine where you’ve already loaded the updated GPMC.

With that in mind, let’s get to know the GPMC a bit better.

I'm going to assume you’ve already installed the GPMC on either your Win-

daTE dows 10 management station (WINTOMANAGEMENT) or your Windows
Server 2016 Domain Controller (DCO01). If you haven't tackled those instal-
lation steps, go back to Chapter 1 and find the section “Implementing the
GPMC on Your Management Station.”

Once you’re ready to get started, from the Start screen, type GPMC.MSC.
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Common Procedures with the
GPMC and PowerShell

In Chapter 1, we created and linked some GPOs, which we can see in the Group Policy
Objects container, to determine how, at each level, we were affecting our users. In the
following sections, we’ll continue by working with some advanced options for applying,
manipulating, and using Group Policy.

Since we didn’t use PowerShell at all in the last chapter to create and link GPOs, let’s
take 30 seconds to do the equivalent of what we did in the last chapter and do it right here,
right now, using PowerShell. In short, let’s create a new, blank Group Policy Object, call
it GPO123, then link it to the Human Resource Users OU (which is tucked within the
Human Resources OU, which itself is within the domain Corp.com).

Before we get started though, if you’re using an older version of Windows (and/or and
older version of PowerShell) you might need to specify the command to import the Group
Policy cmdlets before you get anything useful to happen. So if nothing appears to be work-
ing in PowerShell, start out with the command import-module grouppolicy (which can be
seen in Figure 2.1).

)/ If you are not running as the Built-In Administrator account, you will need
A&TE to launch a PowerShell command prompt with Administrator permissions
because you are doing something that requires elevated access and a Pow-
erShell. You can do this by right-clicking the shortcut and then clicking the
“Run as Administrator” option.

Now, here are the two PowerShell commands you could type to do the job.
Once you are running with Administrator permissions, you’re ready to continue on as
follows. For instance, to create a new Group Policy Object, it’s as simple as:

New-GPO -name GP0123
or

New-GPlink -name GP0123 -target “ou=Human Resources Users, ou=Human Resources,
dc=corp, dc=com”

Note how the domain name is proceeded by dc= and the OUs (parent and child) are pro-
ceeded by ou= in the PowerShell command.

The result can be seen in Figure 2.1.

Note that this didn’t do any real “work” inside the Group Policy Object; it just created
it and linked it to our existing OU. If we go back to using the GPMC, you should be able to
refresh the GPMC and then verify that the Group Policy Object is now linked to the right OU.

While still in the GPMC, clicking a GPO (or a link) lets you get more information about
what it does. For now, feel free to click around, but I suggest that you don’t change any-
thing until we get to the specific examples.
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FIGURE 2.1 You can create and link GPOs using PowerShell. Be sure to put items
with spaces in double quotes.

import-module grouppolicy
-name GP0123

new-GPLink -name GPD123 -target "OU=Human Resources Users,OlU=Human H

: bceffl13-d3al-4782-aed4-e5f1eld0b392
: GPO123
: True

se
Human Resources Users,OU=Human Resources,DC=corp,DC=com

Various tabs are available to you once you click the GPO or a link. For instance, let’s
locate the GPO that’s linked to the Human Resources Users OU. We’ll do this by drill-
ing down to Group Policy Management > Forest > Domains > Corp.com > Human
Resources > Human Resources Users and clicking the one GPO that’s linked there: “Hide
Mouse Pointers Option/Restore Screen Saver Option.” With that in mind, let’s examine the
various sections of a policy setting; you can flip through each of the tabs to get more infor-
mation about the GPO you just found.

The Scope Tab  Clicking a GPO or a GPO link opens the Scope tab. The Scope tab gives
you an at-a-glance view of where and when the GPO will apply. We’ll examine the Scope tab
in the sections “Deleting and Unlinking Group Policy Objects” and “Filtering the Scope of
Group Policy Objects with Security” later in this chapter and in the WMI section of Chapter
4. For now, you can see that the “Hide Mouse Pointers Option/Restore Screen Saver Option”
GPO is linked to the Human Resources Users OU. But you already knew that.

Using Microsoft’s own Group Policy PowerShell cmdlets to detail what Group Policy
Objects are linked where is possible, but actually a little tricky. So, we cover how to do that
in the PowerShell appendix, in the section “Documenting GPO Links.”

That being said, there is another quick way to do this, if you’re willing to download a third-

party (but free) PowerShell cmdlet set from my pal Darren Mar-Elia from SDM Software at:
http://sdmsoftware.com/group-policy-management-products/freeware-group-
policy-tools-utilities/.

You’re looking for the SDM GPMC PowerShell cmdlets.

Once the set is downloaded and installed, just re-open PowerShell, then import his cmdlets
and run Darren’s command Get-SDMgplink, which lists all GPOs at a level. You simply
specify the level. The two commands would be:

Import-Module SDM-GPMC

Get-SDMgplink -Scope "OU=Human Resources Users, OU=Human Resources, DC=corp,
DC=com"


http://sdmsoftware.com/group-policy-management-products/freeware-group-policy-tools-utilities/
http://sdmsoftware.com/group-policy-management-products/freeware-group-policy-tools-utilities/
http://sdmsoftware.com/group-policy-management-products/freeware-group-policy-tools-utilities/
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The result using the free SDM GPMC PowerShell cmdlet can be seen here. You can see that
the line starting with Name details the one Group Policy Object (in my case) that is linked to
that particular scope.

MC
pe "OU=Human Resources U s, OU=Human Resources, D{=corp, DC=com"”

; i
ore Screen ver Option

e 3 uman Resourc DC=c » DC=com
MLinkOrder :

The Details Tab The Details tab contains information describing who created the GPO
(the owner) and the status (Enabled, Disabled, or Partially Disabled) as well as some
nuts-and-bolts information about its underlying representation in Active Directory (the
GUID). We’ll examine the Details tab in the sections “Disabling ‘Half’ (or Both Halves)
of the Group Policy Object” and “Understanding GPMC’s Link Warning” later in this
chapter.

Should you change the GPO status here by, say, disabling the User Configuration of the
policy, you’ll be affecting all other levels in Active Directory that might be using this GPO
by linking to it. See the section “Understanding GPMC’s Link Warning” as well as the side-
bar “On GPO Links and GPOs Themselves” a bit later in the chapter.

You can see these details in the GPMC (top), and using PowerShell, you can use the Get-GP0O
cmdlet as seen in the screenshot on the (bottom).

Hide Mouse Pointers Option/Restore Screen Saver Option
Scope | Details | Settings | Delegation

Domain corp.com
Crwner: Domain Adming (CORP\Domain Admins)
Created: 11/16/2014 11:33:18 AM
Modified 1171672014 11:33:18 AM
User version: 0 {AD}, D{SYSVOL)
Computer version: 0 {AD}, D{SYSVOL)
Unigue 10: {AB9968E7-A3CB-4EB5-8641-2A0EEBBET259}
GPO Status: Enabled v
Comment

ministrator> Get-GPO "Hide Mouse Pointers Option/Restore Screen Saver Option”

DisplayName : Hide Mouse Pointers Option/Restore Screen Saver Option
DomainName

GpoStatus

Description

CreationTime

ModificationTime y

UserVersion : AD Version: 0 sVol Version: 0
ComputerVersion : AD Version: 0, 5 ‘ol Version: 0
WmiFilter 3
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The Settings Tab The Settings tab gives you an at-a-glance view of what’s been set inside
the GPO. In our example, you can see the Enabled and Disabled status of the two policy
settings we manipulated. You can click Hide (or Show) to contract and expand all the con-
figured policy settings.

Hide Mouse Pointers optiﬂnfREStDrE Screen Saver Optinn
| Scope I Dietails | Settings ‘ Dielegation |

Hide Mouse Pointers Option/Restore Screen Saver Option
Data collected on: 13/06/2012 7.58:33 PM show all
Computer Configuration (Enabled) hide:
Mo settings defined
User Configuration (Enabled) hide
Administrative Templates hide
Policy definitions {ADMX files) retrieved from the local computer
Control Panel/Personalization hide
Policy Setting Comment
Prevent changing mouse Enzbled
pointers
Prevent changing screen Disabled
saver

Clicking Hide at any level tightens that level. You can expose more information by
clicking Show.

Clicking the policy setting name—for example, Prevent Changing Mouse Point-
ers—displays the help text for the policy setting (but note that this is only appli-
cable to Administrative Template settings). This trick can be useful if someone
set up a GPO with a kooky name and you want to know what’s going on inside
that GPO.

If you want to change a setting, right-click the settings area and select Edit. The
familiar Group Policy Management Editor will appear. Note, however, that the
Group Policy Management Editor will not “snap to” the policy setting you want to
edit. The editor always starts off at the root.

Additionally, at any time you can right-click over this report and select Save
Report, which does just that. It creates an HTML or XML report that you can
then e-mail to fellow administrators or the boss, and so on. This is a super way of
documenting your Group Policy environment instead of writing down everything

by hand.

You can use PowerShell to save a report of a specific Group Policy Object or all GPOs using
the cmdlet Get-GPOReport. For instance, you could type:

Get-GPOReport -Name GP0123 -ReportType HTML -Path C:\temp\outl.html
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You could also do something like:

Get-GPOReport -ALL -ReportType HTML -Path C:\temp\ALL.html

PS C:\Users\administrator> import-module grouppolicy
PS C:\Users\administrator> Get-GPOReport -Name GP0123 -ReportType HTML -Path c:\temp\outl.html

P5 C:\Users\administrator> Get-GPOReport -ALL -ReportType HTML -Path c:\temp\ALL.html
PS5 C:\Users\administrator> _

Both examples assume C:\temp\ is present. Note the second command is a little weird and
dumps all the reports of all the GPOs into one big HTML file.

If you'd like to see the “trick” for having a single report for each Group Policy Object,
check out the section “Creating GPO Reports” in the PowerShell appendix.

Now, I’ve said it before, but it bears repeating: You can also edit the settings by click-
ing the GPO or any GPO link for that object and choosing Edit. However, you always
affect all containers (sites, domains, or OUs) to which the GPO is linked. It’s one and the
same object, regardless of the way you edit it. See the sidebar “On GPO Links and GPOs
Themselves” a bit later in the chapter to get the gist of this.

Out, Out Annoying Internet Explorer Pop-ups!

If you chose to run the GPMC on a Windows Server, you may run into security pop-ups
when clicking the Settings tab. Certain aspects of the GPMC, such as the Settings tab,
utilize Internet Explorer to display their contents.

Since Internet Explorer is “hardened” on Windows Server machines, you will have lim-
ited access to the whole picture. When showing the Settings within the GPMC, you'll be
presented with a warning box:

Default Domain Policy
|S:npe | Deetails | Settings | Delegation |

Internet Explorer .
Content within this application coming from the
° website listed below is being blocked by Intemet

Explorer Enhanced Security Configuration

about:securty_mmc exe

Leam more about Intemet Explorer's Enhanced Security Configuration..

If you trust this website, you can lower security settings for
the site by adding it to the Trusted sites zone. If you know
this website is on your local intranet, review help for

instructions on adding the site to the local intranet zone
instead.

Important: adding this website to the Trusted sites zone will lower the security
settings for all content from this web site for all applications, including Intemet

Explorer.
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You can bypass this by simply adding security_mmc.exe as a trusted website. This
should make your problems go away.

Optionally, you can also turn off Internet Explorer Enhanced Security Configuration. In
Windows Server 2012 and later, you use Server Manager. Then select Local Server on the
left side and select IE Enhanced Security Configuration on the right side. Finally, choose
Off in the pop-up window that appears:

{ra
5

\\ :) | rA Manage Tools View H

Customer Experience Improvement Program  Net participating

E Enhanced Security Configuration On
Time zone (UTC+10:00) Brisbane
Product ID - - .
7, Internet Explorer Enhanced Security Configuration
Internet Explorer Enhanced Security Configuration (IE ESC) reduces the
exposure of your server to potential attacks from Web-based content.
T Internet Explorer Enhanced Security Configuration is enabled by
HIEE=ETE default for Administrators and Users groups.
nstalled mg
Total disk s; Administrators:
@' O On (Recommended)
W @off
ks~ |
Users:
@' ®) On (Recommended) )
Log @ Oof
Systs hal
Systd More about Internet Explorer Enhanced Security Configuration
Systy
—_——
SysterT 15700720 TZ BUGUT FIvT

This is where you'll be able to enable or disable the annoying, | mean, informative pop-ups.
This approach is recommended in test labs but not recommended on production servers.

The Delegation Tab The Delegation tab lets you specify who can do what with GPOs,
their links, and their properties. You’ll find the Delegation tab in a lot of places, such as
when you do the following:

= Click a GPO link or click a GPO in the Group Policy Objects container
= Click a site

= Click a domain

= Click an OU
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Click the WMI Filters node

Click a WMI (Windows Management Instrumentation) filter itself (covered in
Chapter 4)

Click on the Starter GPOs section

The PowerShell cmdlet to get the state of delegation (which could also be thought of as
permissions) is Get-GPPermission, and the cmdlet to set or change the state of delegation
would be Set-GPPermission.

We’ll not jump into these PowerShell cmdlets here. We’ll use these cmdlets a little later in
the section “Filtering the Scope of Group Policy Objects with Security.”

At each of these locations, the tab allows you to do something different. I’ll discuss what
each instance of this tab does a bit later in the section “Security Filtering and Delegation
with the GPMC.”

Raising or Lowering the Precedence of Multiple Group
Policy Objects

You already know that the “flow” of Group Policy is inherited from the site level, the
domain level, and then from each nested OU level. But, additionally, within each level, say
at the Temporary Office Help OU, multiple GPOs are processed in a ranking precedence
order. Lower-ranking GPOs are processed first, and then the higher GPOs are processed.

In Figure 2.2, you can see that an administrator has linked two GPOs to the Temporary
Office Help OU. One GPO is named “Enforce 50 MB Disk Quota” and another is named
“Enforce 40 MB Disk Quota.”

If the policy settings inside these GPOs both adjust the disk quota settings, which one
will “win”? Client computers will process these two GPOs from lowest-link order to high-
est-link order. Therefore, the “Enforce 40 MB Disk Quota” GPO (with link order 2) is pro-
cessed before “Enforce 50 MB Disk Quota” (link order 1). Hence, the GPO with the policy
settings to dictate 50 MB disk quotas will win.

So, if two (or more) GPOs within the same level contain values for the same policy set-
ting (or policy settings), the GPOs will be processed from lowest-link order to highest-link
order. Each consecutively processed GPO is then written. If there are any conflicts, the
highest link order “wins.” This could happen where one GPO has a specific policy setting
enabled and another GPO at the same level has the same policy setting disabled.

Just to clear up a confusing little point: it turns out the highest-link order is not the highest
numbered GPO listed at a level. Oh no—that would be too easy. Indeed, the highest-link order
is shown as the lowest displayed number. Great. Just another fun fact to keep you on your toes.

Changing the order of the processing of multiple GPOs at a specific level is an easy task
with the GPMC. For instance, suppose you want to change the order of the processing so
that the “Enforce 40 MB Disk Quota” GPO is processed after the “Enforce 50 MB Disk
Quota” GPO. Simply click the policy setting you want to process last and click the down
arrow icon. Similarly, if you have additional GPOs that you want to process first, click the
GPO and click the up arrow icon. The multiple arrow icons will put the highlighted GPO
either first or last in the link order—depending on the icon you click.
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FIGURE 2.2 You can link multiple GPOs at the same level.

= Group Policy Management I;li-

¥

% File Action View Window Help
== 2]
|5, Group Policy Management Temporary Office Help
4 ﬁ F?rest: wrp‘wm Linked Group Policy Objects ‘Gmup Policy Inheritance I Delegation |
4 (55 Domains
4 F corp.com Link Drder Gj'O Enforced Link Enabled GPO Stat|
s Default Domain Policy 1| Enforce 50 MB Disk Quota No Yes Enabled
2 a| Erforce 40 MB Disk Quota No Yes Enabled

s/ Prohibit Changing Scunds
- 2 Domain Controllers
-

I ‘2| Human Resources
4 @ Temporary Office Help -
5/ Enforce 40 MB Disk Quota | Move link down

5 Enforce 50 MB Disk Quota
I+ [ 5 Group Policy Objects
I [ WMI Filters
[ ﬂ Starter GPOs
I L@ Sites
s Group Policy Medeling
+ Group Policy Results

Using PowerShell, the cmdlet would be as follows to set a specific Group Policy Object
(“Enforce 40 MB Disk Quota”) to link order 2:

Set-GPlink -Name “Enforce 40MB Disk Quotas” -Target “ou=Temporary Office Help,
dc=corp, dc=com” -Order 2

" -Target "OU=Tempor

Enabled

Enforced

Target emporary Office Help,DC=corp,DC=com
Order

Again—the “most last” applied GPO wins. So the GPO with a link order of 1 is
always applied last and, hence, has the final say at that level. This is always true unless the
Enforced function is used (as discussed later).

Understanding GPMC'’s Link Warning

In the previous chapter, I pointed out that anytime you click a GPO link, you get the infor-
mational (or perhaps it’s more of a warning) message shown in Figure 2.3.
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FIGURE 2.3 You getthis message anytime you click the icon for a link.

Group Policy Management Console

*You have selected a link to a Group Policy Object (GPO). Becept for
changes to link properties, changes you make here are global to the GPO,
and will impact all other locations where this GPO is linked.

[/ net show this message again

This message is trying to convey an important sentiment: No man is an island, and
neither is a Group Policy Object. Just because you created a GPO and it is seen swimming
in the Group Policy Objects container doesn’t mean you’re the only one who is possibly
using it.

As we work through examples in this chapter, we’ll manipulate various characteristics
of GPOs and links to GPOs. If we manipulate any characteristics of a GPO we’re about to
play with, such as the following, then all other levels in Active Directory that also link to
this GPO will be affected by our changes:

The underlying policy settings themselves
The security filtering (on the Scope tab)
The WMI filtering (on the Scope tab)
The GPO status (on the Details tab)

The delegation (on the Delegation tab)

For instance, imagine you had a GPO linked to an OU called Doctors and the same
GPO linked to an OU called Nurses. If you edit the GPO in the swimming pool, or click
the link to the GPO in either Doctors or Nurses and click Edit, you’re doing the same
thing. Any changes made within the GPO affect both the Doctors OU and the Nurses OU.

This is sometimes a tough concept to remember, so it’s good to see it here again. You can
choose to squelch the tip if you like. Just don’t forget its advice.

The difference between the GPO itself and the links you can create can
P be confusing. Be sure to check out the sidebar “On GPO Links and GPOs
Themselves” a bit later in the chapter.

Another way to see this principle in action is by locating the “Auto-Launch calc.exe”
GPO in either the link in the Human Resources Computers OU or the object itself within
the Group Policy Objects container. Next, go to the Details tab and change the GPO status
to some other setting. Then, go to the link or the actual GPO and see that your changes
are reflected. You can even create a new OU, link the GPO, and stll see that the change
is there. This is because you’re manipulating the actual GPO, not the link. If you choose
to squelch the message, you can get it back by choosing View > Options > General and
selecting “Show confirmation dialog to distinguish between GPOs and GPO links.”
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Stopping Group Policy Objects from Applying

After you create your hierarchy of Group Policy that applies to your users and computers,
you might occasionally want to temporarily halt the processing of a GPO—usually because
a user is complaining that something is wrong. You can prevent a specific GPO from process-
ing at a level in Active Directory via several methods, as explained in the following sections.

Preventing Local GPOs from Applying

Before we get too far down the path with Active Directory—based GPOs, let’s not forget
that you might also want to stop a local GPO from applying. I mentioned this tidbit in the
previous chapter, but I’ll mention it here again for emphasis.

Here’s the scenario: you might have walked up to 50 Sales computers and created a local
GPO that prevents access to the Control Panel. However, now you want to reverse that
edict. Instead of walking around to those 50 computers, you can just zap a Group Policy
Object to those computers containing a setting to inhibit the processing of local GPOs.
Here’s the trick, though: this technique only works for Windows Vista or later machines—
not for earlier versions of the operating system.

To do this trick, you’ll use the policy setting found at Computer Configuration >
Administrative Templates > System > Group Policy, and it’s called Turn off Local Group
Policy objects processing. Just remember to ensure that your computers are in the OU
where this GPO is targeted to take effect.

Disabling the Link Enabled Status

Remember that all GPOs are contained in the Group Policy Objects container. To use
them at a level in Active Directory (site, domain, or OU), you link back to the GPO. So,
the quickest way to prevent a GPO’s contents from applying is to remove its Link Enabled
status. If you right-click a GPO link at a level, you can immediately see its Link Enabled
status, as shown in Figure 2.4.

To prevent this GPO from applying to the Human Resources Users OU, click Link
Enabled to remove the check mark. This will leave the link but disable it, rendering it
innocuous.

To use PowerShell to disable the status of a link, you would use the cmdlet Set-GPLink.
You would specify the OUs, preceded by 0U=, and the name of the domain (pieces, anyway)
with DC=, as seen in this snippet:

Set-GPLink -Name “Hide Mouse Pointers Option/Restore Screen Saver Option”
-Target "ou=Human Resources Users, ou=Human Resources, dc=corp, dc=com"
-LinkEnabled No

PS C:\Windows\system32> Set-GPLink -Name “Hide Mouse Pointers Option/Restore Screen Saver Optio
n*” -Target "ou=Human Resources Users, ou=Human Resources, dc=corp, dc=com” -LinkEnabled No

GpoId : 898 c91-33d2-447d-9929-aa998ec5018c

DisplayName : Hide Mouse Pointers Option/Restore Screen Saver Option

Enabled : False

Enforced : False

Target : OU=Human Resources Users,0U-Human Resources,DC=corp,DC=com
Order i
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FIGURE 2.4 Youcanchooseto enable or disable a GPO link.

You can flip it back to enabled by substituting Yes for No next to the —LinkEnabled

parameter.

Back in the GPMC (after a refresh), the icon to the left of the name of the GPO will

e
5 File Action View Window Help
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change to a scroll with the link arrow dimmed. You’ll see a zoomed-in picture of this later
in the section “GPMC At-a-Glance Icon View.”

Disabling “Half” (or Both Halves) of the Group Policy Object

The second way to disable a specific GPO is by disabling just one-half of a Group Policy
Object. You can disable either the User half or the Computer half. Or you can disable the
entire GPO.

You might be wondering why you would want to disable only half of a GPO. On the one
hand, disabling a GPO (or half of a GPO) makes startup and logon times a teeny-weeny bit
faster for the computer or user, because each GPO you add to the system adds a smidgen of
extra processing—either for the user or the computer. Once you disable the unused portion

of the GPO, you’ve shaved that processing time off the startup or logon time. Microsoft

calls this “modifying Group Policy for performance.”

Don’t go bananas disabling your unused half of a GPO just to save a few cycles of pro-
cessing time. Trust me, it’s just not worth the headaches figuring out later where you did

and did not disable a half of a policy.
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Why Totally Disable a Group Policy Object?

One good reason to disable a specific GPO is if you want to manually “join” several GPOs
together into one larger GPO. Then, once you're comfortable with the reaction, you can
re-create the policy settings from multiple GPOs into another new GPO and disable the
old individual GPOs. If there are signs of trouble with the new policy, you can always just
disable (or delete) the large GPO and re-enable the individual GPOs to get right back to
where you started.

You might also want to immediately disable a new GPO even before you start to edit

it. Imagine that you’ve chosen “Create and link a new GPO here” for, say, an OU. Then,
imagine you have lots of policy settings you want to place inside this new GPO. Remem-
ber that each setting is immediately written inside the Group Policy Management Editor.
GPOs are replicated across all DCs (on their own schedule; not when you desire them to),
and computers are continually requesting changes when their Background Refresh inter-
val triggers.

The affected users or computers might hit their Background Refresh cycle and start
accepting the changes before you've finished writing all your changes to the GPO! There-
fore, if you disable the GPO before you edit and re-enable the GPO after you edit, you can
ensure that your users are getting all the newly changed settings at once.

This tip works best only when creating new GPOs; if you disable the GPO after creation,
there’s an equally likely chance that critical settings will be removed while the GPO is dis-
abled when clients request a Background Refresh. We'll discuss the ins and outs of Back-
ground Refresh in Chapter 3.

Disabling half of the GPO makes troubleshooting and usage quite a bit harder, as you
might just plumb forget you’ve disabled half the GPO. Then, down the road, when you
modify the disabled half of the policy for some future setting, it won’t take effect on your
clients! You’ll end up pulling your hair out wondering why once things should change, they
just don’t!

To disable an unused half of a GPO, follow these steps:

1. Select the GPO you want to modify. In this case, select “Auto-Launch calc.exe” and
select the Details tab in the right pane of the GPMC.

2. Since the policy settings within the “Auto-Launch calc.exe” GPO modify only the
Computer node, it is safe to disable the User node. Again, I'm not a big fan, but if you
want to practice it anyway, select the GPO Status: dropdown, then select “User con-
figuration settings disabled,” as shown in Figure 2.5.
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FIGURE 2.5 You canchange the default from Enabled (shown here) to “User

configuration settings disabled” to disable half the GPO to make Group Policy process a
wee bit faster.
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3. You will be prompted to confirm the status change. Choose to do so.

In PowerShell, you can also dictate the status of the Group Policy Object. But it takes
more than one line in PowerShell. In short, you hold the contents of the Group Policy
Object in a variable of your choosing. Then, you set the GpoStatus bit as you see fit. You
can then verify that the change took as expected by showing that bit. So that’s three lines
as follows:

$gpo = Get-GPO “Auto-Launch calc.exe”

$gpo.GpoStatus = “UserSettingsDisabled”

$gpo.GpoStatus

Administrator> $gpo = Get-GPD "Auto-Launch calc.exe”

Administrator> $gpo.GpoStatus="UserSettingsDisabled”

Administrator> $gpo.GpoStatus
sabled

P5 C:\Users‘\Administrator>

81
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Valid values for GpoStatus are Al1SettingsEnabled, AllSettingsDisabled,
UserSettingsDisabled, and ComputerSettingsDisabled. These correspond to the four
items seen within the dropdown in Figure 2.5.

Here are some additional items to remember regarding disabling portions of a GPO:

It is possible to disable the entire GPO (both halves) by selecting the GPO, clicking the
Options button, and selecting the All Settings Disabled option. If you select All Set-
tings Disabled, the scroll icon next to the name of the GPO “dims” to show that there
is no way it can affect any targets. You’ll see a zoomed-in picture of this later in the
section “GPMC At-a-Glance Icon View.”

As I stated earlier in the section “Understanding GPMC’s Link Warning,” changing
the GPO Status entry (found on the Details tab) will affect the GPO—everywhere it is
linked—at any level, anywhere in the domain. You cannot just change the GPO status
for the instance of this link—this setting affects all links to this GPO! The good news
here is that only the person who created the GPO itself (or anyone who has permissions
to it) can manipulate this setting. To get the full thrust of this, be sure to read the side-
bar “On GPO Links and GPOs Themselves” later in this chapter.

In day-to-day use of this feature, the GPMC doesn’t do a great job indicating (other
than this “GPO status” area) that the link has been fully or half disabled. It’s true that
if you click the Group Policy Objects Container node (the swimming pool) and look at
the GPOs in a list, you will see a column for GPO status. But I don’t do that particular
action much. Interestingly, in the old-school “Active Directory Users and Comput-
ers” interface in Windows 2003’s old-and-crusty Ul, you would at least see a yellow
triangle warning icon next to the name of the GPO. But not in the GPMC. Weird (and
potentially unsafe).

Deleting and Unlinking Group Policy Objects

As you just saw, you can prevent a GPO from processing at a level by merely removing
its Link Enabled status. However, you can also choose to remove the link entirely. For
instance, you might want to return the normal behavior of any affected computers so
that calc.exe isn’t launched whenever someone uses an affected machine. You have two
options:

Delete the link to the GPO

Delete the GPO itself

Deleting the Link to the Group Policy Object

When you right-click the GPO link of “Auto-Launch calc.exe” in the Human Resources
Computers OU, you can choose Delete. When you do, the GPMC will confirm your request
and remind you of an important fact, as shown in Figure 2.6.
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FIGURE 2.6 You can delete a link (as opposed to deleting the GPO itself).

Group Policy Management -

Do you want to delete this link?
This will not delete the GPO itself,

| oK | | Cancel |

Using PowerShell, you would use the Remove-GPlink cmdlet:

Remove-GPLink -Name "Auto-Launch calc.exe" -Target "ou=Human Resources
Computers, ou=Human Resources, dc=corp,dc=com"

PS5 C:\Users\Administrator> Remove-GPLink -Name “"Auto-Launch calc.exe" -Target "ou=Human Resourd
es Computers, ou=Human Resources, dc=corp,dc=com”

DisplayName : Auto-Launch calc.exe

DomainName : corp.com

Owner = P\Domain Admins

Id Bd2c9ff4-9070-48c5-a83c-0b38539400d2

GpoStatus : UserSettingsDisabled

Description :

CreationTime : 2/9/201

ModificationTime : 2/9/2015 90 PM

UserVersion : AD Version: SysVol Version: @
ComputerVersion : AD Version: @, SysVol Version: @
WmiFilter -

Recall that the GPO itself doesn’t “live” at a level in Active Directory; it lives in a
special container in Active Directory (and can be seen via the Group Policy Objects con-
tainer in the GPMC). We’re just working with a link to the real GPO. And, in Chapter 4,
“Advanced Group Policy Processing,” you’ll see where this folder relates directly within
Active Directory itself.

When you choose to delete a GPO link, you are choosing to stop using it at the level
at which it was created but keeping the GPO alive in the representation of the swimming
pool—the Group Policy Objects container. This lets other administrators at other levels
continue to link to that GPO if they want.

Truly Deleting the Group Policy Object Itself

You can choose to delete the GPO altogether—lock, stock, and barrel. The only way to
delete the GPO itself is to drill down through Group Policy Management > Domains >
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Corp.com, locate the Group Policy Objects container, and delete the GPO. It’s like plucking

a child directly from the swimming pool. Before you do, you’ll get a warning message, as
shown in Figure 2.7.

To have the PowerShell cmdlet do the same thing would be Remove-GPO -name
“Auto-Launch calc.exe.” The “not exactly incredibly interesting” result returned from
PowerShell can be seen in Figure 2.8.
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FIGURE 2.7 Here, you're deleting the GPO itself.

Group Policy Management

I- Do you want te delete this GPO and all links to it in
S5 this domain? This will not delete links in other
dormains,

Administrator> Remove-GPO -name "Auto-Launch calc.exe”

This action will remove the bits on the Domain Controller and obliterate it from the sys-

tem. No other administrators can then link to this GPO.
Once it’s gone, it’s gone (unless you have a backup).

If you delete the GPO altogether, there’s only one problem. There is no indication sent
to the folks who are linking to this GPO that you’ve just deleted it. You might be done with
the “Auto-Launch calc.exe” GPO and might not need it anymore to link to your locations
in Active Directory, but what about other administrators? In this case, while I was out to
lunch, Freddie, the administrator for the Temporary Office Help OU, has already chosen to

link the “Auto-Launch calc.exe” GPO to his OU, as shown in Figure 2.9.

FIGURE 2.9 The “Auto-Launch calc.exe” GPO (lowest circle) is linked at both the

Temporary Office Help OU (middle circle) and this Human Resources Computers OU

(topmost circle).
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What if I had deleted the “Auto-Launch calc.exe” GPO? I'm pretty sure I would have
received an angry phone call from Freddie. Or, maybe not—if Freddie didn’t know who
created (and owned) the GPO.

Since we only have a handful of OUs, this link back to the GPO was easy to find.
However, once you start getting lots of OUs, locating additional links back to a GPO will
become much harder. Thankfully, the GPMC shows you if anyone else is linked to a GPO
you’re about to delete. I call this ability “look before you leap.” You can just look on the
Scope tab under the Links heading, as indicated in Figure 2.9. There you can see that both
the Temporary Office Help OU and the Human Resources Computers OU are utilizing the
GPO “Auto-Launch calc.exe.”

If you’re confident that you can still continue, you can delete the GPO contained within
the Group Policy Objects container. However, for now, let’s leave this GPO in place for use
in future examples in the book.

The Scope tab shows you the links to the GPOs from your own domain. It is possible
for other domains to leverage your GPOs and link to them. This is generally considered a
“no-no” and is called cross-domain linking. When you delete a GPO forever (and wipe it
out of your swimming pool), you’re deleting the ability for other domains to utilize that
GPO as well. Note that there is a dropdown in the Scope tab labeled “Display links in this
location.” If you want, you can show Entire Forest. That way, if a GPO is being leveraged
by doing a cross-domain link, you can at least see if this GPO is linked to other areas you
might not have intended it to be.

For now, don’t delete the GPO. We’ll use it again in later chapters. If you want to play
with deleting a GPO, create a new one and delete it.

Block Inheritance

As you’ve already seen, the normal course of Group Policy inheritance applies all policy
settings within GPOs in a cumulative fashion from the site to the domain and then to each
nested OU. A setting at any level automatically affects all levels beneath it. But perhaps this
is not always the behavior you want. For instance, we know that an edict from the Domain
Administrator states there will be no Sounds option in the Windows 10 Personalization page.

This edict is fine for most of the OU administrators and their subjects who are affected.
But Frank Rizzo, the administrator for the Human Resources OU structure, believes
that the folks contained within his little fiefdom can handle the responsibility and gravi-
tas of being able to change their own sounds. Remember, a policy at the domain level
has performed this action. He also feels that they are grown-up enough to manage their
own Screen Saver options (a policy at the site level that has performed this action). Now,
he wants to bring them back to his users. (But he’s not ready to give back the ability to
play around with the mouse pointer settings—a policy that is set at his level, the Human
Resources OU level.)

In this case, Frank can prevent GPOs (and the policy settings within them) defined at
higher levels (domain and site) from affecting his users, as shown in Figure 2.10. If Frank
chooses to select Block Inheritance, Frank is choosing to block the flow of all GPOs (with
all their policy settings) from all higher levels.
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FIGURE 2.10 Use the BlockInheritance feature to prevent all GPOs (and the policy
settings within them) from all higher levels from affecting your users and computers.

?

E Group Policy Management
5L File  Action View Window Help
o B XE G H

3, Group Policy Management Human Resources

a F‘f"em corp.com Linked Group Policy Objects | Group Policy Inheritance
4 (% Domains

4 3 corp.com
s/ Default Domain Policy
s Prohibit Changing Sounds

0

Lirk Brder GFO

I 2] Domain Controllers

I | g9 Human Resources

| (=] Temporary Office Create a GPO in this domain, and Link it here...
3

3

5t Group Policy Objy Link an Existing GPO...
& WMI Filters

[ v] BlockInheritance

b L Starter GPOs
b O Sites Group Pelicy Update.‘.L\%
s Group Policy Modeling Group Pelicy Modeling Wizard...

[ Group Policy Results Mew Organizational Unit

View 3
New Window from Here

Delete

Rename

Refresh

Properties

Help —]

Toggle block inheritance

Block Inheritance upon a level (site, domain, or OU) can also be performed using
PowerShell. The cmdlet to perform the same Block Inheritance of Human Resources OU
would be:

Set-GPinheritance -Target "ou=Human Resources,dc=corp,dc=com" -IsBlocked Yes
You can see the result in Figure 2.11. Note that the field GpoInheritenceBlocked is now

set to Yes.

FIGURE 2.11 PowerShell can be used to Block Inheritance of GPOs at a specific
scope level.

PS C:\Users\Administrator> Set-GPinheritance -Target "ou=Human Resources,dc=corp,dc=com” -Is
cked Yes

LELE : human resources

ContainerType

Path 3 =human resources,dc=corp,dc=com
GpolnheritanceBlocked Yes

GpolLinks {}

InheritedGpolinks : {Prohibit Changing Sounds}
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When Frank performs the Block Inheritance, the Human Resources OU icon (when
refreshed within the GPMC) changes to include a blue exclamation point (!), as seen
in Figure 2.10. Once the Block Inheritance upon the OU is performed and the GPOs
are reprocessed on the client, only those settings that Frank dictates within his Human
Resources OU structure will be applied.

If you want to see the effect of Block Inheritance, ensure that the check is seen, as shown
in Figure 2.10. Then, log on as any user affected by the Human Resources OU—say, Frank
Rizzo. You’ll notice that the Screen Saver options have returned (if you go to Personalize >
Lock Screen > Screen saver settings), as did the ability to manipulate sounds (Personalize >
Themes > Go to advanced sound settings.) But you’ll also notice that the Mouse Pointers
option in the Windows 10 Personalization page (Themes > Go to mouse pointer settings)
is prohibited because that edict is contained within a GPO that’s explicitly defined at the
Human Resources Users OU level, which contains Frank’s user account.

The Enforced Function

Frank Rizzo and his Human Resources folks are happy that the Screen Saver and Sounds
options have made a triumphant return.

There’s only one problem: the Domain Administrator has found out about this trans-
gression and wants to ensure that the Sounds option in Windows 10 is permanently
revoked.

The normal flow of inheritance is site, domain, and then OU. Super. If you’ve set a Block
Inheritance on an OU (say, the Human Resources OU), then all settings to that OU are null
and void.

But shouldn’t there be some power to allow “bigger” administrators to get their wills
enforced? Enforced! Heck, what a great term. I should trademark that. To trump a lower
level’s Block Inheritance, a higher-level administrator will use the Enforced function.

Enforced was previously known as No Override in old-school parlance.
A ITE

The idea behind the Enforced function is simple: It guarantees that policy settings
within a specific GPO from a higher level are always inherited by lower levels. It doesn’t
matter if the lower administrator has blocked inheritance or has a GPO that tries to disable
or modify the same policy setting or settings.

In this example, you’ll log on as the Domain Administrator and set an edict to force the
removal of the Sounds option in the Windows 10 Personalization page (Themes > Go to
advanced sound settings).

To use Enforced to force the settings within a specific Group Policy Object setting,
right-click the “Prohibit Changing Sounds” GPO link and select Enforced, as shown in
Figure 2.12.
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FIGURE 2.12 Use the Enforced option to guarantee that settings contained within a
specific GPO affect all users downward via inheritance.
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The same procedure to perform an Enforce of the Group Policy’s link can be done using
the Set-GPlink command:

Set-GPlink -Name "Prohibit Changing Sounds" -Target "dc=corp, dc=com" -Enforced
Yes

PS C:\Users\Administrator> Set-GPlink -Name “Prohibit Changing Sounds® -Target “dc=corp, dc=cos
* —Enforced Yes

Gpold : d5d238be-4460-43b8-a%8e-719dabe@34c3

DisplayName : Prohibit Changing Sounds
Enabled : True

Enforced : True
Target : DC=corp,DC=com
Order 2

When you refresh the GPMC, notice that the GPO link now has a little “lock” icon,
demonstrating that it cannot be trumped. You can see this in the “Prohibit Changing
Sounds” GPO link icon in Figure 2.10. You’ll see a zoomed-in picture of this later in the
section “GPMC At-a-Glance Icon View.”

To test your Enforced edict, log on as a user affected by the Human Resources OU—
Frank Rizzo. In the Display Properties dialog box, the Sounds option in the Windows 10
Personalization page (Themes > Go to advanced sound settings) should be prevented

because it is being Enforced at the domain level even though Block Inheritance is used at
the OU level.
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On GPO Links and GPOs Themselves

The GPMC is a cool tool, but it shows you a bit too much. Sometimes, it can be confusing
as to what can be performed on the GPO’s link and what can be performed on the GPO
itself. Remember that GPOs themselves are displayed in the GPMC via the Group Policy
Objects container. The links back to them are shown at the site, domain, and OU levels.
So here’s a list of what you can “do” to a GPO link and what you can “do” to a GPO itself.

You can only do three things on a GPO link that applies to a site, a domain, or an OU:

Link Enable (that is, enable or disable the settings to apply at this level).
Enforce the link (and force the policy settings).

Delete the link.

Everything else is always done on the actual GPO itself:

Change the policy settings inside the GPO (found on the Settings tab).

Apply security filters, rights (such as the “Apply Group Policy” privilege), and delega-
tion (such as the “Edit this GPO” privilege), discussed in the section “Security Filter-
ing and Delegation with the GPMC" later in this chapter.

Enable/disable the Computer and/or User half of the GPO via the GPO status (found
on the Details tab).

Place a WMI filter on the GPO (discussed in Chapter 4).

If this seems clear as mud, consider this scenario:

Fred and Ginger are the two Domain Administrators. By definition, they can
create GPOs.

Imagine that Fred designs the “Our Important Stuff” GPO (a poorly named GPO),
which contains policy settings that affect both users and computers. Perhaps one
user policy setting is Remove Run off Start Menu. Perhaps one computer policy set-
ting is Enforce disk quota limit. And Fred sets the quota limit to 50MB.

Fred links the Sounds GPO to the Dancers OU as well as the Audition Halls OU.

Ginger gets a phone call from the folks in the Audition Halls OU. The users in the
Audition Halls OU report that the 50MB disk quotas are too restrictive. “Can they just
turn off the Computer-side settings for us Audition Halls folks?” one of them cries.
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Ginger goes to the “Sounds” GPO link (which is linked to the Audition Halls OU),
clicks the Details tab, and disables the computer settings using the GPO Status drop-
down box.

Fred then gets a phone call that the Dancers OU no longer has disk quotas being
applied.

Why did this happen?

Because the Group Policy engine has certain controls on the GPO itsel/fand has other
controls on the Group Policy link. Because Fred and Ginger are both Domain Administra-
tors, they jointly have ownership of the ability to change the GPO and the GPO link.

Whenever Ginger modifies any characteristic in the previous bulleted list, she’s changing
it “globally” for any place in Active Directory that might be using it. That’s what the warn-
ing in Figure 2.3, earlier in this chapter, is all about.

If you'll allow me to get on my soap box for the next 10 seconds, the level of finite control
over what Ginger can and cannot do to the GPO itself is fairly limited.

In any event, delegating what we can control over the GPO itself is precisely what the
next sections are about, specifically the section “User Permissions on Group Policy
Objects.”

Security Filtering and Delegation
with the GPMC

You wouldn’t want everyone in your domain to get every GPO applied to them. That would
be crazy.

Likewise, you wouldn’t want everyone in your domain to be able to modify every GPO.
That would be “mega-crazy.”

So the following sections will deal with both aspects of making sure users only get
access (and application) to what they’re supposed to. We’ll talk about filtering a user (or
computer) from getting specific GPOs. Then we’ll move on to talking about ensuring that
only the right users and admins have access to the underlying Group Policy system—by
properly delegating who should have the ability to do what.

Turns out, to craft the solution to both of these problems, you leverage security pieces
upon certain Active Directory aspects and also on specific GPOs.

It’s not hard, but let’s tackle these questions one at a time to locate all the places users
and admins touch our Group Policy infrastructure, look at their access, and see where that
access can be managed.



Security Filtering and Delegation with the GPMC 91

Filtering the Scope of Group Policy Objects
with Security

The normal day-to-day Human Resources workers in the Human Resources OU structure
are fine with the facts of life:

The Enterprise Administrator says “Good bye to screensavers” (that is, that no one at
the site will have the option to use the Screen Saver option).

The Domain Administrator says that no one will have the ability to use the Sounds
option within the Windows 10 Personalization page. He is forcing this edict with the
Enforced option.

Frank Rizzo, the Human Resources OU manager, says that for the Human Resources
Users OU, he wants to prevent the use of the Mouse Pointers applet but restore the
Screen Saver option. For the Human Resources Computers OU, he’ll want to make
sure that calc.exe launches whenever someone uses a Human Resources computer.

Additionally, at the top-level Human Resources OU, he will set Block Inheritance. This
will return the normal function of the Screen Saver option (originally removed by the
Enterprise Administrator at the site level). But Frank is forced to live with the fact that he
won’t be able to return the Sounds option in the Windows 10 Personalization page to his
people. The Domain Administrator has Enforced this idea—taken it away and that’s that.

But Frank and other members of the HR-OU-Admins security group are getting frustrated
that they cannot access the Display Settings tab. And they’re also getting a little annoyed that
every time they use a Human Resources machine, calc.exe pops up to greet them.

Sure, it was Frank’s own idea to make these two policy settings—one that affects the
users he’s in charge of and one that affects the computers he’s in charge of. The problem is,
however, it also affects Frank (and the other members of the HR-OU-Admins team) when
they’re working, and you can see where that can be annoying.

Frank needs a way to filter the Scope of Management (SOM) of the “Hide Mouse Pointers
Option/Restore Screen Saver Option” GPO as well as the “Auto-Launch calc.exe” GPO. By
scope, or SOM, I mean how far and wide the GPOs we set up will be embraced.

)’ Occasionally you will see references to SOM in your travels with Group
AéTE Policy. An SOM is simply a quick-and-dirty way to express the idea of
where and when a GPO might apply. An SOM can be nearly any combi-
nation of things: linking a GPO to the domain, linking a GPO to an OU,
and linking a GPO to a site. However, if you start to filter GPOs within the
domain, that’s also an SOM. In essence, an SOM indicates when and where
a GPO applies to a level in Active Directory.

In our case, the idea is twofold:

Frank and his team are excluded from the “Hide Mouse Pointers Option/Restore
Screen Saver Option GPO” edict.

The specific computers that Frank and his team use are excluded from the “Auto-
Launch calc.exe” GPO edict.



92 Chapter 2 = Managing Group Policy with the GPMC and via PowerShell

Recall from Chapter 1 that, despite the wording of the term Group Policy, Group Policy
does not directly affect security groups. You cannot just wrap up a bunch of similar users
or computers in an Active Directory security group and thrust a GPO upon them. There’s
nowhere to “link” to. You need to round up the individual user or computer accounts into
an OU first and then link the desired GPO on that OU.

Here’s the truly strange part: even though you can’t round up users in security groups
and apply GPOs to them, it’s the security group that we’ll leverage (in most cases) to enable
us to filter Group Policy applications!

In order for users to get GPOs to apply to them, they need two under-the-hood access
rights to the GPO itself:

Read
Apply Group Policy (known in shorthand as the AGP rights)

These permissions must be set on the GPO in question. By default, all Authenticated
Users are granted the Read and AGP rights to all new GPOs. Therefore, anyone who has a
GPO geared for them will process it.

The following two things might not be immediately obvious:

Administrators are not magically exempt from embracing Group Policy; they, too, are
members of Authenticated Users. You can change this behavior with the techniques
described in the next section.

Computers need love, too. And for computers to apply their side of the GPO, they need
the same rights: “Read” and “Apply Group Policy.” Since computers are technically
Authenticated Users, the computer has all it needs to process GPOs meant for it.

With these fundamental concepts in mind, let’s look at several ways to filter who gets
specific GPOs.

If you want to filter GPOs for either specific users or specific computers, you have three
distinct approaches. For our three examples (which will all do the exact same thing), we
want the “Hide Mouse Pointers Option/Restore Screen Saver Option” GPO to “pass over”
our heroes in the HR-OU-Admins security group but to apply to everyone else who should
get them. We also want the “Auto-Launch calc.exe” GPO to pass over the specific comput-
ers our heroes use at their desks.

Group Policy Object Filtering Approach #1: Leverage the Security
Filtering Section of the Scope Tab in GPMC

In the first approach, you’ll round up only the users, computers, or security groups who
should get the GPO applied to them. To make things easier, let’s first create two Active
Directory security groups—one for our users who will get the GPO and one for computers
who will get the GPO. Good names (for learning purposes) might be:

People-Who-Get-the-HideDisplayMousePointersOption-and-RestoreSS
and:

Computers-That-Get-the-Auto-Launch calc.exe
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Remember, back when we created GPO, its goal was twofold: so we’ve named it “Hide
Changing Mouse Pointers / Restore Screen Saver Option.” Making a group with something
easy to remember but still only 64 characters can be tough. So, again, ’'m recommending a
group named People-Who-Get-the-HideDisplayMousePointersOption-and-RestoreSS.

The second group, for computers, is a little easier to make. The GPO we’ll want to lever-
age with this group only does one thing: it automatically launches calc.exe. So, my sug-
gested name is Computers-That-Get-the-Auto-Launch calc.exe.

Go ahead and do this in Active Directory Users and Computers, as seen in Figure 2.13.

FIGURE 2.13 Create a new Active Directory security group to which you want the
GPO to apply. Create security groups for both users and computers based on the GPO
you want to filter.

New Object - Group -

Createin:  corp.com/Users
8,

Group name:
| Computers-That-Get-the-Auto-Launch calc.exe-GPO| |

Group name (pre-Windows 2000):
| Computers-That-Get-the-Auto-Launch calc.exe-GPO |

Group scope Group type

() Domain local (®) Security

lobal ) pistribution

Next, add all user accounts that you want to embrace the GPO into the first security
group.

You would then add all computer accounts that you want to get the GPO into the secu-
rity group named Computers-That-Get-the-Auto-Launch calc.exe.

Because we don’t want these GPOs to apply to Frank or Frank’s computer (WIN10),
don’t add Frank to the first group (which contains users) and don’t add WINT10 to the sec-
ond group (which contains computers).

Next, click the link to the “Hide Mouse Pointers Option/Restore Screen Saver Option”
GPO found in Group Policy Management > Forest > Domains > Corp.com > Human
Resources OU > Human Resources Users OU. In the Security Filtering section, you can see
that Authenticated Users is listed. This means that any users inside the Human Resources
Users OU will certainly get this GPO applied.

However, now we’re about to turn the tables. We’re going to click the Remove button to
remove the Authenticated Users in the Security Filtering section; then we’re going to add
the People-Who-Get-the-HideDisplayMousePointersOption-and-RestoreSS security group,
as shown in Figure 2.14.
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The PowerShell way to perform this same function would be the following two
commands:

Set-GPPermissions -Name “Hide Mouse Pointers Option/Restore Screen Saver Option”
-Replace -PermissionLevel None -TargetName 'Authenticated Users' -TargetType
group

Set-GPPermissions -Name “Hide Mouse Pointers Option/Restore Screen Saver
Option” -PermissionLevel gpoapply -TargetName “People-Who-Get-the-
HideDisplayMousePointersOption-and-RestoreSS” -TargetType group

S \Use dministra et-GPPermi ame “Hide Mouse Pointers Opt
aver Option” -Replace -Per nLevel None -TargetName 'Authenticated

Name “Hide k e Pointers Opt
; -TargetMame “Peopl Get-the-Hidel
p

playName
1ainName

Next, in the GPMC, click the “Auto-Launch calc.exe” GPO link (which is under the
Human Resources Computers OU). In the Security Filtering section of the Scope tab, you’ll

remove Authenticated Users and add the Computers-That-Get-the-Auto-Launch calc.exe
security group.

In both cases, what we're doing under the hood is giving these new secu-
P rity groups the ability to Read and Apply Group Policy. You'll see this
under-the-hood stuff in a minute.

If you’re following along with PowerShell, those two commands would be:

Set-GPPermissions -Name “Auto-Launch calc.exe” -Replace -PermissionLevel None
-TargetName “Authenticated Users” -TargetType group

Set-GPPermissions -Name “Auto-Launch calc.exe” -PermissionLevel gpoapply
-TargetName “Computers-That-Get-the-Auto-Launch calc.exe” -TargetType group
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FIGURE 2.14 When you remove Authenticated Users, no one will get the effects of
the GPO. Add only the users or groups you want the GPO to affect.
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Testing Your First Filters

To see if this is working, log on to WIN10 as Frank (frizzo). Even though the GPO applies
to the Human Resources Users OU, the GPO will pass over him and anyone else not explic-
itly put into that security group since Frank is not a member of the People-Who-Get-the-
HideDisplayMousePointersOption-and-RestoreSS security group.

For another test, add a new user account or two to the Human Resources Users OU (via
Active Directory Users and Computers). Then, log on as one of these new users (in the OU)
and verify that they, indeed, do not get the GPO. This is because the GPO is only set to
apply to members of the security group. Then, add the user to the security group and log
on again. The GPO will then apply to your test users (inside the security group) as well. In
fact, you can add users to the security group by simply clicking the Properties button in the
Security Filtering section. Doing so opens the Security Group Membership dialog box, in
which you can add or delete users or computers.

Repeat your tests by adding WIN10 into the security group named Computers-That-
Get-the-Auto-Launch calc.exe. When the computer is in the group, it will apply the GPO.
Now, try removing WIN10 and see what happens. When the computer is out of the group,
the GPO will pass over the computer.
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You will have to reboot the machine to immediately see Computer-side
ITE results.

What’s Going on Under the Hood for Filtering

As T implied, when you add security groups to get the GPOs in the Security Filtering sec-
tion, you’re doing a bit of magic under the hood. Again, that magic is simply granting two
security permissions, “Read” and “Apply Group Policy,” to the users or security groups on
the GPOs linked to the OU.

To see which security permissions are set under the hood for a particular GPO (or GPO
link, because it’s the same information), click the Delegation tab and click the Advanced
button, as shown in Figure 2.15.

FIGURE 2.15 Clicking Advanced on the Delegation tab for the GPO (or GPO link)
shows the under-the-hood security settings for the GPO.
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When you do, you can see the actual permission on the GPO itself. You can easily locate
the security group named People-Who-Get-the-HideDisplayMousePointersOption-and-
RestoreSS and see that they have both the “Read” and “Apply Group Policy” access rights
set to Allow. This is why they will process this GPO.
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Using PowerShell, the command to see the permissions underneath the hood would be:

get-gppermission -Name "Hide Mouse Pointers Option/Restore Screen Saver Option"
-all

dministrator> get-gpperm on -Name "Hide Mouse Pointers Option/Restore Screen 5z
all

: HR-OU-Admins

Pel eteModi FySecurity
Inherited

Note that PowerShell only shows the Group Policy-specific “Apply” attribute and not
the more general (not Group Policy—specific) “Read” attribute.

Filtering Approach #2: Identify Those You Do Not Want to Get
the Policy

The other approach is to leave the default definition in for the GPO such that the Authenticated
Users group is granted the “Read” and “Apply Group Policy” attributes. Then, figure out
who you do not want to have the policy applied to, and use the “Deny” attribute over the
“Apply Group Policy” right.

When Windows security is evaluated, the designated users or computers will not be able
to process the GPO due to the “Deny” attribute; hence, the GPO passes over them.

See the sidebar “Positive or Negative?” later in this chapter before doing
dtnz this in your real (production) environment.

For our examples, we want the “Hide Mouse Pointers Option/Restore Screen Saver
Option” GPO to pass over our heroes in the HR-OU-Admins security group but to apply
to everyone else by default. We also want the “Auto-Launch calc.exe” GPO to pass over the
specific computers our heroes use at their desks.
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To use this second technique, we’ll use the “Deny” permission to ensure that the HR-OU-
Admins security group cannot apply (and hence process) the “Hide Mouse Pointers Option/
Restore Screen Saver Option” GPO. We’ll also prevent Frank’s computer, WIN10, from
processing the “Auto-Launch calc.exe” GPO.

Again, you’ll do this using the GPMC upon the GPO (or the GPO link, because it’s the

same information); click the Delegation tab, and then click the Advanced button. Follow
these steps:

1. Locate the People-Who-Get-the-HideDisplayMousePointersOption-and-RestoreSS
security group and remove it.

2. Add the Authenticated Users group, and select the “Read” permission.

3. If you used Frank’s account originally to create this GPO, he is specifically listed in
the security list. You want to remove Frank and add the HR-OU-Admins group. Click
Frank, and then click Remove. Click Add, and add the HR-OU-Admins group.

4. Then click Advanced and select the Allow option for the “Apply Group Policy” permis-
sion for the Authenticated Users group.

5. Now make sure the Apply Group Policy check box is set to Deny for the HR-OU-
Admins group, as shown in Figure 2.16.

Do not set the Deny check box for the “Read” and “Write” attributes from the
HR-OU-Admins (the group you’re currently a member of when logged in as Frank).
If you do, you’ll essentially lock yourself out, and you’ll have to ask the Domain
Administrator to grant you access again.

FIGURE 2.16 Use the “Deny” attribute on the “Apply Group Policy” right to
prevent Group Policy from applying.
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6. Click OK to close the Group Policy Settings dialog box. In the warning box that tells
you to be careful about “Deny” permissions, click Yes.
7. Click OK to close the OU Properties dialog box.
In both cases (using the GUI or via PowerShell), what you’re doing is specifically adding
the “Deny” right.
Below is the PowerShell equivalent, which, unfortunately, takes a little work and appears
a lot more complicated. That’s because PowerShell does not have any native way to easily
apply the “Deny” permission to a Group Policy Object. The commands to type would be as
follows:

$gpo = Get-GPO -Name "Hide Mouse Pointers Option/Restore Screen Saver Option"
$adgpo = [ADSI]"LDAP://CN="{$($gpo.Id.guid) },CN=Policies,CN=System,DC=corp,DC=
com"

$rule = New-Object System.DirectoryServices.ActiveDirectoryAccessRule(
[System.Security.Principal.NTAccount]"CORP\HR-OU-Admins",
"ExtendedRight",
"Deny",
[Guid]"edacfd8f-ffb3-11d1-b41d-0020c968939"

$acl = Sadgpo.ObjectSecurity
Sacl.AddAccessRule(Srule)
$adgpo.CommitChanges()

The result from the PowerShell commands can be seen here:

> $gpo = Get-GPO -Name "Hide Mouse Pointers Option/Restore Screen Savd

Sadgpo = [ADSI]"LDAP://CN="{$($gpo.Id.guid) },CN=Policies,CN

services. ActiveDirectoryAccessRull

To test your first filter again, log onto WIN10 as Frank Rizzo. Note that the Settings tab
has returned to him because he is part of the HR-OU-Admins group. The “Hide Mouse
Pointers Option/Restore Screen Saver Option” GPO has passed over him because he is
unable to process the GPO.

To bypass the “Auto-Launch calc.exe” GPO on WIN10, you’ll perform a similar opera-
tion. That is, yow’ll modify the security on the GPO to pass over the computers our heroes
use by denying those specific computer accounts the ability to Apply Group Policy. You can


LDAP://CN=`{$($gpo.Id.guid)`
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then test your second filter by logging on as anyone to WIN10. You should then see that
calc.exe will not launch when a user uses that machine.

Turns out, however, there’s something of note when using the aforementioned method.
That is, if you performed the previous exercise and used the “Deny” attribute to pass over
the HR-OU-Admins group using the security on the GPO, you’ve got a small problem.
Sure, it worked! That’s the good news. The bad news is that GPMC isn’t smart enough to
demonstrate what you did back on the Scope tab in the Security Filtering section shown in
Figure 2.17.

FIGURE 2.17 The Security Filtering section on the Scope tab will not show you any
use of “Deny” attributes under the hood.
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Yes, it’s technically true what the Security Filtering section says: Authenticated Users
will apply this GPO. However, it doesn’t tell us the other important fact: the HR-OU-
Admins group will not process this GPO because they were denied the ability to Apply
Group Policy.

The only way to get the full, true story of who will get the GPO applied to them is
to look back within the GPO (or GPO link, because it’s the same information), select
the Delegation tab, and click the Advanced button to see who has “Read” and “Apply
Group Policy;” then also see who is denied access to process the GPO via the “Deny”
attributes.
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With the GPMC (see the upcoming section “Searching and Comment-

P ing Group Policy Objects and Policy Settings”), you can leave a comment
inside the GPO for others to read regarding who has been specifically
denied AGP access. The only problem is someone might not read it.

The moral of the story? Always consult the Advanced tab to get the whole truth as to the
security on the GPO.

Positive or Negative?

Now that you can see the two ways to filter users from processing GPOs, which should
you use: Approach 1 (adding only those you want to get the GPO) or Approach 2 (denying
only those you don’t want to get the GPO)? The data reflected within the GPMC’s Scope
tab clearly wants you to take the first approach. However, many Active Directory imple-
mentations | know take the second approach (and, in fact, it was my advice to do so in the
first several editions of this book).

Now, you and your team need to make a choice for your approach. As you saw, when
you create new GPOs, you can choose to filter via the Scope tab or the Delegation tab’s
Advanced button. So which do you choose? If you're going to be religious about using
the first approach, you can then be reasonably confident that only the users, groups,
and computers listed in the Security Filtering section of the Scope tab will, in fact, be
the only users, groups, and computers that will get the GPO. You can then reduce your
need to dive into the Security Editor, as seen in Figure 2.15 and Figure 2.16, earlier in
this chapter.

However, if you (or other administrators) occasionally choose to use the “Deny” attribute
on users, computers, and groups to keep them from getting the GPO, you'll need to addi-
tionally inspect the Security Editor dialog box, which, again, you’ll find by clicking the
Advanced button within the Delegation tab, as seen in Figure 2.15 and Figure 2.16.

The GPMC encourages you to use Approach 1 for filtering. If you have older GPOs in your
Active Directory that already use Approach 2 for filtering, consider changing it so that
GPMC's Scope tab will reflect who will get the GPO.

There’s no right or wrong answer here. The challenge is simply that the GPMC will

not show who is expressly denied the ability to process the GPO. If you have an in-
house system to compensate for that shortcoming (or you use the GPMC Comment
feature, which I'll explain later in this chapter), you might be able to make better use of
Approach 2.
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User Permissions on Group Policy Objects

You already know the three criteria for someone to be able to edit or modify an existing GPO:
They are a member of the Domain Admins group.
They are a member of the Enterprise Admins group.

They created the GPO themselves and hence are the owner. (We saw this in Figure 1.24
in Chapter 1 when Frank could edit his own GPOs but couldn’t edit the GPOs he
didn’t create.)

But sometimes, you also want to add rights on a GPO so other admins can modify it. As
I previously suggested, the Delegation tab for a GPO (or GPO link, which reflects the same
information) has a second purpose: to help you grant permissions to groups or users over
the security properties of that GPO.

If you click Add on the Delegation tab, you can grant any mere mortal user, an admin,

or group (even in other domains) the ability to manipulate a particular GPO, as seen in
Figure 2.18.

FIGURE 2.18 You can set permissions of “who can do what” on a GPO.

Add Group or User .
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You can also use PowerShell instead of the clickety-clicks by using the Set-
GPPermission cmdlet.

Take a peek at Table 2.1, in the first and second column, to know what you want to
accomplish. Then replace the permission with the appropriate keyword. So, for instance, if
you wanted to specify that Frank Rizzo should be expressly granted “Edit settings, delete,
modify security” permissions upon GPO123, you would type:

Set-GPPermission -Name GP0123 -PermissionLevel GpoEditDeleteModifySecurity
-TargetName "Frizzo" -TargetType User

-Name GP0123 -Perm evel GpoEditDeleteModifysd

Admins
-9aBa-1013d1d00452

P
0

: AD Version:
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Once the permissions settings have been applied, the user has that level of rights over the
GPO, as you can see in the last column in Table 2.1.

TABLE 2.1

GPMC vs. genuine Active Directory permissions

Permissions option

PowerShell GPPermissionType

Actual under-the-hood
permissions

Read

“Edit settings”

“Edit settings, delete,
modify security”

“Read (from Security
Filtering)”

Custom

GpoRead

GpoEdit

GpoEditDeleteModifySecurity

Not applicable for PowerShell

GpoCustom

Sets the Allow permission for
Read on the GPO.

Sets the Allow permission

for Read, Write, Create Child
Objects, and Delete Child
Objects. See the note regarding
under-the-hood attributes.

Sets the Allow permission

for Read, Write, Create Child
Objects, Delete Child Objects,
Delete, Modify Permissions,
and Modify Owner. This is
nearly equivalent to full control
on the GPO, but note that Apply
Group Policy access permis-
sion is not set. (This can be
useful to set for administrators
so they can manipulate the
GPO but not have it apply to
themselves.)

This isn’t a permission located
in the ACL Editor (see Fig-

ure 2.16); rather, this is only
visible if the user has Read and
AGP permissions on the GPO.
This is a reflection of what is on
the Scope tab.

Any other combinations of
rights, including the use of the
“Deny” permission. Custom
rights are only added via the
ACL Editor but can be removed
here. They can be removed
using the Remove button on
the Delegation tab.




104 Chapter 2 = Managing Group Policy with the GPMC and via PowerShell

If you look really, really closely at the under-the-hood attributes specifi-

doTE cally granted to the user when they are given “Edit settings” or “Edit set-
ting, delete, modify security” rights, you'll note that Write isn’t expressly
listed. However, the ability to perform writes is granted because other
subattributes that do permit writing are granted on the entry. To see those
attributes for yourself, click the Advanced button while looking at the prop-
erties of the security on a GPO (like what we see in Figure 2.16).

Granting Group Policy Object Creation Rights in
the Domain

As you learned in Chapter 1, a user cannot create new GPOs unless that user is a member
of the Group Policy Creator Owners group. Dropping a user into this group is one of two
ways you can grant this right.

However, the GPMC introduces another way to grant users the ability to have Group
Policy Creator Owner—style access. Traverse to the Group Policy Objects container as seen
in Figure 2.19, and click the Delegation tab. You can now click Add and select any user,
including any user in your domain, say a user named Joe User, or users across forests, such
as Sol Rosenberg, who is in a domain called bigu.edu. As you can see in Figure 2.19, Sol

has been added.

FIGURE 2.19 You can choose to delegate to users in your domain, in other
domains, or in domains in other forests.
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This can be handy if you have trusted administrators in other domains and you want to
allow them to create GPOs in your domain. You might want to round them up into a group
(instead of just listing them individually as Sol is listed here), but that’s your option.

Enabling people to create GPOs is difficult using Microsoft’s built-in Group Policy e¢md-
lets. But Darren’s free PowerShell cmdlets (which we used earlier) makes quick work of this
task you wanted. To enable Sol Rosenberg from the bigu.edu domain to create GPOs in the
Corp.com domain using PowerShell, you would use the following command:

Add-SDMSOMSecurity -Scope "dc=corp,dc=com" -Trustee "BIGU\srosenberg"
-PermSOMGPOCreate

However, in this quick example, ’'m using a guy called Testman1 in my Corp domain
and giving him those rights.

MSecurity -Scope “dc=corp,dc=com” -Trustee "CORP\Testmanl™

Special Group Policy Operation Delegations

You can delegate three special permissions at the domain and OU levels, and you can set
one of those three special permissions at the site level. Clicking the level, such as an OU,
and then clicking the Delegation tab for that level shows the available permissions, as seen
in Figure 2.20.

The interface is a bit confusing here. Specifically, you must first select the permission
from the drop-down box. This lists the current users who currently have permissions. You
can then click the Add, Remove, or Advanced button to make your changes.

You can select three permissions from the drop-down box, as seen in Figure 2.20:

Link GPOs Of the three permissions here, this is the only permission that can be config-
ured at all levels: site, domain, and OU. Recall in Chapter 1 that you ran Active Directory
Users and Computers’ “Delegation of Control Wizard” (see Figure 1.21). Instead of using
Active Directory Users and Computers to perform that task, the GPMC can do the same
job—right here.

Perform Group Policy Modeling Analyses This right performs the same function as if we
had used Active Directory Users and Computers’ “Delegation of Control Wizard” to grant
the “Generate Resultant Set of Policy (Planning)” permissions, as you saw in Chapter 1,
Figure 1.21. The next section describes how to get more data about what’s happening at the
client. You’ll see how to use this power in the section “What-If Calculations with Group
Policy Modeling” later in this chapter. Group Policy Modeling lets you simulate what-if
scenarios regarding users and computers.
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FIGURE 2.20 These operations enable you to delegate special Group Policy

operations.
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By default, only Domain Admins have the right to perform this task. Domain Admins can
grant other users or groups the ability to perform this function, such as the Help Desk,
HR-OU-Admins, or your own desktop-administrator teams. You can choose to grant peo-
ple the ability to perform Group Policy Modeling analyses on this specific container or this
specific container and child containers. When you assign this right, the user performing the
Group Policy Modeling analysis must have the delegated right on the container containing
the what-if user and also the container containing the what-if computer. If you don’t grant
rights in both containers, only half the analysis is displayed.

Read Group Policy Results Data  This right performs the same function as if we used
Active Directory Users and Computers’ “Delegation of Control Wizard” to grant the
“Generate Resultant Set of Policy (Logging)” permission (which isn’t shown in Figure 2.20
but it would be there if you scrolled down a little). You’ll see how to use this power in the
section “What’s-Going-On Calculations with Group Policy Results” later in this chapter.
However, if you want to grant this power to others, you can. Again, a typical use is to
grant this right to the Help Desk or other administrative authority.

When you assign this right, the user performing the Group Policy Results analysis must
have the delegated right on the container containing the target computer. Or this right can
be applied at a parent container and the rights will flow down via inheritance. The user or
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group must also have this right delegated on any container containing any users who have
logged onto the machine you want to analyze. If you don’t grant rights in both containers,
no analysis is displayed.

To add the equivalent permissions via in PowerShell, you need Darren’s Add-SDMSOMSecurity
cmdlet again from his free PowerShell cmdlets download.

You simply specify the name of the person (in this example, I’'m using a fake guy called
Testman1) and you specify the permissions. The possible entries for permissions are as
follows:

PermSOMLink Link—Group Policy Objects
PermSOMPlanning—Perform Group Policy Modeling Analysis
PermSOMLogging—Read Group Policy Results Data

Add-SDMSOMSecurity -Scope "ou=human resources, dc=corp,dc=com" -Trustee "corp\
Testmanl" -PermSOMLink

MSecurity -Scope “ou=human resources, dc=corp,dc=com” -Trus]

target “ou=human resc

spend [?] Help (d

8
Trustee em.__ComObject

Who Can Create and Use WMI Filters?

Okay, okay, okay. I know the subject of WMI filters has come up about 3,000 times
already, and every time I refer you, the poor reader, to Chapter 4. Once you’ve read what
they are and how to create them in Chapter 4, please come back here and read how to man-
age them. In other words, since I’'m already talking about the delegation of things inside the
GPMC, I’'m going to just cover that now. Go learn about what the heck WMI filters are in
Chapter 4.

That said, two types of people are involved in the management of WMI filters:

Those who can create them

Those who can use them

Delegating Who Can Create WMI Filters

By default, only the Domain Administrator can create WMI filters. However, you might
have some WMI whiz-kid in your company (and it’s a good chance this isn’t the same
person as the Domain Administrator). With that in mind, the Domain Administrator can
grant that special someone the ability to create WMI filters. To do this, drill down to the
domain > WMI Filters node, and then select Delegation in the pane on the right. You can
now grant one of two rights, as shown in Figure 2.21.
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FIGURE 2.21
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These are controls over the creation of WMI filters.
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Creator owner k . .

In Figure 2.21, we can see the two rights that appear in the drop-down box:

= Once a user has “Creator owner” rights here, they can create and modify their own
WMI filters but they cannot modify others’ WMI filters. Note that members of the
Group Policy Creator Owners security group have this right by default.

= A user with “Full control” rights here can create and modify their own WMI filters or

anyone else’s.

Delegating Who Can Use WMI Filters

Once WMI filters are created (again, see Chapter 4), you’ll likely want to assign who can
apply them to specific GPOs. To do this, drill down to the specific WMI filter, as shown in
Figure 2.22. Then click Add, and you’ll see that two rights are available for the user you want.

FIGURE 2.22 These are controls over the WMI filters themselves.
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In Figure 2.22, we can see the two rights that appear in the drop-down box:

= Once users have “Edit” rights here, they can edit and tailor the filter, as we do in
Chapter 4.

= A user with “Full control” rights here can edit the filter as well as delete it and modify
the security (that is, specify who else can get “Edit” or “Full control” rights here).

Performing RSoP Calculations with
the GPMC

In Chapter 1, we charted out a fictitious organization’s GPO structure on paper. We looked
and saw when various GPOs were going to apply to various users and computers. Charting
out the RSoP (Resultant Set of Policy) for users and computers on paper is a handy skill for
a basic understanding of GPO organization and flow, but in the real world, you need a tool
that can help you figure out what’s going on at your client desktops.

The GPMC has a handy feature to show us all the GPOs that are going to apply for the
users and computers at a specific level in Active Directory. In Figure 2.23, when you click
the Human Resources Users OU and then click the Group Policy Inheritance tab, you can
see a list of all the GPOs that should apply to the Human Resources Users OU.

The site level is not shown in this Group Policy Inheritance tab. Because computers, par-
ticularly laptops, can travel from site to site, it is impossible to know for sure what site to
represent here.

FIGURE 2.23 The Group Policy Inheritance tab shows you which GPOs should

apply.
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As T said, this tab in Figure 2.23 should tell you what’s going to happen. The operative
word here is should. That’s because a lot can go wrong between your wishes and what hap-
pens on the client systems. For instance, you already saw how to filter GPOs using security
groups, which would certainly change the experience of one user versus another on the very
same machine. And in Chapter 4, you’ll learn about WMI filters, which limit when GPOs
are applied even more.

The point of all this RSoP stuff is to help us know the score about what’s going on at
machines that could be many hundreds of miles away. When users freak out about getting set-
tings they don’t expect or when they freak out about lacking settings they do expect, the point
is to know which setting is causing the stir and which GPO is to blame for the errant setting.

We know one thing for sure: users do freak out if anything changes, and it’s our job to
track down Group Policy issues that could be affecting them. So the point of performing an
RSoP calculation is to help you know what is going on and why it’s going on that way. The
GPMC can help with that.

What’s-Going-On Calculations with Group Policy Results

If someone calls you to report that an unexpected GPO is applying, you can find out what’s
going on by using the GPMC. Once the user with the problem has logged onto the machine
in question, you can tap into the WMI provider built into all editions of Windows since
Windows XP. Without going too propeller-head here, the upshot of this magic is that the
GPMC (and the GPResult command, and Get-GPresultantSet0fPolicy PowerShell cmd-
let, as we’ll explore more in Chapter 7) can query any particular user who has ever logged
on locally. It’s then a simple matter to display the sexy results within the GPMC.

é/ Once the results are displayed, you can right-click over the report and save
P them as an HTML or XML report.

The magic happens when the computer asking “What’s going on?” (in this case, the
computer running the GPMC) asks the target client computer. The target client computer
responds with a result of what has happened—which GPOs were applied to the Computer
side and to the User side (provided the user has ever, at least once, logged on).

Let me expand on this important point: This Group Policy Results magic only works if
the target user has ever logged onto the target machine. They only need to have ever logged
on once, and here’s the amazing part: they don’t even need to be logged on while you run
the test. But if the target user has never logged onto the target machine, the Group Policy
Results will not allow you to select that user.

You can run your what’s-going-on calculations inside the GPMC by right-clicking
the Group Policy Results node at the bottom of the GPMC’s hierarchy, as shown in
Figure 2.24. When you do, you can select the user and the computer and see their
interaction.
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FIGURE 2.24 The Group Policy Results Wizard performs what’s-going-on
calculations.
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Keep in mind the following before trying to run the Group Policy Results Wizard to fig-

ure out what’s going on:

The target computer must be turned on and on the network. If this is not the case,
you’ll get an error to this effect. It will state that it cannot contact the WMI service
via RPC.

If the target machine has a firewall turned on, it must be disabled. Alternatively (in
advance), you can open up ports 135 and 445 on the target machine. See the sidebar
“Understanding Windows Firewall Settings (and Dealing with Group Policy Results)”
for some ideas on how to mitigate this. If the machine is unreachable because the fire-
wall is blocking access to port 135 or port 445, you’ll get the same RPC Error as if the
computer was off.

The Windows Management Instrumentation service must be started.

The user’s local profile cannot be deleted. If the user has logged on but the administra-
tor later whacks the local profile (or a Windows Vista or later—specific policy setting is
enabled to auto-whack the local profile), WMI data will not be available.

Remember, the user you want to find out about must have logged onto the target com-

puter at least once to be eligible to perform a Group Policy Results calculation.
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Understanding Windows Firewall Settings (and Dealing with Group Policy
Results)

Since Windows XP SP2 and Windows Server 2008, the Windows Firewall is automatically
engaged—protecting your poor machines from the baddies out there.

Now, regular, everyday Group Policy stuff works just fine when the firewall is on. That's
because the Group Policy client requests what it wants from the server, then the results
are returned through the requested ports.

But, as you just learned, the ability to get Group Policy Results is effectively disabled
when the Windows Firewall is engaged. That’s because firewalls reject unrequested stuff
when engaged. So, it feels like the target computer is turned off.

There are some policy settings that will affect Windows XP or later found in two locations:

Administrative Templates > Network > Network Connections > Windows Firewall >
Domain Profile

Administrative Templates > Network > Network Connections > Windows Firewall >
Standard Profile

You can see that the exact same policy settings are listed for both the Standard Profile
and Domain Profile nodes. The Domain Profile settings are what will take effect when
users are inside your corporate network; that is, when they're actively logged in by a
Domain Controller. The Standard Profile, on the other hand, is used for when users are
out of the office (perhaps in a hotel or other public network where they cannot reach your
company’s Domain Controllers for authentication).

Once a machine receives the policy settings for both the Domain Profile and Standard
Profile, that computer is ready to travel both in and out of the office. You can be sure that
machine is embracing your company’s firewall security policy both in the office and on
the road.

If you're interested in learning more about how a computer makes a determination of
whether it is supposed to use Domain Profile or Standard Profile policy settings, be

sure to read Microsoft's “Network Determination Behavior for Network-Related Group
Policy Settings” at https://technet.microsoft.com/1library/bb878049 (shortened to
http://tinyurl.com/cao73).

Note that the details are different for Vista and later, but the net result is the same: You
can use these Standard Profile settings or Domain Profile settings as you need to. You
have two options if you want to restore the Group Policy Results functionality when you
have Windows XP or later clients with the firewall on:



https://technet.microsoft.com/library/bb878049
http://tinyurl.com/cao73
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Approach 1: Kill the Windows XP/SP2 (and later) firewall. Now that you understand
how to control Windows XP’s (or later versions’) firewall settings, one approach is to

kill the firewall completely. If you do this, you understand that you're giving up any of
the protection that Windows Firewall affords. However, by doing so, you will restore
communication to the target computer. To kill the firewall, drill down to Administrative
Templates > Network > Network Connections > Windows Firewall > Domain Profile
and select Windows Firewall: Protect all network Connections. But here’s the thing. You
don’t enable this policy to kill the firewall. You disable it. Yes, you read that right: you dis-
able it. Read the help text in the policy for more information on specific usage examples.

Approach 2: Poke just the required holes in the firewall. Instead of killing the firewall
dead, you can simply open up the one port you need. Again, the idea is that if the target
computer responds on port 135, you're golden. Windows has a policy setting you can
enable named Windows Firewall: Allow Inbound Remote Administration Exception,
which is located in Computer Configuration > Administrative Templates > Network >
Network Connections > Windows Firewall > Domain Profile. Again, when you do this,
you’'re opening up the necessary port 135 (RPC). Note, however, that enabling this policy
setting also opens up port 445 (SMB), which some security shops might object to.

The output generated from the GPMC when performing Group Policy Results RSoP cal-
culations is quite powerful. When your GPMC is Windows 8 or later, the level of detail is
increased. You now get what is shown in Figure 2.25.

FIGURE 2.25 The Group Policy Results report shows three tabs, starting with
Summary.

frizzo on WINg

Summary | Details | Policy Events

Group Policy Results

CORP\frizzo on CORP\WINS
Data collected on: 11/07/2012 11:16:47 AM
Summary

=
=
o

During last computer policy refresh on 11/07/2012 11:16:34 AM
No Emors Detected
| Afast link was detected More information...
| Inhertance is blocking all non-enforced GPOs linked above comp com/Human Resources
| The following GPOs have special alers
GPO Name Alert
Prohibit Changing Sounds  Enforced

During last user policy refresh on 11/07/2012 11:15:13 AM
9 No Emors Detected
| Afastlink was detected Mare information
| Inhertance is blocking all non-enforced GPOs linked above cop com/Human Resources
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When your GPMC is Windows 8 or later, the Summary tab in the Group Policy Results
report shows a true summary of what has occurred. Any “special events” are immediately
obvious here on the Summary page. For instance, as Figure 2.25 shows, you can see that
specific links to GPOs are called out when they are enforced. Also shown is a specific alert
for where Block Inheritance starts.

Additionally, if any errors occurred, those would be present here as well. And you can see
hyperlinks to web pages with interesting information for both errors and informational items.

Similar to using the Settings tab, you can expand and contract the report by clicking Show
and Hide. Inside, you can clearly see which GPOs have been applied and any major errors
along the way. At a glance, you can see which GPOs have Applied and which were Denied
(passed over) for whatever reason, such as filtering or that one-half of the GPO was empty.

The Details tab shows the meat of the report, as shown in Figure 2.26. Note that the

report is pretty long, so ’'m showing you only the bottom half, which is the user portion in
Figure 2.26.

FIGURE 2.26 The GPMC Details report shows the settings within the GPOs.

frizzo on WINg

Summary | Details | Policy Events

User Details hide s
General hide
User name CORP"frizzo
Domain corp.com
Organizational Unit corp.com/Human Resources/Human Resources Users
Block Inheritance corp.com/Human Resources
Security Group Membership show
Component Status hide
Component Name  Status Time Taken Last Process Time Event Log
Group Policy Success 484 Milisecond(s) 11/07/201211:28:17  View Log
Infrastructure AM
Registry Success 31 Milisecond(s) 11/07/201211:28:17  View Log
AM
Settings hide
Administrative Templates hide
Policy defintions (ADMX files) retrieved from the local computer
Control Panel/Personalization hide
Policy Setting ‘Winning GPO
Prevert changing mouse pointers Enabled Hide Mouse Pointers Option/Restore
Screen Saver Option
Prevert changing screen saver Disabled Hide Mouse Pointers Option/Restore
Screen Saver Option
Prevert changing sounds Enabled Prohibit Changing Sounds
Desktop show

Group Policy Objects

=
&
&

Hide Mouse Pointers Option/Restore Screen Saver Oplion show
Local Group Policy show
Default Domain Policy show
'WMI Filters hide:

MName Value Reference GPO(s)
None (v
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Here you can see which GPOs were Applied and which were Denied. Applied means
that on the User or Computer side, the directives inside the Group Policy Object were
performed. Denied means that the Group Policy Object’s directives were not performed.
Denied doesn’t necessarily mean there’s a problem. Indeed, in Figure 2.26, the Default
Domain Policy is listed underneath “Denied GPOs” underneat